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Accuracy

While reasonable efforts have been made to assure the accuracy of this document, Cambium
Networks assumes no liability resulting from any inaccuracies or omissions in this document, or
from use of the information obtained herein. Cambium reserves the right to make changes to
any products described herein to improve reliability, function, or design, and reserves the right
to revise this document and to make changes from time to time in content hereof with no
obligation to notify any person of revisions or changes. Cambium does not assume any liability
arising out of the application or use of any product, software, or circuit described herein; neither
does it convey license under its patent rights or the rights of others. It is possible that this
publication may contain references to, or information about Cambium products (machines and
programs), programming, or services that are not announced in your country. Such references
or information must not be construed to mean that Cambium intends to announce such
Cambium products, programming or services in your country.

Copyrights

This document, Cambium products, and 3™ Party software products described in this document
may include or describe copyrighted Cambium and other 3™ Party supplied computer programs
stored in semiconductor memories or other media. Laws in the United States and other
countries preserve for Cambium, its licensors, and other 3™ Party supplied software certain
exclusive rights for copyrighted material, including the exclusive right to copy, reproduce in any
form, distribute and make derivative works of the copyrighted material. Accordingly, any
copyrighted material of Cambium, its licensors, or the 3™ Party software supplied material
contained in the Cambium products described in this document may not be copied, reproduced,
reverse engineered, distributed, merged or modified in any manner without the express written
permission of Cambium. Furthermore, the purchase of Cambium products shall not be deemed
to grant either directly or by implication, estoppel, or otherwise, any license under the
copyrights, patents or patent applications of Cambium or other 3rd Party supplied software,
except for the normal non-exclusive, royalty free license to use that arises by operation of law in
the sale of a product.

Restrictions

Software and documentation are copyrighted materials. Making unauthorized copies is
prohibited by law. No part of the software or documentation may be reproduced, transmitted,
transcribed, stored in a retrieval system, or translated into any language or computer language,
in any form or by any means, without prior written permission of Cambium.

License Agreements

The software described in this document is the property of Cambium and its licensors. It is
furnished by express license agreement only and may be used only in accordance with the
terms of such an agreement.

High Risk Materials

Cambium and its supplier(s) specifically disclaim any express or implied warranty of fitness for
any high risk activities or uses of its products including, but not limited to, the operation of
nuclear facilities, aircraft navigation or aircraft communication systems, air traffic control, life
support, or weapons systems (“High Risk Use”). Any High Risk is unauthorized, is made at your
own risk and you shall be responsible for any and all losses, damage or claims arising out of any
High Risk Use.

© 2017 Cambium Networks Limited. All Rights Reserved.



cePMP CAMBIUM NETWORKS

Safety and regulatory information

This section describes important safety and regulatory guidelines that must be observed by
personnel installing or operating ePMP equipment.

IMPORTANT SAFETY INFORMATION

mWarning

To prevent loss of life or physical injury, observe the safety guidelines in this section.

Power lines

Exercise extreme care when working near power lines.

Working at heights

Exercise extreme care when working at heights.

Grounding and protective earth

Connectorized ePMP devices must be properly grounded to protect against lightning. It is the
user’s responsibility to install the equipment in accordance with national regulations. In the USA,
follow Section 810 of the National Electric Code, ANSI/NFPA No.70-1984 (USA). In Canada, follow
Section 54 of the Canadian Electrical Code. These codes describe correct installation procedures
for grounding the outdoor unit, mast, lead-in wire and discharge unit, size of grounding
conductors and connection requirements for grounding electrodes. Other regulations may apply in
different countries and therefore it is recommended that installation be contracted to a
professional installer.

Powering down before servicing

Always power down and unplug the equipment before servicing.

Primary disconnect device

The ePMP power supply is the primary disconnect device.

External cables

Safety may be compromised if outdoor rated cables are not used for connections that will be
exposed to the outdoor environment.

RF exposure near the antenna

Strong radio frequency (RF) fields will be present close to the antenna when the transmitter is on.
Always turn off the power to the ePMP device before undertaking maintenance activities in front of
the antenna.

Minimum separation distances

Install the ePMP device so as to provide and maintain the minimum separation distances from all
persons.

The minimum separation distances for each frequency variant are specified in Calculated distances
and power compliance margins on page 431.
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IMPORTANT REGULATORY INFORMATION

The ePMP product is certified as an unlicensed device in frequency bands where it is not allowed
to cause interference to licensed services (called primary users of the bands).

Radar avoidance

In countries where radar systems are the primary band users, the regulators have mandated
special requirements to protect these systems from interference caused by unlicensed devices.
Unlicensed devices must detect and avoid co-channel operation with radar systems.

The ePMP provides detect and avoid functionality for countries and frequency bands requiring
protection for radar systems.

Installers and users must meet all local regulatory requirements for radar detection. To meet these
requirements, users must set the correct country code during commissioning of the ePMP
equipment. If this is not done, installers and users may be liable to civil and criminal penalties.

Contact the Cambium helpdesk if more guidance is required.

USA and Canada specific information

The USA Federal Communications Commission (FCC) has asked manufacturers to implement
special features to prevent interference to weather radar systems that operate in the band 5600
MHz to 5650 MHz. These features must be implemented in all products able to operate outdoors in
the band 5470 MHz to 5725 MHz.

Manufacturers must ensure that such radio products cannot be configured to operate outside of
FCC rules; specifically it must not be possible to disable or modify the radar protection functions
that have been demonstrated to the FCC.

In order to comply with these FCC requirements, Cambium supplies variants of the ePMP for
operation in the USA or Canada. These variants are only allowed to operate with license keys and
country codes that comply with FCC/IC rules. In particular, operation of radio channels overlapping
the band 5600-5650 MHz is not allowed and these channels are permanently barred.

In addition, other channels may also need to be barred when operating close to weather radar
installations.

A Note

To ensure compliance with FCC rules (KDB 443999: Interim Plans to Approve UNII Devices
Operating in the 5470 - 5725 MHz Band with Radar Detection and DFS Capabilities), follow
Avoidance of weather radars on page 94.

Other variants of the ePMP are available for use in the rest of the world, but these variants are not
supplied to the USA or Canada except under strict controls, when they are needed for export and
deployment outside the USA or Canada.
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Specific expertise and training required for professional installers

To ensure that the ePMP is installed and configured in compliance with the requirements of
Industry Canada and the FCC, installers must have the radio engineering skills and training
described in this section. This is particularly important when installing and configuring an ePMP
system for operation in the 5 GHz band (5150 — 5250 MHz - FCC only, 5250 — 5350 MHz, 5470 - 5725
MHz and 5725 - 5850 MHz).

Avoidance of weather radars

The installer must be familiar with the requirements in FCC KDB 443999. Essentially, the installer
must be able to:

e Access the FCC database of weather radar location and channel frequencies.

e Use this information to correctly configure the product (using the GUI) to avoid operation on
channels that must be avoided according to the guidelines that are contained in the KDB and
explained in detail in this user guide.

In ETSI regions, the band 5600 MHz to 5650 MHz is reserved for the use of weather radars.

External antennas

When using a connectorized version of the product (as compared to the version with an integrated
antenna), the conducted transmit power must be reduced to ensure the regulatory limit on
transmitter EIRP is not exceeded. The installer must have an understanding of how to compute the
effective antenna gain from the actual antenna gain and the antenna cable losses.

The product GUI automatically applies the correct conducted power limit to ensure that it is not
possible for the installation to exceed the EIRP limit, when the appropriate values for antenna gain
are entered into the GUIL.

Ethernet networking skills

The installer must have the ability to configure IP addressing on a PC and to set up and control
products using a web browser interface.

Lightning protection

To protect outdoor radio installations from the impact of lightning strikes, the installer must be
familiar with the normal procedures for site selection, bonding and grounding. Installation
guidelines for the ePMP can be found in section System planning on page 90.

Training
The installer needs to have basic competence in radio and IP network installation. The specific

requirements applicable to the ePMP must be gained by reading this user guide and by performing
sample setups at base workshop before live deployments.
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About This User Guide

This guide describes the planning, installation, configuration and operation of the Cambium ePMP

Series of point-to-multipoint wireless Ethernet systems. It is intended for use by the system
designer, system installer and system administrator.

For radio network design, see:
e Product description

e System hardware

e System planning

e Legal and reference information

For system configuration, monitoring and fault finding, see:
¢ Configuration
e Operation and Troubleshooting

For radio equipment installation, refer to the following guides:
e The ePMP Quick Start Guide
o The ePMP Installation Guide

026v003

12



cPMP

CAMBIUM NETWORKS

General information

VERSION INFORMATION

The following shows the issue status of this document:

Issue Date of issue Remarks
001v000 October 2013 System Release 1.0 (Software Release 1.1.6)
002v000 December 2013 System Release 1.0 (Software Release 1.2.3)
003v000 January 2014 System Release 1.0 (Software Release 1.3.4)
004v000 March 2014 System Release 1.0 (Software Release 1.4.1)
005v000 March 2014 System Release 1.0 (Software Release 1.4.3)
006v000 April 2014 System Release 1.0 (Software Release 1.4.4)
007v000 June 2014 System Release 2.0 (Software Release 2.0)
008v000 July 2014 System Release 2.1 (Software Release 2.1)
010v000 September 2014 System Release 2.2 (Software Release 2.2)
011v000 October 2014 System Release 2.3 (Software Release 2.3)
012v000 November 2014 System Release 2.3.1 (Software Release 2.3.1)
013v000 December 2014 System Release 2.3.3 (Software Release 2.3.3)
014v000 December 2014 System Release 2.3.4 (Software Release 2.3.4)
015v000 March 2015 System Release 2.4 (Software Release 2.4)
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016v000 April 2015 System Release 2.4.1 (Software Release 2.4.1)
System Release 2.4.2 (Software Release 2.4.2)
017v000 June 2015 System Release 2.4.3 (Software Release 2.4.3)
018v000 August 2015 System Release 2.5 (Software Release 2.5)
019v000 October 2015 System Release 2.5.1 (Software Release 2.5.1)
020v000 November 2015 System Release 2.5.2 (Software Release 2.5.2)
021v000 December 2015 System Release 2.6 (Software Release 2.6)
022v000 February 2016 System Release 2.6.1 (Software Release 2.6.1)
023v000 June 2016 System Release 2.6.2 (Software Release 2.6.2)
024v000 June 2016 System Release 3.0 (Software Release 3.0)
025v000 September 2016 System Release 3.0.1 (Software Release 3.0.1)
025v007 November 2016 System Release 3.1 (Software Release 3.1)
System Release 3.2 (Software Release 3.2)
025v008 December 2016 System Release 3.2.1 (Software Release 3.2.1)
025v009 January 2017
025v010
025v011 January 2017 System Release 3.2.2 (Software Release 3.2.2)
026v001 March 2017 System Release 3.3 (Software Release 3.3)
026v002 April 2017
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CONTACTING CAMBIUM NETWORKS

Support website:
Main website:
Sales enquiries:
Support enquiries:

Telephone number list:

http://www.cambiumnetworks.com/support

http://www.cambiumnetworks.com

solutions @cambiumnetworks.com
support@cambiumnetworks.com

http://www.cambiumnetworks.com/support/contact-support/

Address: Cambium Networks Limited,
3800 Golf Road, Suite 360
Rolling Meadows, IL 60008
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Purpose

Cambium Networks ePMP documents are intended to instruct and assist personnel in the
operation, installation and maintenance of the Cambium ePMP equipment and ancillary devices. It
is recommended that all personnel engaged in such activities be properly trained.

Cambium disclaims all liability whatsoever, implied or expressed, for any risk of damage, loss or
reduction in system performance arising directly or indirectly out of the failure of the customer, or
anyone acting on the customer's behalf, to abide by the instructions, system parameters, or
recommendations made in this document.

Cross references

References to external publications are shown in jtalics. Other cross references, emphasized in
green text in electronic versions, are active links to the references.

Feedback

We appreciate feedback from the users of our documents. This includes feedback on the structure,
content, accuracy, or completeness of our documents.

For feedback, e-mail to support@cambiumnetworks.com.
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Problems and warranty

Reporting problems

If any problems are encountered when installing or operating this equipment, follow this
procedure to investigate and report:

1  Search this document and the software release notes of supported releases.

2 Visit the support website:

http://www.cambiumnetworks.com/support/
3 Ask for assistance from the Cambium product supplier.
4  Gather information from affected units, such as any available diagnostic downloads.

5 Escalate the problem by emailing or telephoning support:
http://www.cambiumnetworks.com/support/contact-support

Repair and service

If unit failure is suspected, obtain details of the Return Material Authorization (RMA) process from
the support website.

Warranty

Cambium’s standard hardware warranty is for one (1) year from date of shipment from Cambium
or a Cambium distributor. Cambium warrants that hardware will conform to the relevant published
specifications and will be free from material defects in material and workmanship under normal
use and service. Cambium shall within this time, at its own option, either repair or replace the
defective product within thirty (30) days of receipt of the defective product. Repaired or replaced
product will be subject to the original warranty period but not less than thirty (30) days.

To register PMP products or activate warranties, visit the support website.

For warranty assistance, contact the reseller or distributor.
A Caution

Do not open the radio housing for repair or diagnostics; there are no serviceable parts within
the housing.

Portions of Cambium equipment may be damaged from exposure to electrostatic discharge.
Use precautions to prevent damage.
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Security advice

Cambium Networks systems and equipment provide security parameters that can be configured
by the operator based on their particular operating environment. Cambium recommends setting
and using these parameters following industry recognized security practices. Security aspects to
be considered are protecting the confidentiality, integrity, and availability of information and
assets. Assets include the ability to communicate, information about the nature of the
communications, and information about the parties involved.

In certain instances Cambium makes specific recommendations regarding security practices,
however the implementation of these recommendations and final responsibility for the security of
the system lies with the operator of the system.

Cambium Networks ePMP equipment is shipped with default web management interface login
credentials. It is highly recommended that these usernames and passwords are modified prior to
system deployment.
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Warnings, cautions, and notes

The following describes how warnings and cautions are used in this document and in all
documents of the Cambium Networks document set.

Warnings
Warnings precede instructions that contain potentially hazardous situations. Warnings are used to

alert the reader to possible hazards that could cause loss of life or physical injury. A warning has
the following format:

mWarning

Warning text and consequence for not following the instructions in the warning.

Cautions
Cautions precede instructions and are used when there is a possibility of damage to systems,

software, or individual items of equipment within a system. However, this damage presents no
danger to personnel. A caution has the following format:

A Caution

Caution text and consequence for not following the instructions in the caution.

Notes

A note means that there is a possibility of an undesirable situation or provides additional
information to help the reader understand a topic or concept. A note has the following format:

A Note

Note text
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Caring for the environment

The following information describes national or regional requirements for the disposal of
Cambium Networks supplied equipment and for the approved disposal of surplus packaging.

In EU countries

The following information is provided to enable regulatory compliance with the European Union
(EU) directives identified and any amendments made to these directives when using Cambium
equipment in EU countries.

X

Disposal of Cambium equipment
European Union (EU) Directive 2002/96/EC Waste Electrical and Electronic Equipment (WEEE)

Do not dispose of Cambium equipment in landfill sites. For disposal instructions, see
http://www.cambiumnetworks.com/support

Disposal of surplus packaging

Do not dispose of surplus packaging in landfill sites. In the EU, it is the individual recipient’s
responsibility to ensure that packaging materials are collected and recycled according to the
requirements of EU environmental law.

In non-EU countries

In non-EU countries, dispose of Cambium equipment and all surplus packaging in accordance with
national and regional regulations.
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Product description

This chapter provides a high level description of the ePMP product. It describes the function of the
product, the main product variants and typical deployment. It also describes the main hardware
components.

The following topics are described in this chapter:

e The key features, typical uses, product variants and components of the ePMP are explained in
Overview of ePMP on page 21.

e How the ePMP wireless link is operated, including modulation modes, power control and
security is described under Wireless operation on page 24.

e The ePMP management system, including the web interface, installation, configuration, alerts
and upgrades is described in System management on page 28.
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Overview of ePMP

This section introduces the key features, typical uses, product variants and components of the
ePMP.

PURPOSE

Cambium ePMP Series products are designed for Ethernet bridging over point-to-multipoint
microwave links in the unlicensed 5 GHz and 2.4 GHz bands. Users must ensure that the ePMP
Series complies with local operating regulations.

The ePMP Series acts as a transparent bridge between two segments of the operator and
customers’ networks. In this sense, it can be treated as a virtual wired connection between the
Access Point and the Subscriber Module. The ePMP Series forwards 802.3 Ethernet packets
destined for the other part of the network and filters packets it does not need to forward.

KEY FEATURES

The ePMP system is a high performance wireless bridge for Ethernet traffic with a maximum UDP
throughput of 200+ Mbps (40 MHz Channel Bandwidth). It is capable of operating in line-of-sight
(LOS) and near-LOS conditions. Its maximum LOS range is 13 mi (20 MHz channel bandwidth) or 9
mi (40 MHz channel bandwidth).

Utilizing GPS sync, the ePMP is an ideal fit for networks that require capacity and reliability for
superior QoS in remote and underserved areas. The integrated PTP and PMP solution features an
efficient GPS synchronized operational mode that permits highly scalable frequency reuse.

ePMP operates in the unlicensed 5 GHz and 2.4 GHz bands and supports a channel bandwidth of
up to 40 MHz. It is available with an integrated antenna or in connectorized version for use with an
external antenna.

The wireless link is primarily TDD based. System Release 1.2.3 added a Flexible Frame Ratio
option which provides improved latency and throughput under unsynchronized operational mode.

From a network point-of-view, the ePMP wireless link is a transparent Layer 2 bridge. It offers
limited switching capability in order to support a primary and a secondary (future release) Ethernet
port on the Subscriber Module.

ePMP supports quality of service (QoS) classification capability and supports three traffic priorities.
Management of the unit is conducted via the same interface as the bridged traffic (in-band
Management).

System Release 1.3.4 adds support for RADIUS EAP-TTLS authentication and VSA support for MIR.

When deployed with a sector antenna, the ePMP 1000 GPS Sync Radio can be configured as a GPS
synchronized Access Point serving ePMP Integrated Radios configured as Subscriber Modules.
When deployed with a high gain point to point antenna, the ePMP GPS Sync Radio can be
configured to be a GPS Synchronized Backhaul Master, forming a PTP link with another ePMP
Radio module.

Powered by Hypure™ technology, ePMP 2000 features Smart Beamforming. This powerful
addition to your network creates narrow, targeted beams to each subscriber, rather than relying on
a traditional wide beam, blocking out multiple sources of interference to keep performance high.

ePMP 2000 also includes Intelligent Filtering, working automatically to clean up the signals
received by the access point as well as keep its owns transmissions clean. This helps not just that
single access point reach optimum performance, but the whole tower too.
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A summary of the main ePMP characteristics is listed under Table 1.

Table 1 Main characteristics of the ePMP Series

Characteristic Value

Topology PMP or PTP

Wireless link condition LOS, near LOS

Scheduler TDD (Fixed or Flexible Ratios), ePTP, Standard WiFi

Connectivity Ethernet

Operating frequencies ePMP 2000
Unlicensed bands, 5 GHz

ePMP 1000
Unlicensed bands, 5 GHz and 2.4 GHz

Channel bandwidth 5 MHz, 10 MHz, 20 MHz or 40 MHz

Data rate 200+ Mbps

TYPICAL DEPLOYMENT EQUIPMENT

The ePMP is a solution consisting of integrated or connectorized outdoor units, indoor power
supply units/LAN injectors, cabling and surge suppression equipment.

The main hardware components of an ePMP deployment are as follows:

¢ ePMP 2000 Access Point with Intelligent Filtering and Sync or Connectorized Radio with GPS
Sync (ePMP 1000): A connectorized outdoor transceiver unit containing all the radio,
networking, and surge suppression electronics.

o ePMP 2000 Access Point with Intelligent Sync Power Supply or GPS Sync Connectorized Radio
(ePMP 1000) Power Supply: An indoor power supply module providing Power-over-Ethernet
(PoE) supply and 1000/100/10 Base-TX to the Access Point.

e ePMP 2000 Access Point with Intelligent Sync or GPS Sync Connectorized Radio (ePMP 1000)
Radio Cabling and lightning protection: Shielded Cat5e cables, grounding cables, and
connectors.

¢ Integrated Radio: An integrated-antenna outdoor transceiver unit containing all the radio,
networking, antenna, and surge suppression electronics.

¢ Integrated or Un-sync Connectorized Radio: A connectorized outdoor transceiver unit
containing all the radio, networking and surge suppression electronics.

¢ Integrated Radio Power Supply: An indoor power supply module providing Power-over-
Ethernet (PoE) supply and 100/10 Base-TX to the Subscriber Module.

¢ Integrated Radio Cabling and lightning protection: Shielded Cat5e cables and connectors

For more information about these components, including interfaces, specifications and Cambium
part numbers, see System hardware on page 32.
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EPMP ELEVATE

ePMP Elevate is a software solution allowing fixed wireless broadband networks to gain the
powerful signature capabilities of Cambium Networks’ ePMP platform, including frequency reuse
enabled by GPS Synchronization and Smart Beamforming, even on non-Cambium 802.11n-based
hardware.

Network migration is taken to the next level, solving a major pain-point for all wireless network
operators. At a fraction of the cost and time of a total network replacement, an operator only needs
to install an ePMP Access Point and to load their deployed subscriber modules with ePMP Elevate
software. The hardware investment is protected, and the existing infrastructure is given a new
lease of life to support revenue-generating applications for years to come.

ePMP Elevate networks can be managed by cnMaestro, the cloud-based or on-premise platform
that provides end-to-end management, device onboarding, and maintenance support for wireless
broadband networks from a single, easy-to-use interface.

Starting with Software Release 3.3, each ePMP AP is configured with one free ePMP Elevate
license (to accept registration from one non-Cambium subscriber module).

For more information about ePMP Elevate, see the ePIMP Elevate website.

(7@ Cambium Networks _ —er- R I
U ePMP 1000 Hovate | NEPMP_7f8fes | Subscriber Module % 0} & Administrator ~
A& Home Monitor » System
Hardware Version ePMP Elevate PBE-M5-400-XW
& Quick Start
Serial number (MSN) NiA
¢ Configuration~ Firmware Version U-Boot 1.1.4-5958 (Jun 10 2015 - 10:56:20)
-v* Monitor~ Software Version 3.2-RC12
Device-Agent Version 2.60
ﬁ Performance
Date and Time 01 Sep 2015, 00:01:35 GMT
B system System Uptime 1 minute, 38 seconds
= Wireless MAC Address 44:D9:ETTEBFER
T Wireless
Ethernet MAC Address 44:DETTFBFRER
all. Throughput Chart DFS Status Channel Availability Check
@;ﬁ? Network Read-Only Users o
Read-Write Users 1
=~ System Log
SM Current GUI User Authentication Device Local Only
f' Tools+ Factory Reset Via Power Sequence Enabled

cnMaestro Connection Status Connecting in 1 minute

cniaestro Account ID

Figure 1 ePMP Elevate subscriber example
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Wireless operation

This section describes how the ePMP wireless link is operated, including modulation modes,
power control and security.

TIME DIVISION DUPLEXING

TDD cycle

ePMP links operate using Time Division Duplexing (TDD). The links employ a TDD cycle in which
the APs determines which SMs may transmit and when based on the configured downlink/uplink
ratio (duty cycle). Three fixed Downlink/Uplink frame ratios are available — 75/25, 50/50 and 30/70.
A flexible frame ratio is available as a fourth option where the AP dynamically determines the
downlink and uplink ratio based on data demand in each direction.

OFDM AND CHANNEL BANDWIDTH

The ePMP series transmits using Orthogonal Frequency Division Multiplexing (OFDM). This
wideband signal consists of many equally spaced sub-carriers. Although each sub carrier is
modulated at a low rate using conventional modulation schemes, the resultant data rate from all
the sub-carriers is high.

The channel bandwidth of the OFDM signal is 5 MHz, 10 MHz, 20 MHz or 40 MHz, based on
operator configuration.

Each channel is offset in center frequency from its neighboring channel by 5 MHz.

ADAPTIVE MODULATION

The ePMP series can transport data over the wireless link using a number of different modulation
modes ranging from 64-QAM to QPSK. For a given channel bandwidth and TDD frame structure,
each modulation mode transports data at a fixed rate. Also, the receiver requires a given signal to
noise ratio in order to successfully demodulate a given modulation mode. Although the more
complex modulations such as 64QAM will transport data at a much higher rate than the less
complex modulation modes, the receiver requires a much higher signal to noise ratio.

The ePMP series provides an adaptive modulation scheme where the receiver constantly monitors
the quality of the received signal and notifies the far end of the link of the optimum modulation
mode with which to transmit. In this way, optimum capacity is achieved at all times.

MIMO

Multiple-Input Multiple-Output (MIMO) technique provides protection against fading and increases
the probability of a received decoded signal to be usable.

The ePMP transmits two signals on the same radio frequency, one of which is 90 degrees offset
from the other.
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RADAR AVOIDANCE

In regions where protection of radars is part of the local regulations, the ePMP must detect
interference from radar-like systems and avoid co-channel operation with these systems.

To meet this requirement, the ePMP implements the following features:

o The equipment can only transmit on available channels, of which there are none at initial
power up. The radar detection algorithm will always scan a usable channel for 60 seconds for
radar interference before making the channel an available channel.

e This compulsory channel scan will mean that there is at least 60 seconds service outage every
time radar is detected and that the installation time is extended by at least 60 seconds even if
there is found to be no radar on the channel

There is a secondary requirement for bands requiring radar avoidance. Regulators have mandated
that products provide a uniform loading of the spectrum across all devices. In general, this
prevents operation with fixed frequency allocations. However:

e ETSI regulations do allow frequency planning of networks (as that has the same effect of
spreading the load across the spectrum).

e The FCC does allow channels to be avoided if there is actually interference on them.

A Note

When operating in a region which requires DFS, ensure that the AP is configured with alternate
frequencies and that the SM is configured to scan for these frequencies to avoid long outages.

ENCRYPTION

The ePMP supports optional encryption for data transmitted over the wireless link. The encryption
algorithm used is the Advanced Encryption Standard (AES) with 128-bit key size. AES is a
symmetric encryption algorithm approved by U.S. Government organizations (and others) to
protect sensitive information.

COUNTRY CODES

Some aspects of wireless operation are controlled, enforced or restricted according to a country
code. ePMP country codes represent individual countries (for example Denmark) or regulatory
regions (for example FCC or ETSI).

Country codes affect the following aspects of wireless operation:
¢ Maximum transmit power
e Radar avoidance

e Frequency range

2\
/1 .
&3 Caution
To avoid possible enforcement action by the country regulator, always operate links in
accordance with local regulations
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SMART BEAMFORMING (EPMP 2000 SERIES)

ePMP 2000 Smart Beamforming drastically reduces the effects of on-channel
interference. The System learns the locations of each served Subscriber Module
and forms a narrow beam towards the desired Subscriber Module while that
radio is transmitting in the uplink. This reduces the gain on the uplink for on-
channel interferers that are transmitting at an azimuth angle different than the
Subscriber Module, delivering performance gains never before seen.

Smart Antenna Key Advantages:

e Eliminate Uplink Interference: Smart Beamforming delivers dramatic performance
improvements when dealing with strong co-channel uplink interference, maximizing network
performance.

e Consistent Performance in High Interference: By mitigating significant sources of interference,
packet loss and retransmissions are kept to a minimum, keeping your network applications
working at their best.

e Improvement in Uplink and Downlink Performance: By eliminating packet loss and
retransmissions resulting from co-channel uplink interference, TCP retransmissions are greatly
reduced. Other applications also show significant performance benéefits.

INTELLIGENT FILTERING (EPMP 2000 SERIES)

ePMP 2000 Intelligent Filtering improves both receive and transmit performance. It protects the
network from off-channel interferers with a filter that dynamically moves around the channel. On
the transmit side, it protects the RF environment by reducing off-channel transmission noise.

PMP NETWORKS

Using frequency planning

Frequency planning is the exercise of assigning operating channels to PMP units so as to minimize
RF interference between links. Frequency planning must consider interference from any PMP unit
to any other PMP unit in the network. Low levels of interference normally allow for stable
operation and high link capacity.

The frequency planning task is made more straightforward by use of the following techniques:
e Using several different channels

e Separating units located on the same mast

o Configuring a 5 MHz guard band between adjacent sector operating band edges.

For help with planning networks, see System planning. You can also contact your Cambium
distributor or re-seller.
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FURTHER READING ON WIRELESS OPERATION

For information on planning wireless operation, see:

The regulatory restrictions that affect radio spectrum usage, such as frequency range and
radar avoidance is described under Radio spectrum planning on page 91

The factors to be taken into account when planning links such as range, path loss and data
throughput are described under Link planning on page 95.

The safety specifications against which the ePMP has been tested are listed under Compliance
with safety standards on page 427 . It also describes how to keep RF exposure within safe
limits.

How ePMP complies with the radio regulations that are enforced in various countries is
explained in Compliance with radio regulations on page 444.

Compliance with the radio regulations that are enforced in various regions is explained under
Notifications on page 462.

Tables and graphs to support calculation of the data rate capacity that can be provided by
ePMP configurations are available at Data throughput tables on page 474.

For more information on configuring and operating the wireless link, see:

The configuration parameters of the ePMP devices described under Configuration on page 100.

Post-installation procedures and troubleshooting tips explained under Operation and
Troubleshooting on page 291.
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System management

This section introduces the ePMP management system, including the web interface, installation,
alerts and upgrades, configuration and management software.

MANAGEMENT AGENT

ePMP equipment is managed through an embedded management agent. Management
workstations, network management systems or PCs can be connected to this agent using the
module’s Ethernet port or over the air (SM).

The management agent supports the following interfaces:
e Hypertext Transfer Protocol (HTTP)

e Hypertext Transfer Protocol secure (HTTPs)

e Simple Network Management Protocol (SNMP)

e Network Time Protocol (NTP)

e System logging (Syslog)

e Cambium Network Services Server (CNSS) software

¢ Dynamic Host Configuration Protocol (DHCP)

WEB SERVER

The ePMP management agent contains a web server. The web server supports access via the
HTTP and HTTPs interfaces.

Web-based management offers a convenient way to manage the ePMP equipment from a locally
connected computer or from a network management workstation connected through a
management network, without requiring any special management software. The web-based
interfaces are the only interfaces supported for installation of ePMP, and for the majority of ePMP
configuration management tasks.
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Figure 2 ePMP 1000 AP web-based management screenshot
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Figure 3 ePMP 2000 AP web-based management screenshot

Access Point

1

Device Name ePMP2000_d184b5 Wireless MAC Address 00:04:56:D1:84:B6
-f' Quick Start
ssID Cambium-AP Ethernet MAC Address 00:04:56:D1:84:85
£ configuration~ Operating Frequency 5800 MHz P Address 10.120.210.134
_“_ Monitor Operating Channel Bandwidth 20 MHz Date and Time 14 Nov 2016, 16:36:29 GMT
, Transmitter Output Power 13dBm System Uptime 14 minutes, 44 seconds
Tools~
Antenna Gain 17 dBi System Description kreddum
Country United States Sync Source Status GPS Sync Up
Access Point Mode DD Device Coordinates 12.90, 2
Downlink/Uplink Frame Ratio 50/50 DFS Status Not Availzble
Wireless Security Open Ethernet Status 100 Mbps / Full
cnMaestro Remote Management - Wireless Status Up
cnMaestro Connection Status Connected to Registered Subscriber Modules 2z
qa.cloud.cambiumnetwarks.com )
Uplink Antenna Sector Antenna

cnMaestro Account ID

KREDDUM_CNSNGQA

Smart Antenna

Power Supply

© 2016 Cambium Netwaorks, All Rights Reserved | Version 3.1 | Support | Community Farum

Smart Antenna is Disconnected, Power
on

Generic Power Supply

026v003

29



cPMP CAMBIUM NETWORKS

Web pages

The web-based management interfaces provide comprehensive web-based fault, configuration,

performance and security management functions organized into the following web-pages and

groups:

Access Point and Subscriber Module web-pages:

e Dashboard: The Dashboard web-page reports the general device status, session status,
remote subscriber status, event log information, and network interface status.

o Configure: The Configuration web-page may be utilized for configuring general device
parameters, as well as IP, radio, SNMP, Quality of Service (QoS), security, time, VLAN, protocol
filtering, and unit settings.

¢ Monitor: The Monitor web-page reports detailed operating statistics for the radio link and
network, and reports system log information.

o Tools: The tools web-page offers useful tools for device installation, configuration, and
operation including software upgrade, backup/restore, spectrum analyzer, throughput test,
ping test, and traceroute.

¢ Quick Start: The Quick Start web-page provides quick access to requisite parameters for radio
link establishment and network access.

Identity-based user accounts

When identity-based user accounts are configured, a security officer can define from one to four

user accounts, each of which may have one of the four possible roles:

e ADMINISTRATOR (default username/password “admin”), who has full read and write
permission.

o INSTALLER (default username/password “installer”), who has permission to read and write
parameters applicable to unit installation and monitoring.

e HOME (default username/password “home”), who has permission only to access pertinent
information for support purposes

e READONLY (default username/password “readonly”), who has permission to only view the
Monitor page.

SNMP

The management agent supports fault and performance management by means of an SNMP
interface. The management agent is compatible with SNMP v2c using one Management
Information Base (MIB) file which is available for download from the Cambium Networks Support
website (https:/support.cambiumnetworks.com/files/epmp).

NETWORK TIME PROTOCOL (NTP)

The clock supplies accurate date and time information to the system. It can be set to run with or
without a connection to a network time server (NTP). It can be configured to display local time by
setting the time zone and daylight saving in the Time web page.

If an NTP server connection is available, the clock can be set to synchronize with the server time at
regular intervals.

ePMP devices may receive NTP data from a CMM3 or CMM4 module or an NTP server configured
in the system’s management network.
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The Time Zone option is configurable on the AP’s Configure => System page and may be used to
offset the received NTP time to match the operator’s local time zone.

CAMBIUM NETWORK SERVICES SERVER

The Cambium Network Services Server (CNSS) may be used to monitor, configure, and upgrade
Cambium network equipment.

For Cambium Network Services Server download, see
https://support.cambiumnetworks.com/files/cns%20server/.

SOFTWARE UPGRADE

Software upgrades may be issued via the radio web interface (Tools => Software Upgrade) or via
CNSS (Cambium Networks Services Server). For Software upgrades, see
https://support.cambiumnetworks.com/files/epmp.

FURTHER READING ON SYSTEM MANAGEMENT
For more information on system management, see:

e AP System page on page 140

e SM System page on page 205

¢ Operation and Troubleshooting on page 291
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System hardware

This chapter describes the site planning and hardware components of an ePMP link.

The following topics are described in this chapter:

Factors to be considered when planning the proposed network is described under Site
planning on page 33.

The ePMP 2000 Access Point with Intelligent Filtering and Sync module hardware, part
numbers, mounting equipment, and specifications are described under ePMP 2000 Access
Point with Intelligent Filtering and Sync on page 36.

The ePMP 1000 Connectorized with Sync module hardware, part numbers, mounting
equipment, and specifications are described under ePMP 1000 Connectorized Radio with Sync
on page 46.

The ePMP 1000 Integrated hardware, part numbers, mounting equipment and specifications
are described under ePMP 1000 Integrated Radio on page 54 (ePMP 1000).

The ePMP 1000 Connectorized hardware, part numbers, mounting equipment and
specifications are described under ePMP 1000 Connectorized Radio on page 60 (ePMP 1000).
The Force 180 hardware, part numbers, mounting equipment and specifications are described
under Force 180 on page 68.

The Force 200 hardware, part numbers, mounting equipment and specifications are described
under Force 200 on page 74.

The power supply hardware, part numbers and specifications are described under ePMP 1000
Series Power Supply on page 84.

The AP sector antenna (including optional Smart Antenna) part numbers are described under
ePMP 2000 Access Point with Intelligent Filtering and Sync, antennas and antenna cabling on
page 44 (ePMP 2000) ePMP 1000 Connectorized Radio with Sync, antennas and antenna
cabling on page 53 (ePMP 1000).

Cable standards and lengths are described under Ethernet cabling on page 87.

Surge suppression requirements and recommendations are described under Surge
Suppression unit on page 88.
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Site planning
Conduct a site survey to ensure that the proposed AP and SM sites meet the requirements defined
in this section.

SITE INSTALLATION

An ePMP site typically consists of a high supporting structure such as a mast, tower or building for
the AP or SM.

There is only one Ethernet interface, a copper Catbe connection from the AP or SM to the AP/SM
power supply and network terminating equipment. If a 1000 Base-TX (Gigabit) Ethernet connection
is required at the AP, ensure that power supply NO0O0900L0O01A (ePMP 1000) or NOOOOOOL0O34A
(ePMP 2000) is utilized.

GROUNDING AND LIGHTNING PROTECTION

Structures, equipment and people must be protected against power surges (typically caused by
lightning) by conducting the surge current to ground via a separate preferential solid path. The
actual degree of protection required depends on local conditions and applicable local regulations.
To adequately protect an ePMP installation, both ground bonding and transient voltage surge
suppression are required.

mWarning

Electro-magnetic discharge (lightning) damage is not covered under warranty. The
recommendations in this guide, when followed correctly, give the user the best protection from
the harmful effects of EMD. However 100% protection is neither implied nor possible.

Details of lightning protection methods and requirements can be found in the international
standards IEC 61024-1 and IEC 61312-1, the U.S. National Electric Code ANSI/NFPA No. 70-1984 or
section 54 of the Canadian Electric Code.
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Ad Note

International and national standards take precedence over the requirements in this guide.
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Figure 4 AP Cabling Diagram

LIGHTNING PROTECTION ZONES

Use the rolling sphere method (Figure 6) to determine where it is safe to mount equipment. An
imaginary sphere, typically 50 meters in radius, is rolled over the structure. Where the sphere rests
against the ground and a strike termination device (such as a finial or ground bar), all the space
under the sphere is considered to be in the zone of protection (Zone B). Similarly, where the
sphere rests on two finials, the space under the sphere is considered to be in the zone of

protection.
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Figure 5 SM Cabling Diagram
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Figure 6 Rolling sphere method to determine the lightning protection zones
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mWarning

Do not mount equipment in Zone A which can put the equipment, structures and life at risk.

-
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ePMP 2000

ePMP 2000 Access Point with Intelligent Filtering and Sync

For details of the ePMP 2000 Access Point with Intelligent Filtering and Sync connectorized
hardware, see:

ePMP 2000 Access Point with Intelligent Filtering and Sync description on page 36

ePMP 2000 Access Point with Intelligent Filtering and Sync part numbers on page 37

ePMP 2000 Access Point with Intelligent Filtering and Sync mounting bracket on page 38

ePMP 2000 Access Point with Intelligent Filtering and Sync interfaces on page 39
ePMP 2000 Access Point with Intelligent Filtering and Sync LEDs on page 40

ePMP 2000 Access Point with Intelligent Filtering and Sync specifications on page 40

ePMP 2000 Access Point with Intelligent Filtering and Sync heater on page 42

ePMP 2000 Access Point with Intelligent Filtering and Sync - external antenna location on page

42

ePMP 2000 Access Point with Intelligent Filtering and Sync wind loading on page 43

ePMP 2000 Access Point with Intelligent Filtering and Sync software packages on page 44

ePMP 2000 Access Point with Intelligent Filtering and Sync, antennas and antenna cabling on

page 44

EPMP 2000 ACCESS POINT WITH INTELLIGENT FILTERING AND SYNC
DESCRIPTION

The ePMP 2000 Access Point with Intelligent
Filtering and Sync device is a self-contained
transceiver unit that houses both radio and
networking electronics. The connectorized unit
is designed to work with externally mounted
antennas that have high gains to cope with
difficult radio conditions. The unit is designed
with female RP-SMA 50Q antenna connections
located at the top of the unit and female RP-
SMA 50Q DC-coupled for connection to the
optional Smart Antenna.

A Note

To select antennas, RF cables and
connectors for connectorized units,
see ePMP 2000 Access Point with
Intelligent Filtering and Sync,
antennas and antenna cabling on page
44.

Figure 7 ePMP 2000 Series Access Point with
Intelligent Filtering and Sync
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(il

////_
)

/

026v003

36



cPMP

CAMBIUM NETWORKS

EPMP 2000 ACCESS POINT WITH INTELLIGENT FILTERING AND SYNC PART
NUMBERS

Choose the correct regional variant: one is for use in regions where FCC or IC licensing restrictions
apply (FCC/IC), one is for use in ETSI countries (EU), and one is for non-FCC/IC/ETSI-restricted
regions (RoW).

Each of the parts listed in Table 2 includes the following items:

¢ Onecon

nectorized unit

e One power supply 1000/100/10 Base-TX LAN injector

The GPS-capable parts listed in Table 2 also ship with a GPS antenna.

Table 2 ePMP 2000 Access Point with Intelligent Filtering and Sync part numbers

Cambium description

Cambium part number

ePMP 2000: 5 GHz AP with Intelligent Filtering and Sync (EU) C050900A033A
ePMP 2000: 5 GHz AP with Intelligent Filtering and Sync (FCC) C058900A132A
ePMP 2000: 5 GHz AP with Intelligent Filtering and Sync (ROW) (no C050900A031A
cord)
PMP 2000: 5 GHz AP with Intelligent Filteri dS ROW) (EU
iord) z with Intelligent Filtering and Sync ( ) ( CO50900A231A
ePMP 2000: 5 GHz AP with Intelligent Filtering and Sync (ROW) (US CO50900A131A
cord)
ePMP 2000: 5 GHz AP with Intelligent Filtering and Sync (EU) (UK cord) C050900A333A
PMP 2000: 5 GHz AP with Intelligent Filteri dS ROW) (UK
iord) z with Intelligent Filtering and Sync ( ) ( CO50900A331A
PMP 2000: 5 GHz AP with Intelligent Filteri d ROW) (Indi
iord) GHz with Intelligent Filtering and Sync (ROW) (India C050900A431A
PMP 2000: 5 GHz AP with Intelligent Filteri ds ROW) (Chi
sord) z with Intelligent Filtering and Sync ( ) (China CO50900A531A
PMP 2000: 5 GHz AP with Intelligent Filteri ds ROW) (Brazil
sord) z with Intelligent Filtering and Sync ( ) (Brazi CO50900A631A
ePMP 2000: 5 GHz AP with Intelligent Filtering and Sync
(ROW)(Argentina cord) C050900A731A
ePMP 2000: 5 GHz AP with Intelligent Filtering and Sync (ROW)(ANZ C050900A831A
cord)
ePMP 2000: 5 GHz AP Lite with Intelligent Filtering and Sync (EU) C050900L033A
ePMP 2000: 5 GHz AP Lite with Intelligent Filtering and Sync (FCC) C058900L132A
PMP 2000: 5 GHz AP Lite with Intelli t Filteri dsS ROW
Sord) z ite with Intelligent Filtering and Sync ( ) (no C050900L031A
PMP 2000: Hz AP Li ith Intelli Filteri ROW
e 000: 5 GHz ite with Intelligent Filtering and Sync (ROW) C050900L231A
(EU cord)
PMP 2000: Hz AP Li ith Intelli Filteri ROW
e 000: 5 GHz ite with Intelligent Filtering and Sync (ROW) C050900L131A
(US cord)
PMP 2000: 5 GHz AP Lite with Intelli t Filteri ds EU) (UK
Eo,—d) z ite with Intelligent Filtering and Sync (EU) ( C050900L333A
ePMP 2000: 5 GHz AP Lite with Intelligent Filtering and Sync (ROW) C050900L331A

(UK cord)
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ePMP 2000: 5 GHz AP Lite with Intelligent Filtering and Sync (ROW)

(India cord) C050900L431A
;agm:az(?:r(zj:)S GHz AP Lite with Intelligent Filtering and Sync (ROW) CO50900LE31A
(E:II;I\:ZPHZC%(?();)S GHz AP Lite with Intelligent Filtering and Sync (ROW) C050900L631A
(e;gﬂvl\’l)%g(r)gégtﬁl;zcﬁfdl)_ite with Intelligent Filtering and Sync C050900LT31A
ePMP2000 AP Lite License Key — Upgrade Lite (10 SM) to Full (120 SM) C050900S2KLA

Table 3 Access Point with Intelligent Filtering and Sync accessory part numbers

Cambium description Cambium part number

POWER SUPPLY, 30W, 56V — Gbps support NO00000L034

EPMP 2000 ACCESS POINT WITH INTELLIGENT FILTERING AND SYNC
MOUNTING BRACKET

The ePMP 2000 Access Point with Intelligent Filtering and Sync is designed to be attached to the
new Cambium ePMP sector antenna (see Table 10). The new Cambium ePMP sector antenna
contains all of the mounting brackets, antenna cabling, and GPS antenna mounting for device

deployment.

Figure 8 ePMP 2000 Access Point with Intelligent Filtering and Sync mounted to ePMP sector
antenna
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EPMP 2000 ACCESS POINT WITH INTELLIGENT FILTERING AND SYNC
INTERFACES

The ePMP 2000 Access Point with Intelligent Filtering and Sync interfaces are illustrated in Figure
9 and described in Table 4.

Figure 9 Connectorized Radio with Sync interfaces

— Antenna port H Smart Smart
4 l— Antenna port V Antenna port Antenna port
Vv H
Ethernet
(DS Q
— GPS  Reset Button Status LEDs
Table 4 ePMP 2000 Access Point with Intelligent Filtering and Sync interfaces
Name Connector Interface Description
Antenna RP-SMA, Antenna, .
L To/from H polarized antenna port
port H female H polarization
Ant RP-SMA, Ant , .
ntenna 3 enn_a . To/from V polarized antenna port
port V female V polarization
Smart RP-SMA, Smart _
Antenna female Antenna, H To/from H polarized Smart Antenna port
port H polarization
Smart RP-SMA, Smart _
Antenna female Antenna, V To/from V polarized Smart Antenna port
portV polarization
802.3at-compliant
PoE input Please note: A non-802.3at-compliant pow_er
supply may also be used to power the device.
Ethernet RJ45 The power supply must supply at least 20 Watts.
10/100/1000
Base-TX Management and data
Ethernet
GPS SMA, female Antenna, GPS To/from GPS antenna
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Reset

Button

Physical button N/A

For resetting the radio and for setting the radio
back to its factory default configuration. See
Using the device external reset button on page
300.

EPMP 2000 ACCESS POINT WITH INTELLIGENT FILTERING AND SYNC LEDS

-

T

© PwR
© GPS
 m=
0 ==
5
© ENET

LED

Function

POWER

Green: Power is applied to the device

Unlit: No power is applied to the device or improper
power source

GPS
SYNC

Orange: AP has acquired a 1PPS GPS synchronization
pulse either from the internal GPS module and antenna
or from a connected CMM

Unlit: 1PPS GPS not acquired, or Synchronization
Source set to Internal (AP operates without sync)

No LEDs lit: Three or less satellites tracked
One LED lit: Four or five satellites tracked
Two LEDs lit: Six or seven satellites tracked

All LEDs lit: Eight or more satellites are tracked

ETH

Once lit, blinking indicates Ethernet activity
Red: 10BaseTX link

Green: 100BaseTX link

Orange: 1000BaseTX link

Unlit: No Ethernet link established

EPMP 2000 ACCESS POINT WITH INTELLIGENT FILTERING AND SYNC

SPECIFICATIONS

The ePMP 2000 Access Point with Intelligent Filtering and Sync connectorized module conforms to
the specifications listed in Table 5 and Table 6.
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The connectorized module meets the low level static discharge specifications identified in
Electromagnetic compatibility (EMC) compliance on page 429 and provides internal surge
suppression but does not provide lightning suppression.

For a full listing of Access Point with Intelligent Filtering and Sync specifications, see the ePMP
2000 website.

Table 5 ePMP 2000 Access Point with Intelligent Filtering and Sync physical specifications

Category Specification

Dimensions (H x W x D) Radio: 22.2 x 12.4 x 4.5 cm (8.75 x 4.9 x 1.75 in) without
brackets

Weight .7 kg (1.5 Ibs) without brackets

Table 6 ePMP 2000 Access Point with Intelligent Filtering and Sync environmental specifications

Category Specification
Temperature -30°C (-22°F) to +55°C (131°F)
Wind loading 118 mph (190 kph) maximum. See ePMP 2000 Access Point

with Intelligent Filtering and Sync wind loading on page 43
for a full description.

Humidity 95% condensing

Environmental IP55
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EPMP 2000 ACCESS POINT WITH INTELLIGENT FILTERING AND SYNC HEATER

At startup, if the ePMP 2000 Access Point with Intelligent Filtering and Sync module temperature is
at or below 32° F (0° C), an internal heater is activated to ensure that the device is able to
successfully begin operation. The unit’s heater is only activated when the unit is powered on and
will not apply heat to the device once startup is complete. When the unit temperature is greater
than 32° F (0° C), the heater is deactivated and the unit continues its startup sequence.

The effect on device startup time at various temperatures is defined in Table 7.

Table 7 ePMP 2000 Access Point with Intelligent Filtering and Sync startup times based on
ambient temperature

Initial Temperature Startup time (from power on to operational)

-22° F (-30° C) 20 minutes
-4° F (-20° C) 6 minutes
14° F (-10° C) 2 minutes, 30 seconds

EPMP 2000 ACCESS POINT WITH INTELLIGENT FILTERING AND SYNC -
EXTERNAL ANTENNA LOCATION

Find a location for the device and external antenna that meets the following requirements:
e The equipment is high enough to achieve the best radio path.

e People can be kept a safe distance away from the equipment when it is radiating. The safe
separation distances are defined in Calculated distances and power compliance margins on
page 431.

e The equipment is lower than the top of the supporting structure (tower, mast or building) or its
lightning air terminal.

e The location is not subject to excessive wind loading. For more information, see ePMP 2000
Access Point with Intelligent Filtering and Sync wind loading on page 43.

026v003 42



cePMP CAMBIUM NETWORKS

EPMP 2000 ACCESS POINT WITH INTELLIGENT FILTERING AND SYNC WIND
LOADING

Ensure that the device and the structure on which it is mounted are capable of withstanding the
prevalent wind speeds at a proposed ePMP site. Wind speed statistics are available from national
meteorological offices.

The device and its mounting bracket are capable of withstanding wind speeds of up to 190 kph
(118 mph).

Wind blowing on the device will subject the mounting structure to significant lateral force. The
maghnitude of the force depends on both wind strength and surface area of the device. Wind
loading is estimated using the following formulae:

Force (in kilograms) = 0.1045aV?
Where: Is:
a surface area in square meters
\% wind speed in meters per second
Force (in pounds) = 0.0042Av?
Where: Is:
A surface area in square feet

\% wind speed in miles per hour
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Applying these formulae to the ePMP device at different wind speeds, the resulting wind loadings
are shown in Table 17 and Table 18.

Table 8 ePMP 2000 Access Point with Intelligent Filtering and Sync wind loading (Kg)

Type of ePMP Largest Wind speed (meters per second)
device surface area

(square meters) 30 40 50 60 70
Connectorized 0.09 8.5 Kg 15 Kg 23.5 33.9Kg 46.1Kg
with Sector Kg
Antenna

Table 9 ePMP 2000 Access Point with Intelligent Filtering and Sync wind loading (Ib)

Type of ePMP device Largest Wind speed (miles per hour)
surface area
(square feet)

80 100 120 140 150

Connectorized with 1 2691b 421b 60.11b 82.321b 107.51b
Sector Antenna

EPMP 2000 ACCESS POINT WITH INTELLIGENT FILTERING AND SYNC
SOFTWARE PACKAGES

ePMP 2000 Access Point with Intelligent Filtering and Sync devices may be upgraded by
downloading new software packages from the Cambium Networks website or by using the
Cambium Network Services Server. The software packages applicable to ePMP connectorized
radios are named:

e ePMP-GPS_Synced-v3.3.tar.gz (or higher version number)

EPMP 2000 ACCESS POINT WITH INTELLIGENT FILTERING AND SYNC,
ANTENNAS AND ANTENNA CABLING

ePMP 2000 Access Point with Intelligent Filtering and Sync devices require external antennas
connected using RF cables (included with Cambium ePMP sector antennas). For details of the
antennas and accessories required for a connectorized ePMP installation, see:

e Antenna requirements on page 44
e FCC and IC approved antennas on page 45

ANTENNA REQUIREMENTS

For ePMP 2000 Access Point with Intelligent Filtering and Sync units operating in the USA or
Canada 5 GHz bands, choose external antennas from those listed in FCC and IC approved antennas
on page 45. For installations in other countries, the listed antennas are advisory, not mandatory.
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FCC AND IC APPROVED ANTENNAS

For ePMP 2000 Access Point with Intelligent Filtering and Sync units operating in the USA or
Canada, choose external antennas from Table 10. These are approved by the FCC for use with the
product and are constrained by the following limits:

e 5 GHz - 18 dBi gain

|
Z'\—\' Caution

Using other than approved antennas may cause measurements higher than reported for certification.

This radio transmitter (IC certification number 109W-0005) has been approved by Industry Canada to
operate with the antenna types listed below with the maximum permissible gain and required
antenna impedance for each antenna type indicated. Antenna types not included in this list, having a
gain greater than the maximum gain indicated for that type, are strictly prohibited for use with this
device.

Le présent émetteur radio (Numéro de certification IC 109W-0005) a été approuvé par Industrie
Canada pour fonctionner avec les types d'antenne énumeérés ci-dessous et ayant un gain admissible
maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne non inclus dans
cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour
I'exploitation de I'émetteur.

Table 10 ePMP 2000 Allowed antennas for deployment in USA/Canada

Cambium part Antenna Type Gain (dBi)
number

C050900D021A 5 GHz Sector Antenna — 90/120 degree 18
C050900D020A Smart Antenna (complimentary to Sector Antenna, does not -

replace Sector Antenna)
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ePMP 1000
ePMP 1000 Connectorized Radio with Sync

For details of the ePMP connectorized hardware, see:

ePMP 1000 Connectorized Radio with Sync description on page 46

ePMP 1000 Connectorized Radio with Sync part numbers on page 47

ePMP 1000 Connectorized Radio with Sync interfaces on page 48

ePMP 1000 Connectorized Radio with Sync specifications on page 50

ePMP 1000 Connectorized Radio with Sync and external antenna location on page 51

ePMP 1000 Connectorized Radio with Sync wind loading on page 52

ePMP 1000 Connectorized Radio with Sync software packages on page 52

ePMP 1000 Connectorized Radio with Sync, antennas and antenna cabling on page 53

EPMP 1000 CONNECTORIZED RADIO WITH SYNC DESCRIPTION

The connectorized ePMP device is a self-
contained transceiver unit that houses both
radio and networking electronics. The
connectorized unit is designed to work with
externally mounted antennas that have high
gains. Connectorized units can cope with
more difficult radio conditions. The unit is
designed with female RP-SMA 50Q antenna
connections located at the top of the unit. An
ePMP connectorized unit may function as an
Access Point (AP) or a Subscriber Module
(SM) in a Point-To-Multipoint (PMP) or in a
Point-To-Point (PTP) network topology.

A Note

To select antennas, RF cables and
connectors for connectorized units,
see ePMP 1000 Connectorized Radio
with Sync, antennas and antenna
cabling on page 53.

Figure 10 ePMP 1000 Series Connectorized
Radio with Sync
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EPMP 1000 CONNECTORIZED RADIO WITH SYNC PART NUMBERS

Choose the correct regional variant: one is for use in regions where FCC or IC licensing restrictions

apply (FCC/IC), one is for use in ETSI countries (EU), and one is for non-FCC/IC/ETSI-restricted

regions (RoW).

Each of the parts listed in Table 11 includes the following items:
¢ One connectorized unit

e One power supply 1000/100/10 Base-TX LAN injector

The GPS-capable parts listed in Table 11 also ship with a GPS antenna.

Table 11 ePMP 1000 Connectorized Radio with Sync part numbers

Cambium description Cambium part number
ePMP GPS, Conn - 5 GHz - no power cord — ROW version C050900A011A
ePMP GPS, Conn - 5 GHz - no power cord — EU version C050900A013A
ePMP GPS, Conn - 5 GHz - US power cord — FCC version C058900A112A
ePMP GPS, Conn - 2.4 GHz - US power cord C024900A011A

GPS Sync AP License Key — ePMP 1000 GPS Sync AP

License Key - Upgrade Lite (10 SM) to Full (120 SM) C0509005200A

Table 12 ePMP 1000 Connectorized Radio with Sync accessory part numbers

Cambium description Cambium part number
ePMP Power Supply for GPS Radio - no cord (spare) NOOO900L001A
ePMP Power Supply for non-GPS Radio - no cord (spare) NOO0O900L002A

EPMP 1000 CONNECTORIZED RADIO WITH SYNC MOUNTING BRACKET

The connectorized unit is designed to be attached to a Cambium ePMP sector antenna (see Table

19). The Cambium ePMP sector antenna contains all of the mounting brackets, antenna cabling,

and GPS antenna mounting for device deployment.
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Figure 11 ePMP 1000 Connectorized Radio with Sync sector antenna

EPMP 1000 CONNECTORIZED RADIO WITH SYNC INTERFACES

The connectorized radio with sync interfaces are illustrated in Figure 12 and described in Table 13.

Figure 12 ePMP 1000 Connectorized Radio with Sync interfaces
Antenna port H

—— Antenna port V Ethernet—
— GPS
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Table 13 ePMP 1000 Connectorized Radio with Sync interfaces

Name Connector Interface Description
Antenna RP-SMA, Antenna, .
o To/from H polarized antenna port
port H female H polarization
Ant RP-SMA, Ant , .
ntenna S n enn_a . To/from V polarized antenna port
portV female V polarization
802.3af PoE Standard, as well as Proprietary
PoE input power over Ethernet (PoE) twisted pair (for
powering via CMM3/CMM4)
Ethernet RJ45
10/100/1000
Base-TX Management and data
Ethernet
GPS SMA, female Antenna, GPS To/from GPS antenna
For resetting the radio and for setting the radio
:Efﬁ:n Physical button  N/A back to its factory default configuration. See

Using the device external reset button on page
300.

EPMP 1000 CONNECTORIZED RADIO WITH SYNC LEDS

LED Function
POWER g POWER Green: Power is applied to the device
GRS SYHNE D Unlit: No power is applied to the device or improper

_— Q power source

= Q GPS Orange: AP has acquired a 1PPS GPS synchronization

= Q SYNC pulse either from the internal GPS module and antenna

ei ©) or from a connected CMM

e Unlit: 1PPS GPS not acquired, or Synchronization
Source set to Internal (AP operates without sync)
—] No LEDs lit: Three or less satellites tracked
E One LED lit (bottom): Four or five satellites tracked
= Two LEDs lit (bottom two): Six or seven satellites
tracked
All LEDs lit: Eight or more satellites are tracked
ETH Once lit, blinking indicates Ethernet activity
Red: 10BaseTX link
Green: 100BaseTX link
Orange: 1000BaseTX link
Unlit: No Ethernet link established
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EPMP 1000 CONNECTORIZED RADIO WITH SYNC SPECIFICATIONS

The ePMP connectorized module conforms to the specifications listed in Table 14 and Table 15.
The connectorized module meets the low level static discharge specifications identified in
Electromagnetic compatibility (EMC) compliance on page 429 and provides internal surge
suppression but does not provide lightning suppression.

For a full listing of connectorized radio with sync specifications, see the ePMP 1000 website.

Table 14 ePMP 1000 Connectorized Radio with Sync physical specifications

Category

Specification

Dimensions (H x W x D)

Radio: 227 x 88 x 33 mm (8.9” x 3.5” x 1.3")

Antenna: 529 x 124 x 53 mm (20.8" x 4.9" x 2.1")

Weight

.521 kg (1.15 Ibs) without antenna

4.5 kg (10 Ibs) with antenna

Table 15 ePMP 1000 Connectorized Radio with Sync environmental specifications

Category Specification

Temperature -30°C (-22°F) to +55°C (131°F)

Wind loading 118 mph (190 kph) maximum. See ePMP 1000
Connectorized Radio with Sync wind loading on page 52 for
a full description.

Humidity 95% condensing

Environmental

IP55
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EPMP 1000 CONNECTORIZED RADIO WITH SYNC HEATER

At startup, if the ePMP connectorized module temperature is at or below 32° F (0° C), an internal
heater is activated to ensure that the device is able to successfully begin operation. The unit’s
heater is only activated when the unit is powered on and will not apply heat to the device once
startup is complete. When the unit temperature is greater than 32° F (0° C), the heater is
deactivated and the unit continues its startup sequence.

The effect on device startup time at various temperatures is defined in Table 16.

Table 16 ePMP 1000 Connectorized Radio with Sync startup times based on ambient temperature

Initial Temperature Startup time (from power on to operational)

-22° F (-30° C) 20 minutes
-4° F (-20° C) 6 minutes
14° F (-10° C) 2 minutes, 30 seconds

EPMP 1000 CONNECTORIZED RADIO WITH SYNC AND EXTERNAL ANTENNA
LOCATION

Find a location for the device and external antenna that meets the following requirements:
e The equipment is high enough to achieve the best radio path.

e People can be kept a safe distance away from the equipment when it is radiating. The safe
separation distances are defined in Calculated distances and power compliance margins on
page 431.

e The equipment is lower than the top of the supporting structure (tower, mast or building) or its
lightning air terminal.

e The location is not subject to excessive wind loading. For more information, see ePMP 1000
Connectorized Radio with Sync wind loading on page 52.
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EPMP 1000 CONNECTORIZED RADIO WITH SYNC WIND LOADING

Ensure that the device and the structure on which it is mounted are capable of withstanding the
prevalent wind speeds at a proposed ePMP site. Wind speed statistics is available from national
meteorological offices.

The device and its mounting bracket are capable of withstanding wind speeds of up to 190 Kph
(118 mph).

Wind blowing on the device will subject the mounting structure to significant lateral force. The
maghnitude of the force depends on both wind strength and surface area of the device. Wind
loading is estimated using the following formulae:

Force (in kilograms) = 0.1045aV?
Where: Is:
a surface area in square meters
\% wind speed in meters per second
Force (in pounds) = 0.0042Av?
Where: Is:
A surface area in square feet

\% wind speed in miles per hour

Applying these formulae to the ePMP device at different wind speeds, the resulting wind loadings
are shown in Table 17 and Table 18.

Table 17 ePMP 1000 Connectorized Radio with Sync wind loading (Kg)

Type of ePMP Largest Wind speed (meters per second)
device surface area

(square meters) 30 40 50 60 70
Connectorized 0.13 12.2 Kg 21.7Kg 34Kg 49 Kg 66.6 Kg

Table 18 ePMP 1000 Connectorized Radio with Sync wind loading (Ib)

Type of ePMP device Largest Wind speed (miles per hour)

surface area

(square feet) 80 100 120 140 150
Connectorized 1.39 37.41b 5841b 84.11b 11441b 13141b

EPMP 1000 CONNECTORIZED RADIO WITH SYNC SOFTWARE PACKAGES

Connectorized radios may be upgraded by downloading new software packages from the
Cambium Networks website or by using the Cambium Network Services Server. The software
packages applicable to ePMP connectorized radios are named:

e ePMP-GPS_Synced-v3.3.tar.gz
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EPMP 1000 CONNECTORIZED RADIO WITH SYNC, ANTENNAS AND ANTENNA
CABLING

Connectorized modules require external antennas connected using RF cable (included with
Cambium ePMP sector antennas). For details of the antennas and accessories required for a
connectorized ePMP installation, see:

e ePMP 1000 Antenna requirements on page 53
e ePMP 1000 FCC and IC approved antennas on page 53

EPMP 1000 ANTENNA REQUIREMENTS

For connectorized units operating in the USA or Canada 2.4 GHz, 5.2 GHz, 5.4 GHz or 5.8 GHz
bands, choose external antennas from those listed in ePMP 1000 FCC and IC approved antennas
on page 53. For installations in other countries, the listed antennas are advisory, not mandatory.

EPMP 1000 FCC AND IC APPROVED ANTENNAS

For connectorized units operating in the USA or Canada, choose external antennas from Table 19.
These are approved by the FCC for use with the product and are constrained by the following
limits:

e 5 GHz - 15 dBi gain

e 2.4 GHz- 15 dBi gain

A Caution

Using other than approved antennas may cause measurements higher than reported for certification.

This radio transmitter (IC certification number 109W-0005) has been approved by Industry Canada to
operate with the antenna types listed below with the maximum permissible gain and required
antenna impedance for each antenna type indicated. Antenna types not included in this list, having a
gain greater than the maximum gain indicated for that type, are strictly prohibited for use with this
device.

Le présent émetteur radio (Numéro de certification IC 109W-0005) a été approuvé par Industrie
Canada pour fonctionner avec les types d'antenne énumérés ci-dessous et ayant un gain admissible
maximal et l'impédance requise pour chaque type d'antenne. Les types d'antenne non inclus dans
cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement interdits pour
I'exploitation de I'émetteur.

Table 19 ePMP 1000 Allowed antennas for deployment in USA/Canada

Cambium part Antenna Type Gain (dBi)
number

C050900D021A 5 GHz Sector Antenna — 90/120 degree 18
C050900D003A 5 GHz Sector Antenna - 90 degree 15
C050900D002A 5 GHz Sector Antenna — 120 degree 15
C024900D004A 2.4 GHz Sector Antenna - 90 /120 degree 15
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ePMP 1000 Integrated Radio
For details of the ePMP 1000 integrated hardware, see:

ePMP 1000 Integrated Radio description on page 54

ePMP 1000 Integrated Radio part numbers on page 55
ePMP 1000 Integrated Radio mounting bracket on page 55
ePMP 1000 Integrated Radio interfaces on page 56

ePMP 1000 Integrated Radio specifications on page 57
ePMP 1000 Integrated Radio heater on page 58

ePMP 1000 Integrated Radio wind loading on page 58
ePMP 1000 Integrated Radio software packages on page 59.

EPMP 1000 INTEGRATED RADIO DESCRIPTION

Figure 13 ePMP 1000 Series Integrated Radio

The integrated ePMP 1000 module is a self-
contained transceiver unit that houses both
radio and networking electronics. An ePMP
1000 integrated unit may function as an
Access Point (AP) or a Subscriber Module
(SM) in a Point-To-Multipoint (PMP) or in a
Point-To-Point (PTP) network topology.
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EPMP 1000 INTEGRATED RADIO PART NUMBERS

Choose the correct regional variant: one is for use in regions where FCC or IC licensing restrictions
apply (FCC/IC), one is for use in ETSI countries (EU), and one is for non-FCC/IC/ETSI-restricted
regions (RoW).

Each of the parts listed in Table 20 includes the following items:
¢ One integrated module (with mounting bracket)
¢ One metal mounting strap

e Power supply

Table 20 ePMP 1000 Integrated Radio part numbers

Cambium description Cambium part number
ePMP Integrated — 5 GHz — no power cord - ROW version C050900C031A
ePMP Integrated - 5 GHz — EU power cord — EU version C050900P033A
ePMP Integrated — 5 GHz — US power cord — FCC version C058900C132A
ePMP Integrated - 2.4 GHz - US power cord C024900C031A

Table 21 ePMP 1000 Integrated Radio accessory part numbers

Cambium description Cambium part number

ePMP Power Supply for non-GPS Radio - no cord (spare) NOOO900L002A

EPMP 1000 INTEGRATED RADIO MOUNTING BRACKET

Figure 14 Integrated module mounting bracket

The ePMP 1000 integrated module is designed
to be pole-mounted using the mounting strap
and bracket provided in the box with the
radio.
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EPMP 1000 INTEGRATED RADIO INTERFACES

The integrated module interfaces are illustrated in Figure 15 and described in Table 22.

Figure 15 ePMP 1000 Integrated Radio interfaces

Y

Table 22 ePMP 1000 Integrated Radio interfaces

Auxiliary
Ethernet

Primary
Ethernet

Port name Connector Interface Description
Proprietary power over Ethernet (PoE)
PoE input twisted pair (for powering via

Primary Ethernet RJ45

CMM3/CMM4)

10/100 Base-TX
Ethernet

Management and data

Auxiliary Ethernet

RJ45
(future release)

Cambium
proprietary PoE
output, data
bridging

Proprietary 30V PoE output for
auxiliary devices (not 802.3af standard
PoE)
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EPMP 1000 INTEGRATED RADIO LEDS

LED Function
— g Green: Power is applied to the device
ETH 1 g POWER  uUnlit: No power is applied to the device or improper
power source
eH2 )
— g Main/Primary Ethernet port indicator
E Q ETH 1 Once lit, blinking indicates Ethernet activity
= (1 Green: 10/100BaseTX link
RF SIGMNAL D Auxiliary/Secondary Ethernet port indicator
ETH 2 Once lit, blinking indicates Ethernet activity
Green: 10/100BaseTX link
=== Radio scanning: LEDs light in an ascending
E sequence to indicate that the radio is scanning
E Radio registered: LEDs light to indicate the RSSI
= |evel at the device.
RF SIGMAL
— — — —
=0 rsss =EO 70m =0  ssm =0 gss
=0 >0 EO <prssis SO <rssis SO <80
=@ dBm =@ 60dBm =0 70dBm =) dBm

EPMP 1000 INTEGRATED RADIO SPECIFICATIONS

The ePMP integrated module conforms to the specifications listed in Table 23 and Table 24.

The integrated device meets the low level static discharge specifications identified in

Electromagnetic compatibility (EMC) compliance on page 429 and provides internal surge
suppression but does not provide lightning suppression.

For a full listing of integrated radio specifications, see ePMP 1000 website.
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Table 23 ePMP 1000 Integrated Radio physical specifications

Category Specification
Dimensions (H x W x D) Radio: 29.1 x 14.56 x8.3cm (11.4 x 5.7 x 3.3 in)
Weight 0.49 kg (1.1 Ibs)

Table 24 ePMP 1000 Integrated Radio environmental specifications

Category Specification

Temperature -30°C (-22°F) to +60°C (131°F)

Wind loading 90 mph (145 kph) maximum. See ePMP 1000 Integrated Radio wind
loading on page 58 for a full description.

Humidity 95% condensing

Environmental IP55

EPMP 1000 INTEGRATED RADIO HEATER

Upon power on, if the ePMP integrated module device temperature is at or below 32° F (0° C), an
internal heater is activated to ensure that the device is able to successfully begin operation. The
unit’s heater is only activated when the unit is powered on and will not apply heat to the device
once startup is complete. When the unit temperature is greater than 32° F (0° C), the heater is
deactivated and the integrated module continues its startup sequence.

The effect on integrated module startup time at various temperatures is defined in Table 25.

Table 25 ePMP 1000 Integrated module startup times based on ambient temperature

Initial Temperature  Startup time (from power
on to operational)

-22° F (-30° C) 4 minutes
-4° F (-20° C) 2 minutes
14° F (-10° C) 1 minutes, 30 seconds

EPMP 1000 INTEGRATED RADIO WIND LOADING

Ensure that the integrated module and the structure on which it is mounted are capable of
withstanding the prevalent wind speeds at a proposed ePMP site. Wind speed statistics must be
available from national meteorological offices.

The integrated module and its mounting bracket are capable of withstanding wind speeds of up to
145 Kph (90 mph).

Wind blowing on the integrated module will subject the mounting structure to significant lateral
force. The magnitude of the force depends on both wind strength and surface area of the
integrated module. Wind loading is estimated using the following formulae:

026v003 58



cPMP CAMBIUM NETWORKS

Force (in kilograms) = 0.1045aV?
Where: Is:
a surface area in square meters
\% wind speed in meters per second
Force (in pounds) = 0.0042Av?
Where: Is:
A surface area in square feet
\% wind speed in miles per hour

Applying these formulae to the ePMP integrated module at different wind speeds, the resulting
wind loadings are shown in Table 26 and Table 27.

Table 26 ePMP 1000 Integrated Radio wind loading (Kg)

Type of ePMP Largest Wind speed (meters per second)
module surface area

(square meters) 30 40 50 60 70
Integrated 0.042 4 Kg 7 Kg 1M Kg 15.8Kg 21.6Kg

Table 27 ePMP 1000 Integrated Radio wind loading (lb)

Type of ePMP Largest surface Wind speed (miles per hour)
module area (square feet)

80 100 120 140 150
Integrated 0.45 1211b  1891b 27.21b 371b 425 |b

EPMP 1000 INTEGRATED RADIO SOFTWARE PACKAGES

Integrated radios may be upgraded by downloading new software packages from the Cambium
Networks website or by using the Cambium Network Services Server. The software packages
applicable to ePMP integrated radios are named:

. ePMP-NonGPS_Synced-v3.3.tar.gz
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ePMP 1000 Connectorized Radio

For details of the ePMP 1000 connectorized hardware, see:

ePMP 1000 Connectorized Radio description on page 60

ePMP 1000 Connectorized Radio part numbers on page 61

ePMP 1000 Connectorized Radio Interfaces on page 62

ePMP 1000 Connectorized Radio specifications on page 64

ePMP 1000 Connectorized Radio and external antenna location on page 65

ePMP 1000 Connectorized Radio wind loading on page 66

Connectorized Radio software packages on page 66

ePMP 1000 Connectorized Radio antennas and antenna cabling on page 67

EPMP 1000 CONNECTORIZED RADIO DESCRIPTION

The connectorized ePMP 1000 device is a self-
contained transceiver unit that houses both
radio and networking electronics. The
connectorized unit is designed to work with
externally mounted antennas that have high
gains. Connectorized units can cope with more
difficult radio conditions. The unit is designed
with female RP-SMA 50Q antenna connections
located at the top of the unit. An ePMP 1000
connectorized unit may function as an Access
Point (AP) or a Subscriber Module (SM) in a
Point-To-Multipoint (PMP) or in a Point-To-
Point (PTP) network topology.

A Note

Figure 16 ePMP 1000 Series Connectorized
Radio

To select antennas, RF cables and connectors for connectorized units, see ePMP 1000
Connectorized Radio antennas and antenna cabling on page 67.
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EPMP 1000 CONNECTORIZED RADIO PART NUMBERS

Choose the correct regional variant: one is for use in regions where FCC or IC licensing restrictions
apply (FCC/IC), one is for use in ETSI countries (EU), and one is for non-FCC/IC/ETSI-restricted
regions (RoW).

Each of the parts listed in Table 28 includes the following items:

¢ One connectorized unit

e One power supply 100/10 Base-TX LAN injector

Table 28 ePMP 1000 Connectorized Radio part numbers

Cambium description Cambium part number
ePMP Conn -5 GHz - no power cord - ROW version C050900A021A
ePMP Conn -5 GHz - EU power cord — EU version CO050900A023A
ePMP Conn -5 GHz - US power cord — FCC version C058900A122A
ePMP Conn - 2.4 GHz - US power cord C024900A021A

Table 29 ePMP 1000 Connectorized Radio accessory part numbers

Cambium description Cambium part number

ePMP Power Supply for non-GPS Radio - no cord (spare) NOOO900L002A

EPMP 1000 CONNECTORIZED RADIO MOUNTING BRACKET

Figure 17 Connectorized radio sector antenna

The ePMP 1000 Connectorized unit is designed [
to be attached to a Cambium ePMP sector L L
antenna or with a non-Cambium antenna.
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EPMP 1000 CONNECTORIZED RADIO INTERFACES

The connectorized radio with interfaces are illustrated in Figure 18 and described in Table 30.

Figure 18 Connectorized radio interfaces

Table 30 ePMP 1000 Connectorized radio interfaces

Antenna port H
—— Antenna port V

~ AUXILLARY
ETHERNET

PRIMARY
ETHERNET

Name Connector Interface Description
A A

ntenna RP-SMA, female ntennf':l, . To/from H polarized antenna port
port H H polarization
Ant Ant , .

ntenna RP-SMA, female n enn.a . To/from V polarized antenna port
port V V polarization

POE i ‘ Proprietary power over Ethernet (PoE) twisted

Pri Ot inpu pair (for powering via CMM3/CMM4)

rimary

RJ45
Ethernet 107100 Base- Management and data
TX Ethernet g
Auxiliary Cambium
Ethernet RJ45 propriety POE  Propriety 30V PoE output for auxiliary devices
(future output, data (not 802 3af standard Poe)
reIease) bridging
For resetting the radio and for resetting the
Reset . radio back to its factory default configuration,
Physical button N/A
Button ys! " see Using the device external reset button on
page 300.
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EPMP 1000 CONNECTORIZED RADIO LEDS

LED Function
POWER g
ETH 1 Q POWER

Green: Power is applied to the device

Unlit: No power is applied to the device or

S

Q improper power source
©

(=

()

ETH1

Main/Primary Ethernet port indicator
RF SIGMA

=

Once lit, blinking indicates Ethernet activity
Green: 10/100BaseTX link

ETH 2 Auxiliary/Secondary Ethernet port

indicator

Once lit, blinking indicates Ethernet activity
Green: 10/100BaseTX link

Radio scanning: LEDs light in an ascending

sequence to indicate that the radio is
scanning

Radio registered: LEDs light to indicate the
RSSI level at the device.

Reserved for future release

RSSI — -70 dBm

— < RSSI <
dBm = ©  -60dBm

-80 dBm
< RSSI <
-70 dBm

RSSI

<-80
dBm

atiil
000
|
noiiill
000
nniiiil
000
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EPMP 1000 CONNECTORIZED RADIO SPECIFICATIONS
The ePMP connectorized radio conforms to the specifications listed in Table 31 and Table 32.

The connectorized module meets the low level static discharge specifications identified in
Electromagnetic compatibility (EMC) compliance on page 429 and provides internal surge
suppression but does not provide lightning suppression.

For a full listing of connectorized radio specifications, see ePMP 1000 website.

Table 31 ePMP 1000 Connectorized radio physical specifications

Category Specification

Dimensions (H x W x D) Radio: 227 x 88 x 33 mm (8.9” x 3.6” x 1.3")

Antenna: 529 x 124 x 53 mm (20.8" x 4.9" x 2.1")

Weight .521 kg (1.15 lbs) without antenna

4.5 kg (10 Ibs) with antenna

Table 32 ePMP 1000 Connectorized radio environmental specifications

Category Specification

Temperature -30°C (-22°F) to +55°C (131°F)

Wind loading 118 mph (190 kph) maximum. See ePMP 1000
Connectorized Radio wind loading on page 66 for a full
description.

Humidity 95% condensing

Environmental IP55
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EPMP 1000 CONNECTORIZED RADIO HEATER

On startup, if the ePMP 1000 Connectorized radio temperature is at or below 32° F (0° C), an
internal heater is activated to ensure that the device is able to successfully begin operation. The
unit’s heater is only activated when the unit is powered on and will not transfer heat to the device
until the startup completes. When the unit temperature is greater than 32° F (0° C), the heater is
deactivated and the unit continues its startup sequence.

The effect on device startup time at various temperatures is defined in Table 33.

Table 33 ePMP 1000 Connectorized radio startup times based on ambient temperature

Initial Temperature Startup time (from power on to operational)
-22° F (-30° C) 20 minutes

-4° F (-20° C) 6 minutes

14° F (-10° C) 2 minutes, 30 seconds

EPMP 1000 CONNECTORIZED RADIO AND EXTERNAL ANTENNA LOCATION

Find a location for the device and external antenna that meets the following requirements:

e The equipment is high enough to achieve the best radio path.

o People are a safe distance away from the equipment when it is radiating. The safe separation
distances are defined in Calculated distances and power compliance margins on page 431.

e The equipment is lower than the top of the supporting structure (tower, mast or building) or its
lightning air terminal.

e The location is not subjected to excessive wind loading. For more information, see ePMP 1000
Connectorized Radio wind loading on page 66.
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EPMP 1000 CONNECTORIZED RADIO WIND LOADING

Ensure that the device and the structure on which it is mounted are capable of withstanding the
prevalent wind speeds at a proposed ePMP site. Wind speed statistics must be available from
national meteorological offices.

The device and its mounting bracket are capable of withstanding wind speeds of up to 190 kph
(118 mph).

Wind speeds on the device subjects the mounting structure to significant lateral force. The
maghnitude of the force depends on both the wind strength and surface area of the device. Wind
loading is estimated using the following formulae:

Force (in kilograms) = 0.1045aV?
Where: Is:
a surface area in square meters
\% wind speed in meters per second
Force (in pounds) = 0.0042Av?
Where: Is:
A surface area in square feet

\% wind speed in miles per hour

Applying these formulae to the ePMP device at different wind speeds, the resulting wind loadings
are shown in Table 34 and Table 35.

Table 34 ePMP 1000 Connectorized radio wind loading (Kg)

Type of ePMP Largest Wind speed (meters per second)
device surface area
(square meters)

30 40 50 60 70

Connectorized 0.13 12.2 Kg 21.7Kg 34Kg 49 Kg 66.6 Kg

Table 35 ePMP 1000 Connectorized radio wind loading (Ib)

Type of ePMP device Largest Wind speed (miles per hour)

surface area

(square feet) 80 100 120 140 150
Connectorized 1.39 3741b 584Ilb 84.1lb 114.41b 131.41b

CONNECTORIZED RADIO SOFTWARE PACKAGES

Connectorized radio may be upgraded by downloading new software packages from the Cambium
Networks website or by using the Cambium Network Services Server. The software packages
applicable to ePMP 1000 Un-synced connectorized radio are named:

e ePMP-NonGPS_Synced-v3.3.tar.gz
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EPMP 1000 CONNECTORIZED RADIO ANTENNAS AND ANTENNA CABLING

Connectorized radio requires external antennas connected using RF cable (included with Cambium
ePMP sector antennas). For details of the antennas and accessories required for a connectorized
ePMP installation, see:

e ePMP 1000 Antenna requirements on page 53
¢ ePMP 1000 FCC and IC approved antennas on page 53

EPMP 1000 ANTENNA REQUIREMENTS

For connectorized units operating in the USA or Canada 2.4 GHz, 5.4 GHz or 5.8 GHz bands, choose
external antennas from those listed in ePMP 1000 FCC and IC approved antennas on page 53. For
installations in other countries, the listed antennas are advisory, not mandatory.

EPMP 1000 FCC AND IC APPROVED ANTENNAS

For connectorized units operating in the USA or Canada, choose external antennas from Table 36.
These are approved by the FCC for use with the product and are constrained by the following
limits:

e 5 GHz - 15 dBi gain

e 2.4 GHz- 15 dBi gain

A Caution

Using other than approved antennas may cause measurements higher than reported for
certification.

This radio transmitter (IC certification number 109W-0005) has been approved by Industry Canada
to operate with the antenna types listed below with the maximum permissible gain and required
antenna impedance for each antenna type indicated. Antenna types not included in this list, having
a gain greater than the maximum gain indicated for that type, are strictly prohibited for use with
this device.

Le présent émetteur radio (Numéro de certification IC 109W-0005 ) a été approuvé par Industrie
Canada pour fonctionner avec les types d'antenne énumérés ci-dessous et ayant un gain
admissible maximal et I'impédance requise pour chaque type d'antenne. Les types d'antenne non
inclus dans cette liste, ou dont le gain est supérieur au gain maximal indiqué, sont strictement
interdits pour I'exploitation de I'émetteur.

Table 36 ePMP 1000 allowed antennas for deployment in USA/Canada - 5 GHz

Cambium part number Antenna Type Gain (dBi)
C050900D003A 5 GHz Sector Antenna — 90 degree 15
C050900D002A 5 GHz Sector Antenna — 120 degree 15
C024900D004A 2.4 GHz Sector Antenna - 90 /120 degree 15
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Force 180

For details of the ePMP Force 180 hardware, see:
e [Force 180 description on page 68

o Force 180 part numbers on page 69

e Force 180 mounting bracket on page 69

e Force 180 interfaces on page 70

e Force 180 LEDs on page 71

e Force 180 heater on page 72

e Force 180 wind loading on page 72

o Force 180 software packages on page 73

FORCE 180 DESCRIPTION

. . Figure 19 ePMP Series Force 180
The Force 180 integrated module is a self-

contained transceiver unit that houses both
radio and networking electronics. An ePMP
Force 180 unit may function as an Access
Point (AP) or a Subscriber Module (SM) in a
Point-To-Multipoint (PMP) or in a Point-To-
Point (PTP) network topology. It is typically
deployed as an SM in a PMP system.
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FORCE 180 PART NUMBERS

Choose the correct regional variant: one is for use in regions where FCC or IC licensing restrictions

apply (FCC/IC), one is for use in ETSI countries (EU), and one is for non-FCC/IC/ETSI-restricted

regions (RoW).

Each of the parts listed in Table 37 includes the following items:
e One Force 180 module (with mounting bracket)

¢ One metal mounting strap

e Power supply

Table 37 Force 180 part numbers

Cambium description

Cambium part number

ePMP 5 GHz Force 180 Integrated Radio (FCC) (US cord) C058900C072A
ePMP 5 GHz Force 180 Integrated Radio (ROW) (no cord) C050900C071A
ePMP 5 GHz Force 180 Integrated Radio (EU) (EU cord) C050900C073A
ePMP 5 GHz Force 180 Integrated Radio (ROW) (US cord) C050900C171A
ePMP 5 GHz Force 180 Integrated Radio (ROW) (EU cord) C050900C271A
ePMP 5 GHz Force 180 Integrated Radio (ROW) (UK cord) C050900C371A
ePMP 5 GHz Force 180 Integrated Radio (EU) (UK cord) C050900C373A
ePMP 5 GHz Force 180 Integrated Radio (ROW) (India cord) C050900C471A
ePMP 5 GHz Force 180 Integrated Radio (ROW) (China cord) C050900C571A
ePMP 5 GHz Force 180 Integrated Radio (ROW) (Brazil cord) C050900C671A
ePMP 5 GHz Force 180 Integrated Radio (ROW) (Argentina cord) C050900C771A
ePMP 5 GHz Force 180 Integrated Radio (ROW) (ANZ cord) C050900C871A

FORCE 180 MOUNTING BRACKET

Figure 20 Force 180 module mounting bracket

The Force 180 module is designed to be
pole-mounted using the mounting strap and
bracket provided in the box with the radio.
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FORCE 180 INTERFACES
The Force 180 module interfaces are illustrated in Figure 21 and described in Table 38.

Figure 21 Force 180 interfaces

| Ethernet
\“(u
J==N\
f pr———
\T*r“\n —
Table 38 Force 180 interfaces
Port name Connector Interface Description

10/100/1000BaseT, Compatible with
Cambium PoE pinouts (V+=7 & 8,
Return = 4 & 5) and Standard PoE
Ethernet RJ45 pinouts (V+ =4 & 5, Return =7 & 8)

PoE input

10/100/1000 Base-

M
TX Ethernet anagement and data

For resetting the radio and for setting

Physical the radio back to its factory default

Reset Butt N/A . . .
eset Button button / configuration. See Using the device

external reset button on page 300.
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FORCE 180 LEDS

,f" — "'1 LED Function

Green: Power is applied to the device

POWER  Unlit: No power is applied to the device or improper
HH I power source
_. Ethernet port indicator
— ETH

Once lit, blinking indicates Ethernet activity
Green: 10/100/1000 BaseTX link
-}

Radio scanning: LEDs light in an ascending
sequence to indicate that the radio is scanning

(

Radio registered: LEDs light to indicate the RSSI

RF SIGNAL level at the device.

E g RSSI E -70 dBm E g -80 dBm E @ RSSI
=0 .0 SO <vx =0 <mv: =0 <
=E@® d9dBm =@ 60dBm =@ 70dm =) dBm

FORCE 180 SPECIFICATIONS

The Force 180 module conforms to the specifications listed in Table 39 and Table 40.
The device meets the low level static discharge specifications identified in Electromagnetic

compatibility (EMC) compliance on page 429 and provides internal surge suppression but does not
provide lightning suppression.

For a full listing of Force 180 specifications, see ePMP 1000 website.

Table 39 Force 180 physical specifications
Category

Specification

Dimensions (H x W x D) Radio: 12.5 x 25.1x11.9cm (4.9 x 9.9 x 4.7 in)
— with mounting bracket attached

Radio: 12.56x25.1x4cm (4.9x9.9x 1.6 in) —
without mounting bracket attached
Weight

0.50 kg (1.1 Ibs)
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Table 40 Force 180 environmental specifications

Category Specification

Temperature -30°C (-22°F) to +60°C (140°F)

Wind loading 90 mph (145 kph) maximum. See Force 180 wind loading on page 72 for
a full description.

Humidity 95% condensing

Environmental IP55

FORCE 180 HEATER

Upon power on, if the ePMP Force 180 device temperature is at or below 32° F (0° C), an internal
heater is activated to ensure that the device is able to successfully begin operation. The unit’s
heater is only activated when the unit is powered on and will not apply heat to the device once
startup is complete. When the unit temperature is greater than 32° F (0° C), the heater is
deactivated and the integrated module continues its startup sequence.

The effect on Force 200 startup time at various temperatures is defined in Table 41.

Table 41 Force 180 startup times based on ambient temperature

Initial Temperature  Startup time (from power
on to operational)

-22° F (-30° C) 4 minutes
-4° F (-20° C) 2 minutes
14° F (-10° C) 1 minutes, 30 seconds

FORCE 180 WIND LOADING

Ensure that the Force 180 and the structure on which it is mounted are capable of withstanding the
prevalent wind speeds at a proposed ePMP site. Wind speed statistics must be available from
national meteorological offices.

The Force 180 and its mounting bracket are capable of withstanding wind speeds of up to 145 Kph
(90 mph).

Wind blowing on the Force 180 will subject the mounting structure to significant lateral force. The
magnitude of the force depends on both wind strength and surface area of the Force 180. Wind
loading is estimated using the following formulae:

Force (in kilograms) = 0.1045aV?
Where: Is:
a surface area in square meters

V wind speed in meters per second
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Force (in pounds) = 0.0042Av?
Where: Is:
A surface area in square feet
\% wind speed in miles per hour

Applying these formulae to the ePMP Force 180 at different wind speeds, the resulting wind
loadings are shown in Table 42 and Table 43.

Table 42 Force 180 wind loading (Kg)

Type of ePMP Largest Wind speed (meters per second)
module surface area
(square meters)

30 40 50 60 70

Force 180 0.031 3Kg 52Kg 8.2Kg 11.8Kg 16Kg

Table 43 Force 180 wind loading (Ib)

Type of ePMP Largest surface Wind speed (miles per hour)
module area (square feet)

80 100 120 140 150
Force 180 0.33 91b 14.11b 203Ib 27.71b 3181b

FORCE 180 SOFTWARE PACKAGES

Force 180 radios may be upgraded by downloading new software packages from the Cambium
Networks website or by using the Cambium Network Services Server. The software packages
applicable to ePMP Force 180 are named:

e ePMP-NonGPS_Synced-v3.3.tar.gz
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Force 200

For details of the ePMP Force 200 hardware, see:
e Force 200 description on page 74

e Force 200 part numbers on page 75

e Force 200 mounting bracket on page 76

e Force 200 interfaces on page 77

e Force 200 LEDs on page 78

e Force 200 heater on page 79

e Force 200 wind loading on page 79

o Force 200 software packages on page 80

FORCE 200 DESCRIPTION

Figure 22 ePMP Series Force 200

The Force 200 integrated dish is a self-
contained transceiver unit that houses both
radio, parabolic dish and networking
electronics. An ePMP Force 200 unit may
function as an Access Point (AP) or a
Subscriber Module (SM) in a Point-To-

Multipoint (PMP) or in a Point-To-Point (PTP) Figure 23 ePMP Series Force 200 (with optional
radome - sold separately)

network topology. It is typically deployed as
an SM in a PMP system and either Master or
Slave in a PTP system.
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FORCE 200 PART NUMBERS

Choose the correct regional variant: one is for use in regions where FCC or IC licensing restrictions
apply (FCC/IC), one is for use in ETSI countries (EU), and one is for non-FCC/IC/ETSI-restricted

regions (RoW).

Each of the parts listed in Table 44 includes the following items:
e Force 200 Radio Assembly

o

o

Power Cord (if applicable)

Power Supply

e Force 200 Dish

e Force 200 Pole Bracket Assembly
e Force 200 Pole Clamp Assembly

e Four M6 Bolts

Table 44 Force 200 part numbers

Cambium description

Cambium part number

ePMP 5 GHz Force 200AR5-25 High Gain Radio (FCC) (US cord) C058900C062A
ePMP 5 GHz Force 200AR5-25 High Gain Radio (ROW) (no cord) C050900C061A
ePMP 5 GHz Force 200AR5-25 High Gain Radio (EU) (EU cord) C050900C063A
ePMP 5 GHz Force 200AR5-25 High Gain Radio (ROW) (US cord) C050900C161A
ePMP 5 GHz Force 200AR5-25 High Gain Radio (ROW) (EU cord) C050900C261A
ePMP 5 GHz Force 200AR5-25 High Gain Radio (ROW) (UK cord) C050900C361A
ePMP 5 GHz Force 200AR5-25 High Gain Radio (EU) (UK cord) C050900C363A
ePMP 5 GHz Force 200AR5-25 High Gain Radio (ROW) (India cord) C050900C461A
ePMP 5 GHz Force 200AR5-25 High Gain Radio (ROW) (China/ANZ cord) C050900C561A
ePMP 5 GHz Force 200AR5-25 High Gain Radio (ROW) (Brazil cord) C050900C661A
ePMP 5 GHz Force 200AR5-25 High Gain Radio (ROW) (Argentina cord) C050900C761A
ePMP 2.4 GHz Force 200AR2-25 High Gain Radio (US cord) C024900C161A
ePMP 2.4 GHz Force 200AR2-25 High Gain Radio (EU cord) C024900C261A
ePMP Force 200 Radome NO00900L021A
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FORCE 200 MOUNTING BRACKET

Figure 24 Force 200 mounting bracket (side)

Sl
Gl S

i
The Force 200 module is designed to be pole- |

mounted using the mounting bracket and

clamp assembly provided in the box with the
radio.

Figure 25 Force 200 mounting bracket (back)
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FORCE 200 INTERFACES

The Force 200 module interfaces are illustrated in Figure 26 and described in Table 45.

Figure 26 Force 200 interfaces

Ethernet

Reset Button

Table 45 Force 200 interfaces

Port name Connector Interface Description

10/100/1000BaseT, Compatible with
Cambium PoE pinouts (V+=7 & 8,
Return =4 & 5) and Standard PoE
Ethernet RJ45 pinouts (V+ =4 & 5, Return =7 & 8)

PoE input

10/100/1000 Base-

TX Ethernet Management and data

For resetting the radio and for setting
Physical N/A the radio back to its factory default
button configuration. See Using the device

external reset button on page 300.

Reset Button
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FORCE 200 LEDS

h LED Function

m. Green: Power is applied to the device

ETH l POWER  uUnlit: No power is applied to the device or improper

_I power source

| Ethernet port indicator
-:l ETH Once lit, blinking indicates Ethernet activity
\ Green: 10/100/1000 BaseTX link
— Radio scanning: LEDs light in an ascending
= sequence to indicate that the radio is scanning
E Radio registered: LEDs light to indicate the RSSI
RF SIGMNAL

level at the device.

E g RSSI E -70 dBm E g -80 dBm E @ RSSI
=0 -6 = <pssiss =0 <rssis =0 <=0
=E® ™ = -60 dBm =@ 70dm =) dBm

FORCE 200 SPECIFICATIONS

The Force 200 module conforms to the specifications listed in Table 46 and Table 47.

The device meets the low level static discharge specifications identified in Electromagnetic

compatibility (EMC) compliance on page 429 and provides internal surge suppression but does not
provide lightning suppression.

For a full listing of Force 200 specifications, see ePMP 1000 website.

Table 46 Force 200 physical specifications

Category Specification

Dimensions (Dia x Depth) 47 x 28 cm (18.5x 11.2 in)

Weight

2.4 GHz: 2.8 kg (6.2 Ibs)
5 GHz: 2.3 kg (5.1 Ibs)
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Table 47 Force 200 environmental specifications

Category Specification

Temperature -30°C (-22°F) to +60°C (140°F) — with radome attached maximum
temperature is +47°C (116°F)

Wind loading 90 mph (145 kph) maximum. See Force 200 wind loading on page 79 for
a full description.

Humidity 95% condensing

Environmental

IP55

FORCE 200 HEATER

Upon power on, if the ePMP Force 200 device temperature is at or below 32° F (0° C), an internal
heater is activated to ensure that the device is able to successfully begin operation. The unit’s
heater is only activated when the unit is powered on and will not apply heat to the device once
startup is complete. When the unit temperature is greater than 32° F (0° C), the heater is
deactivated and the Force 200 module continues its startup sequence.

The effect on Force 200 startup time at various temperatures is defined in Table 48.

Table 48 Force 200 startup times based on ambient temperature

Initial Temperature

Startup time (from power
on to operational)

-22° F (-30° C) 4 minutes
-4° F (-20° C) 2 minutes
14° F (-10° C) 1 minutes, 30 seconds

FORCE 200 WIND LOADING

Ensure that the Force 200 and the structure on which it is mounted are capable of withstanding the
prevalent wind speeds at a proposed ePMP site. Wind speed statistics must be available from
national meteorological offices.

The Force 200 and its mounting bracket are capable of withstanding wind speeds of up to 145 Kph

(90 mph).

Wind blowing on the Force 200 will subject the mounting structure to significant lateral force. The
magnitude of the force depends on both wind strength and surface area of the integrated module.
Wind loading is estimated using the following formulae:

Force (in kilograms) = 0.1045aV?

Where:

a surface area in square meters

V wind speed in meters per second
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Force (in pounds) = 0.0042Av?
Where: Is:
A surface area in square feet
\% wind speed in miles per hour

Applying these formulae to the ePMP Force 200 at different wind speeds, the resulting wind
loadings are shown in Table 49 and Table 50.

Table 49 Force 200 wind loading (Kg)

Type of ePMP Largest Wind speed (meters per second)
module surface area
(square meters)

30 40 50 60 70

Force 200 0.13 123Kg 22Kg 34.4Kg 495Kg 67.4Kg

Table 50 Force 200 wind loading (Ib)

Type of ePMP Largest surface Wind speed (miles per hour)
module area (square feet)

80 100 120 140 150
Force 200 1.44 38.71lb 6041b 871lb 1181Ib 1361b

FORCE 200 SOFTWARE PACKAGES

Force 200 radios may be upgraded by downloading new software packages from the Cambium
Networks website or by using the Cambium Network Services Server. The software packages
applicable to ePMP Force 200 are named:

e ePMP-NonGPS_Synced-v3.3.tar.gz
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ePMP 2000 Series Power Supply

For details of the ePMP power supply units, see:
o Power supply description on page 81

e Power supply part numbers on page 81

e Power supply interfaces on page 82

e Power supply specifications on page 83

e Power supply location on page 83

POWER SUPPLY DESCRIPTION

The power supply is an indoor unit that is connected to the ePMP module and network terminating
equipment using Catbe cable with RJ45 connectors. It is also plugged into an AC or DC power
supply so that it can inject Power over Ethernet (PoE) into the module.

POWER SUPPLY PART NUMBERS

Each module requires one power supply and one power supply line cord (line cord included with
radio device, see Table 2). The power supplies listed in Table 51 may be used for all ePMP 2000
modules

Table 51 Power supply component part numbers

Cambium description Cambium part number

POWER SUPPLY, 30W, 56V — Gbps support NO00000L034
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POWER SUPPLY INTERFACES

The power supply interfaces are illustrated in Figure 27 and described in Table 52 and Table 53.

Figure 27 Power supply interfaces

Power Gigabit
input p Data
@ Gigabit
Data +
Power

Table 52 Power supply interface functions - NOO0000L034

Interface Function

Power input Mains power input.

Gigabit Data + Power RJ45 socket for connecting Catb5e cable to radio
Gigabit Data RJ45 socket for connecting Catbe cable to network.

Table 53 Power Supply LED functions

LED Function
Power (green) Power supply detection
026v003
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POWER SUPPLY SPECIFICATIONS

The ePMP power supply conforms to the specifications listed in Table 54, Table 55, and Table 56.
These specifications apply to ePMP 2000 product variants.

Table 54 Power supply physical specifications

Category

Specification

Dimensions (H x W x D)

14 x 6.5 x 3.6 cm (5.5 x 2.65 x 1.42 in)

Weight

0.26 Ibs

Table 55 Power supply environmental specifications

Category

Specification

Ambient Operating
Temperature

0°Cto+40°C

Humidity

20% - 90%

Table 56 Power supply electrical specifications

Category Specification
AC Input 100 to 240 VAC
Efficiency Meets Energy Level 6

Over Current Protection

Short circuit, with auto recovery

Hold up time

10 ms minimum at maximum load, 120 VAC

POWER SUPPLY LOCATION

Find a location for the power supply that meets the following requirements:

e The power supply can be mounted on a wall or other flat surface.

e The power supply is kept dry, with no possibility of condensation, flooding or rising damp.

e The power supply can be accessed to view status indicators.

e The power supply can be connected to the ePMP module drop cable and network terminating

equipment.

e The power supply can be connected to a mains or DC power supply that meets the
requirements defined in Table 63.
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ePMP 1000 Series Power Supply (includes Force 180 and Force 200)
For details of the ePMP power supply units, see:

o Power supply description on page 84

e Power supply part numbers on page 84

e Power supply interfaces on page 85

e Power supply specifications on page 86

e Power supply location on page 86

POWER SUPPLY DESCRIPTION

The power supply is an indoor unit that is connected to the ePMP module and network terminating
equipment using Catbe cable with RJ45 connectors. It is also plugged into an AC or DC power
supply so that it can inject Power over Ethernet (PoE) into the module.

POWER SUPPLY PART NUMBERS

Each module requires one power supply and one power supply line cord (line cord included with
radio device, see Table 11, Table 20, Table 28, Table 37, Table 44) . The power supplies listed in
Table 57 may be used for all ePMP 1000 modules, however, only NOO0900L001A provides a
Gigabit Ethernet interface.

Table 57 Power supply component part numbers

Cambium description Cambium part number
ePMP Pwr Supply for GPS Radio - no cord (spare) NOOO900LO001A
ePMP Pwr Supply for non-GPS Radio - no cord (spare) NOO0900L002A
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POWER SUPPLY INTERFACES
The power supply interfaces are illustrated in Figure 28 and described in Table 58 and Table 60.

Figure 28 Power supply interfaces

Power Gigabit
input p Data
iﬂ) Gigabit
Data +
Power

Table 58 Power supply interface functions - NOOO900L001A

Interface Function

Power input Mains power input.

RJ45 socket for connecting Catb5e cable to radio

Ad Note

This port provides a Gigabit Ethernet interface to ePMP GPS
Synced connectorized radios. To ePMP integrated radios,
this port provides a 10/100 Mbit/sec Ethernet interface.

Gigabit Data + Power

Gigabit Data RJ45 socket for connecting Catbe cable to network.

Table 59 Power supply interface functions - NOOO900L002A

Interface Function

Power input Mains power input.

10/100 Mbit/sec Data + Power RJ45 socket for connecting Catbe cable to radio

10/100 Mbit/sec Data RJ45 socket for connecting Catbe cable to network.

Table 60 Power Supply LED functions

LED Function

Power (green) Power supply detection
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POWER SUPPLY SPECIFICATIONS

The ePMP power supply conforms to the specifications listed in Table 61, Table 62 and Table 63.
These specifications apply to all ePMP product variants.

Table 61 Power supply physical specifications

Category Specification
Dimensions (H x W x D) 11.8x4.4x3.2cm (4.66 x 1.75 x 1.25 in)
Weight 0.26 Ibs

Table 62 Power supply environmental specifications

Category Specification
Ambient Operating 0°Cto +40°C
Temperature

Humidity 20% - 90%

Table 63 Power supply electrical specifications

Category Specification
AC Input 100 to 240 VAC
Efficiency Meets efficiency level ‘V’

Over Current Protection Zener clamping (38V to 45V)

Hold up time 10 ms minimum at maximum load, 120 VAC

POWER SUPPLY LOCATION

Find a location for the power supply that meets the following requirements:

The power supply can be mounted on a wall or other flat surface.
The power supply is kept dry, with no possibility of condensation, flooding or rising damp.
The power supply can be accessed to view status indicators.

The power supply can be connected to the ePMP module drop cable and network terminating
equipment.

The power supply can be connected to a mains or dc power supply that meets the
requirements defined in Table 63.
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Ethernet cabling
For details of the Ethernet cabling components of an ePMP installation, see:
o Ethernet standards and cable lengths on page 87

e QOutdoor Catbe cable on page 87

ETHERNET STANDARDS AND CABLE LENGTHS

All configurations require a copper Ethernet connection from the power supply port to the power
supply and network terminating equipment.

For each power supply, the maximum permitted drop cable length is specified in Table 64.

Table 64 Power supply drop cable length restrictions

Part number Description Maximum cable length (*1)

NO000000L034 POWER SUPPLY, 30W, 56V - 330 feet (100m)
Gbps support

NOOO900LO001A Power Supply for Radio with 330 feet (100m)
Gigabit Ethernet (no cord)

NOOO900L002A Power Supply for Radio with 330 feet (100m)
100Mbit Ethernet (no cord)

(*1) Maximum length of Ethernet cable from AP/SM to network device needs to follow 802.3
standards. If the power supply is not the network device the cable from the power supply to the
network device must be included in the total maximum cable length.

OUTDOOR CATS5E CABLE

For copper connections from the device to the power supply, use Catbe cable that is shielded with
copper-plated steel.

A Caution

Always use Catbe cable that is shielded with copper-plated steel. Alternative types of
Ethernet cables are not supported by Cambium Networks.
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Surge Suppression unit

The ePMP integrated and connectorized units both contain 1 Joule-rated surge suppression built
into the device. With this built-in surge suppression, it is not required to install a surge suppressor
at the unit’s mounting location. However, it is required to install a surge suppressor at the
Ethernet cable’s building ingress into the power supply’s indoor location. For installations that do
not require Gigabit (1000 Mbit/sec) Ethernet, a Cambium 600SSH surge suppressor may be used.
For more details, see Cambium 600SSH details.
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CAMBIUM 600SSH DETAILS

1  Holes—for mounting the Surge
Suppressor to a flat surface (such as an
outside wall). The distance between
centers is 4.25 inches (108 mm).

2  RJ-45 connectors—One side (neither
side is better than the other for this
purpose) connects to the product (AP,
SM, or cluster management module).
The other connects to the AC adaptor’s
Ethernet connector.

3 Ground post and washer—use heavy
gauge (10 AWG or 6 mm?) copper wire
for connection. Refer to local electrical
codes for exact specifications.

A
A “ Note
At Note The 600SSH surge suppressor is
For connectorized module installations shipped in the “isolated” position
requiring Gigabit (1000 Mbit/sec) Ethernet (pin 4 isolated by 68V from protective
surge suppression, utilize the following: earth). If packet error issues occur
Mfr Part Description over the Ethernet link (verify by
pinging the device through the
L-COM AL-CAT6JW Outdoor 10/100/1000 600SSH), configure the 600SSH to
Base-T CAT6 PoE “grounded” position (by moving the
Compatible Lightning 600SSH switch from “isolated” to
Protector “ground”) to avoid ground loops that
L-COM  AL- Outdoor 10/100/1000 may be present in the system.
CAT6HPJW Base-T CAT6 PoE 4  Ground Cable Opening—route the 10
Compatible Lightning AWG (6 mm?) ground cable through
Protector — High this opening.
Power (protection
comparable to 5 CAT-5 Cable Knockouts—route the two
600SSH) CAT-5 cables through these openings,
or alternatively through the Conduit
Knockouts.

6  Conduit Knockouts—on the back of the
case, near the bottom. Available for
installations where cable is routed
through building conduit.
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System planning
This chapter provides information to help the user to plan an ePMP link.
The following topics are described in this chapter:

e How to plan ePMP links to conform to the regulatory restrictions that apply in the country of
operation is explained under Radio spectrum planning on page 91.

e Factors to be considered when planning links such as range, path loss and throughput are
described under Link planning on page 95.

o Factors to be considered when planning to use connectorized APs with external antennas in
ePMP links are described under Planning for connectorized units on page 96.

e The grounding and lightning protection requirements of a ePMP installation are described
underGrounding and lightning protection on page 33.

e Factors to be considered when planning ePMP data networks are described under Data
network planning on page 98.
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Radio spectrum planning
This section describes how to plan ePMP links to conform to the regulatory restrictions that apply
in the country of operation.

|
Z'\*\' Caution

The user must ensure ePMP product operates in accordance to local regulatory limits.

A
Ad Note
Contact the applicable radio regulator to check if registration of the ePMP link is required.

GENERAL WIRELESS SPECIFICATIONS

The wireless specifications that apply to all ePMP variants are listed under Table 65. The wireless
specifications that are specific to each frequency variant are listed in Table 66 and Table 67.

Table 656 ePMP wireless specifications (all variants)

ltem Specification
Channel selection Automatic and Manual selection (fixed frequency).
Manual power control To avoid interference to other users of the band, maximum

power can be set lower than the default power limit.

Integrated device antenna Patch antenna

type

Duplex scheme Adaptive TDD (with optional Standard 802.11n Wi-Fi on SM)
Range 21 mi (5 MHz channel bandwidth)

17 mi (10 MHz channel bandwidth)
13 mi (20 MHz channel bandwidth)
9 mi (40 MHz channel bandwidth)

Over-the-air encryption AES

Error Correction FEC

Table 66 ePMP 2000 wireless specifications (per frequency band)

Item 5 GHz

RF band (GHz) 5150 - 5970 MHz

Channel bandwidth 5 MHz, 10 MHz, 20 MHz or 40 MHz

Typical antenna Connectorized antenna - 18 dBi
gain
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Table 67 ePMP 1000 wireless specifications (per frequency band)

ltem 5 GHz 2.4 GHz

RF band (GHz) 4900 - 5980 MHz 2407 - 2472 MHz

Channel bandwidth 5 MHz, 10 MHz, 20 MHz or 40 MHz 5 MHz, 10 MHz, 20 MHz or 40
MHz

Typical antenna Connectorized antenna — 15 dBi Connectorized antenna - 15 dBi

gain Integrated patch antenna — 13 dBi Integrated patch antenna - 11 dBi

Antenna beamwidth 24° azimuth, 12° elevation 24° azimuth, 12° elevation

(Integrated)

Antenna beamwidth 10° azimuth, 25° elevation 10° azimuth, 28° elevation

(Relector dish)

REGULATORY LIMITS

The local regulator may restrict frequency usage and channel width and may limit the amount of
conducted or radiated transmitter power. For details of these restrictions, see Examples of
regulatory limits on page 446.

Many countries impose EIRP limits (Allowed EIRP) on products operating in the bands used by the
ePMP Series. For example, in the 5 GHz and 2.4 GHz bands, these limits are calculated as follows:

e Inthe 5.2 GHz (5250 MHz to 5350 MHz) and 5.4 GHz (5470 MHz to 5725 MHz) band, the EIRP
must not exceed the lesser of 30 dBm or (17 + 10 x Log Channel width in MHz) dBm.

e |Inthe 5.8 GHz band (5725 MHz to 5875 MHz), the EIRP must not exceed the lesser of 36 dBm or
(23 + 10 x Log Channel width in MHz) dBm.

e Inthe 2.4 GHz band (2400 MHz to 2500 MHz), the EIRP must not exceed the lesser of 36 dBm or
(23 + 10 x Log Channel width in MHz) dBm.

Some countries (for example the USA) impose conducted power limits on products operating in
the 5 GHz and 2.4 GHz band.

CONFORMING TO THE LIMITS

Ensure the link is configured to conform to local regulatory requirements by configuring the
correct country code (located in the web management interface, under Configure => Radio). In the
following situations, the country code does not automatically prevent operation outside the
regulations:

e When using connectorized APs with external antennas, the regulations may require the
maximum transmit power to be reduced. To ensure that regulatory requirements are met for
connectorized installations, see Calculating maximum power level for connectorized units on
page 96. When operating in ETSI regions, it is required to enter a license key in the ePMP web
management interface to unlock valid country-specific frequencies. This key may be obtained
from https://support.cambiumnetworks.com/licensekeys/epmp.
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e When installing 5.4 GHz links in the USA, it may be necessary to avoid frequencies used by
Terminal Doppler Weather Radar (TDWR) systems. For more information, see Avoidance of
weather radars on page 94.

AVAILABLE SPECTRUM

The available spectrum for operation depends on the region. When configured with the
appropriate country code, the unit will only allow operation on those channels which are permitted
by the regulations.

A Note

In Italy, there is a regulation which requires a general authorization of any 5.4 GHz radio
link which is used outside the operator’s own premises. It is the responsibility of the
installer or operator to have the link authorized. For details, see:

http://www.sviluppoeconomico.gov.it/index.php?option=com_content&view=article&idme
nu=672
&idarea1=593&andor=AND&idarea2=1052&id=68433&sectionid=1,16&viewType=1&show
Menu=1&showCat=1&idarea3=0&andorcat=AND&partebassaType=0&idareaCalendariol=
0&MvediT=1

&idaread=0&showArchiveNewsBotton=0&directionidUser=0

For the form that must be used for general authorization, see:
http://www.sviluppoeconomico.gov.it/images/stories/mise_extra/Allegato%20n19.doc

Certain regulations have allocated certain channels as unavailable for use:

e ETSI has allocated part of the 5.4 GHz band to weather radar.

¢ UK and some other European countries have allocated part of the 5.8 GHz band to Road
Transport and Traffic Telematics (RTTT) systems.

For details of these restrictions, see Examples of regulatory limits on page 446.

Where regulatory restrictions apply to certain channels, these channels are barred automatically

by the use of the correct country code. For example, at 5.8 GHz in the UK and some other

European countries, the RTTT band 5795 MHz to 5815 MHz is barred. With the appropriate country
code configured for this region, the ePMP will not operate on channels within this band.

The number and identity of channels barred by the license key and country code is dependent on
the channel bandwidth.

For more information about configuring the Country Code parameter, see AP Radio page on page
125 and SM Radio page on page 194.
CHANNEL BANDWIDTH

Select the required channel bandwidth for the link. The selection depends upon the ePMP
frequency variant and country code, as specified on page 446.

The wider a channel bandwidth the greater is its capacity. As narrower channel bandwidths take
up less spectrum, selecting a narrow channel bandwidth may be a better choice when operating in
locations where the spectrum is very busy.

Both ends of the link must be configured to operate on the same channel bandwidth.
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AVOIDANCE OF WEATHER RADARS

To comply with FCC rules (KDB 443999: Interim Plans to Approve UNII Devices Operating in the
5470 - 5725 MHz Band with Radar Detection and DFS Capabilities), units which are installed within
35 km (22 miles) of a Terminal Doppler Weather Radar (TDWR) system (or have a line of sight
propagation path to such a system) must be configured to avoid any frequency within +30 MHz or
—30 MHz of the frequency of the TDWR device. This requirement applies even if the master is
outside the 35 km (22 miles) radius but communicates with outdoor clients which may be within
the 35 km (22 miles) radius of the TDWRs.

The requirement for ensuring 30 MHz frequency separation is based on the best information
available to date. If interference is not eliminated, a distance limitation based on line-of-sight from
TDWR will need to be used. In addition, devices with bandwidths greater than 20 MHz may require
greater frequency separation.

When planning a link in the USA, visit http://spectrumbridge.com/udia’home.aspx, enter the
location of the planned link and search for TDWR radars. If a TDWR system is located within 35 km
(22 miles) or has line of sight propagation to the PMP device, perform the following tasks:

o Register the installation on http://spectrumbridge.com/udia/home.aspx.

o Make a list of channel center frequencies that must be barred, that is, those falling within +30
MHz or -30 MHz of the frequency of the TDWR radars.

In ETSI regions, the band 5600 MHz to 5650 MHz is reserved for the use of weather radars.
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Link planning
This section describes factors to be taken into account when planning links, such as range,
obstacles path loss and throughput.

RANGE AND OBSTACLES

Calculate the range of the link and identify any obstacles that may affect radio performance.
Perform a survey to identify all the obstructions (such as trees or buildings) in the path and to
assess the risk of interference. This information is necessary in order to achieve an accurate link
feasibility assessment.

PATH LOSS

Path loss is the amount of attenuation the radio signal undergoes between the two ends of the
link. The path loss is the sum of the attenuation of the path if there were no obstacles in the way
(Free Space Path Loss), the attenuation caused by obstacles (Excess Path Loss) and a margin to
allow for possible fading of the radio signal (Fade Margin). The following calculation needs to be
performed to judge whether a particular link can be installed:

L treespace T Lexcess T Lrade T Lseasonar < Leapavitiy
Where: Is:
Lfree_space Free Space Path Loss (dB)
Lexcess Excess Path Loss (dB)
Lfade Fade Margin Required (dB)
Lseasonal Seasonal Fading (dB)
Lcapability Equipment Capability (dB)

Free space path loss is a major determinant in received (Rx) signal level. Rx signal level, in turn, is
a major factor in the system operating margin (fade margin), which is calculated as follows:

System Operating Margin (fade margin) dB = Rx signal level (dB) — Rx sensitivity (dB)

Thus, the fade margin is the difference between strength of the received signal and the strength
that the receiver requires for maintaining a reliable link.

ADAPTIVE MODULATION

Adaptive modulation ensures that the highest throughput that can be achieved instantaneously
will be obtained, taking account of propagation and interference. When the link has been installed,
web pages provide information about the link loss currently measured by the equipment, both
instantaneously and averaged.
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Planning for connectorized units

This section describes factors to be taken into account when planning to use connectorized APs
with external antennas in ePMP networks.

CALCULATING MAXIMUM POWER LEVEL FOR CONNECTORIZED UNITS

If a connectorized ePMP link is to be installed in a country that imposes an EIRP limit in the
selected band, choose an external antenna and RF cable that will not cause the ePMP to exceed the
EIRP limit. To calculate the highest setting of Maximum Power Level that will be permitted, use
this formula:

Maximum Power Level (dBm) = Allowed EIRP (dBm) — Antenna Gain (dBi) + Cable Loss (dB)

Where: Is:
Maximum Power the highest permissible setting of the Maximum Power Level
Level (dBm) attribute in the Step 2: Wireless Configuration page,

Allowed EIRP (dBm) the EIRP limit allowed by the regulations,
Antenna Gain (dBi) the gain of the chosen antenna,
Cable Loss (dB) the loss of the RF cable connecting the AP to the antenna.

As the 2.4 GHz, 5.4 GHz and 5.8 GHz have an operating bandwidth of 5 MHz, 10 MHz, 20 MHz or 40
MHz then the maximum allowed EIRP depends on the operating bandwidth of the radio as shown
in Table 68.

Table 68 Normal EIRP limits with operating channel bandwidth

Operating Allowed EIRP Allowed EIRP Allowed EIRP Allowed EIRP
bandwidth (dBm) at 5.2 GHz (dBm) at 5.4 GHz (dBm) at 5.8 GHz (dBm) at 2.4 GHz
{MHz)

5,10, 20, 40 24 - 30 24 - 30 36 36

The settings to be used for regions with the EIRP limits in Table 68 are shown in Table 69.

Table 69 Setting maximum transmit power to meet general EIRP limits

Antenna Maximum Operating Transmitter Output Power parameter
available bandwidth (MHz) setting (dBm)
antenna
gain (dBi) 5.2 GHz 54GHz 5.8GHz 2.4GHz
ePMP 2000 18 5,10, 20, 40 12 12 18 N/A

Connectorized
module Sector
antenna

ePMP 1000 15 5,10, 20, 40 15 15 21 21
Connectorized

module Sector

antenna
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‘A‘ Note

Calculations under Table 69 are on the basis of 0.5 dB cable loss and the highest gain antennas
per size of which Cambium Networks are aware. At these operating frequencies, antenna cable

losses even with short cables are unlikely to ever be below 0.5 dB for practical installations and
cable diameters.
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Data network planning

This section describes factors to be considered when planning ePMP data networks.

ETHERNET INTERFACES

The ePMP Ethernet ports conform to the specifications listed in Table 70 and Table 71.

Table 70 ePMP 2000 Ethernet bridging specifications

Ethernet Bridging

Specification

Protocol 10BASE-Te/100BASE-Tx/1000BASE-T IEEE 802.3
IEEE 802.3at (PoE)
IEEE802.3u compliant Auto-negotiation

QoS Proprietary QoS

Interface 10/100/1000BaseT (RJ-45)

Data Rates See Data throughput tables on page 474.

Maximum Ethernet Frame Size 1700 bytes

Service classes for bridged 3 classes

traffic

Table 71 ePMP 1000 Ethernet bridging specifications

Ethernet Bridging

Specification

Protocol 10BASE-Te/100BASE-Tx/1000BASE-T IEEE 802.3
IEEE 802.3af (PoE)
IEEE802.3u compliant Auto-negotiation

QoS Proprietary QoS

Interface 10/100/1000BaseT (RJ-45)

Data Rates See Data throughput tables on page 474.

Maximum Ethernet Frame Size 1700 bytes

Service classes for bridged 3 classes

traffic
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Ad Note

Practical Ethernet rates will depend on network configuration, higher layer protocols and
platforms used.

Over the air throughput will be capped to the rate of the Ethernet interface at the
receiving end of the link.

MANAGEMENT VLAN

Decide if the IP interface of the AP/SM management agent will be connected in a VLAN. If so,
decide if this is a standard (IEEE 802.1Q) VLAN or provider bridged (IEEE 802.1ad) VLAN, and select
the VLAN ID for this VLAN.

Use of a separate management VLAN is strongly recommended. Use of the management VLAN
helps to ensure that the AP/SM management agent cannot be accessed by customers.

QUALITY OF SERVICE FOR BRIDGED ETHERNET TRAFFIC

Decide how quality of service will be configured in ePMP to minimize frame loss and latency for
high priority traffic. Wireless links often have lower data capacity than wired links or network
equipment like switches and routers, and quality of service configuration is most critical at network
bottlenecks.

ePMP provides three priority types for traffic waiting for transmission over the wireless link —
Voice, High and Low. Low is the lowest priority and Voice is the highest priority. Traffic is
scheduled using strict priority; in other words, traffic in a given priority is transmitted when all
higher-priority transmissions are complete.
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Configuration

This chapter describes all configuration and alignment tasks that are performed when an ePMP
system is deployed.

Configure the units by performing the following tasks:

e Preparing for configuration on page 101

e Using the web interface on page 104

¢ Configuring connectorized radios using the Quick Start menu on page 116
e Configuring SM units using the Quick Start menu on page 119

e Using the AP menu options on page 123

o Using the SM menu options on page 192
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Preparing for configuration

This section describes the checks to be performed before proceeding with unit configuration.

SAFETY PRECAUTIONS

All national and local safety standards must be followed while configuring the units.

mWarning

Ensure that personnel are not exposed to unsafe levels of RF energy. The units start to
radiate as soon as they are powered up. Respect the safety standards defined in Compliance
with safety standards on page 427, in particular the minimum separation distances.

Observe the following guidelines:

Never work in front of the antenna when the AP is powered. Always power down the power supply
before connecting or disconnecting the Ethernet cable from the module.

REGULATORY COMPLIANCE

All applicable radio regulations must be followed while configuring the units and aligning the
antennas. For more information, Compliance with safety standards on page 429.
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Connecting to the unit

To connect the unit to a management PC, use the following procedures:

¢ Configuring the management PC on page 102
¢ Connecting to the PC and powering up on page 103

CONFIGURING THE MANAGEMENT PC

Use this procedure to configure the local management PC to communicate with the ePMP module.

Procedure:

1 Select Properties for the Ethernet port.

In Windows 7 this is found in Control Panel >
Network and Internet >

Network Connections > Local Area
Connection.

2 Select the Internet Protocol (TCP/IP) item:

3 Click Properties.

4 Enter an IP address that is valid for the
192.168.0.X network, avoiding:

192.168.0.1, 192.168.0.2 and 192.168.03
A good example is 192.168.0.100:

5 Enter a subnet mask of 255.255.255.0.
Leave the default gateway blank.

6 Click OK, then click Close

=
@ Local Area Connection Properties . u

Networking | Sharng

Connect using:
Il.ﬂ' Intel(R) 82566MM Gigabit Network Connection

This connection uses the following tems:

o Client for Microsoft Networks

=005 Packet Scheduler

gl—‘lle and Printer Sharing for Microsoft Networks
«& PPP over Ethemet Protocol

& Intemet Protocal Version & (TCP/IPvE) fl
B "=t Frotocol Version 4 (TCP/1Pv4) |

& Link-Layer Topology Discovery Mapper /0 Driver
& Link-Layer Topology Discovery Responder

Install... Uninstall

Description

Transmission Corttrol Protocol/Intemet Protocol. The default
wide area network protocol that provides communication
across diverse interconnected networks.

=
Internet Protacol Version 4 (TCP/IPvd) Properties m
—

General

You can get IP settings assigned automatically if your network supparts
this capability, Otherwise, you need to ask your network administrator
for the appropriate IP settings.

() Obtain an IP address automatically

(@ Uge the following IP address:

IP address: 192 .168 . 0 . 100
Subnet mask: 255,255,255, 0
Default gateway:

Obtain DNS server address automatically
@ Use the following DNS server addresses:
Preferred DNS server:

Alternate DNS server:

[ validate settings upon exit
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CONNECTING TO THE PC AND POWERING UP

Use this procedure to connect a management PC directly to the ePMP for configuration and
alignment purposes and to power up the ePMP device.

Procedure:

1 Check that the device and power supply are correctly connected (the device Ethernet port is
connected to the power supply Ethernet power port — see the ePMP Installation Guide for
more information).

2 Connect the PC Ethernet port to the LAN (AP: “Gigabit Data”, SM: “10/100Mbit Data”) port
of the power supply using a standard (not crossed) Ethernet cable.

3  Apply mains or battery power to the power supply. The green Power LED must illuminate
continuously.

A Note

If the Power and Ethernet LEDs do not illuminate correctly, see Testing hardware on page 296.
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Using the web interface

To understand how to use the ePMP web interface, see:

¢ Logging into the web interface on page 105

e Layout of the web interface on page 105

¢ Configuring connectorized radios using the Quick Start menu on page 116
¢ Configuring SM units using the Quick Start menu on page 119

e Using the AP menu options on page 123
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LOGGING INTO THE WEB INTERFACE

Use this procedure to log into the web interface as a system administrator.

Equipment and tools:

Connectorized or integrated device connected to power supply by Ethernet cable.
PC connected to power supply by Ethernet cable.
Power Supply powered up.

Minimum supported browser version - Chrome v29, Firefox v24, Internet Explorer 10, Safari
vb.

Procedure:

2 Type the IP address of the unit into the address bar. The factory default

1 Start the web browser from the management PC.

admin

IP address is either 192.168.0.1 (AP mode) or 192.168.0.2 (SM mode). T
Press ENTER. The web interface dashboard and login input is
displayed.

A
Ad Note

If Device IP address Mode is set to DHCP and the device is unable to retrieve IP address
information via DHCP, the device management IP is set to fallback IP 192.168.0.1 (AP mode),
192.168.0.2 (SM mode), 192.168.0.3 (Spectrum Analyzer mode) or the previously-configured
static Device IP Address. Units may always be accessed via the Ethernet port. With Release 2.1,
the fallback IP address has changed from 10.1.1.254 to 169.254.1.1.

3 Enter Username (default: admin) and Password (default: admin).

4 Click Login.

A Note

New ePMP devices all contain default username and password configurations. It is
recommended to change these password configurations immediately. These passwords may be
configured in the management GUI in section Configuration => System => Account
Management.

LAYOUT OF THE WEB INTERFACE

After logging in, the web interface first displays a dashboard view of vital system status and
statistics. Also, the first level of navigation is displayed across the top (Configure, Monitor, Tools

&N
and Quick Start). To return to this display at any time, click the Home (Lal) icon or device name
(i.e. “ePMP Access Point”)
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Figure 29 ePMP 2000 GUI dashboard (includes additional fields not resident in ePMP 1000)
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Figure 30 ePMP 1000 GUI dashboard
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The top of the interface contains the following attributes:

Table 72 GUI status bar attributes

Icon Attribute

Meaning

Cambium Networks
logo

Hyperlink to the Cambium Networks website.

Home Icon

Link to the device dashboard.

LR Login Level indicator

Displays the current user login level.

Internet Connectivity
- Indicator

Green indicates that the AP has IP connectivity to
the configured DNS server.

Grey indicates that the AP has no IP connectivity
to the configured DNS server.

Ad Note

The Internet Connectivity Indicator state is
determined by receipt of ping responses
from the configured DNS server.

= GPS Synchronization
- . :
Receive Indicator

Green indicates that the AP is receiving a valid
GPS synchronization timing pulse via a connected
GPS antenna or a CMM.

Red indicates that the AP is not receiving GPS
synchronization due to lack of satellite fix.

Grey indicates that the AP is not receiving GPS
synchronization due to configuration of
Synchronization Source to Internal.

1 Notifications Button

The Notifications button may be clicked to display
system messaging. When a new notification is
available, the icon is highlighted and displays the
number of notifications available. The outer icon
highlighting indicates the type of notification
pending:

Green: Successful operation has completed (i.e.
Changes successfully saved)

Grey: Informational message (i.e. tips regarding
GUI operation)

Blue: Operations information message (i.e.
Initializing upgrade...)

Orange: Warning message (i.e. Login session has
expired)

Red: Error message (i.e. Software update file
download failed)
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Icon Attribute Meaning
When the mouse pointer is hovered over this
(1] indicator, it displays the number of active Read-
i Active Users Indicator ' play .
Only and Read-Write users currently logged into
the radio.

The Undo button may be used to undo changes
) Undo Button prior to a Save operation. All changes made on
any section of the GUI are undone.

The Save button is used to commit configuration
changes to the device. When configuration

B Save Button changes are made, the outer area of the icon is
highlighted blue to indicate that a save operation
is required.

The Reset button is used to reset the device.
When a configuration change requires a radio

(U] Reset Button reset, the outer area of this icon is highlighted
orange to indicate that a reset is necessary to
complete the change.

The Logout button is used to logout from the

Logout Button current session and return to the initial GUI

landing page (login screen).

The bottom of the interface contains the following attributes:

Table 73 GUI footer attributes

Attribute Meaning
Copyright Copyright information.
Version The current software version is reported in the footer bar and may be

clicked to navigate to the Cambium Networks software support website.

Support Hyperlink to the Cambium Networks support website.

Community Forum Hyperlink to the Cambium Community Forum website.

The AP dashboard contains the following attributes:
Table 74 AP dashboard attributes

Attribute Meaning

Device Name The configured device name of the AP, used for identifying the device in
an NMS such as the Cambium Network Services Server (CNSS).

SSID The current configured name/SSID of the AP.
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Attribute

Meaning

Operating Frequency

The current frequency carrier used for radio transmission, based on the
configuration of the Frequency Carrier parameter (in DFS regions, if a
radar has been detected, this field may display either DFS Alternate
Frequency Carrier 1 or DFS Alternate Frequency Carrier 2).

Operating Channel
Bandwidth

The current channel bandwidth used for radio transmission, based on
the configuration of the Channel Bandwidth parameter.

Transmitter Output
Power

The current operating transmit power of the AP.

Antenna Gain

The configured gain of the external antenna.

Country

The current configured country code, which has an effect on DFS
operation and transmit power restrictions. Registered Subscriber
Modules will inherit this country code when registration is complete
(unless SM is locked to US region).

Access Point Mode

TDD: The Access Point is operating in point-to-multipoint (PMP) mode
using TDD scheduling. The AP is able to GPS synchronize in this mode
(except when in Flexible mode).

ePTP Master: The Access Point is operating as a Master in point-to-point
mode. The AP does not support GPS Synchronization in this mode but is
able to provide significantly lower latency than other modes. QoS (MIR
and traffic priority) capability and Link Quality/Capacity indicators are
not available in this mode.

PTP: The Access Point is operating in point-to-point (PTP) mode using
TDD scheduling. The AP is able to GPS synchronize in this mode (except
when in Flexible mode).

Downlink/Uplink
Frame Ratio

The current configured schedule of downlink traffic to uplink traffic on
the radio link. In other words, this ratio represents the amount of the
total radio link’s aggregate throughput that will be used for downlink
resources and the amount of the total radio link’s aggregate throughput
that will be used for uplink resources.

Wireless Security

The current configured authentication type used for radio link encryption
as well as SM authentication.

cnMaestro Remote
Management

Indicates whether the device is currently configured to be managed by
the Cambium cloud management system — cnMaestro™.

cnMaestro
Connection Status

The current management status of the device with respect to the
Cambium Cloud Server. When Enabled under Configuration->System,
the device will be managed by the Cambium Remote Management
System, which allows all Cambium devices to be managed from the
Cambium Cloud Server.
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Attribute

Meaning

cnMaestro Account
ID

The ID that the device is currently using to be managed by the Cambium
Cloud Server.

Wireless MAC The MAC address of the device wireless interface.

Address

Ethernet MAC The MAC address of the device Ethernet (LAN) interface.

Address

IP Address The current configured device IP address (LAN) used for management

access.

IPv6 Link Local

A link-local address is required for the IPv6-enabled interface

Address (applications may rely on the link-local address even when there is no
IPv6 routing). The IPv6 link-local address is comparable to the auto-
configured IPv4 address 169.254.0.0/16.

IPv6 Address The IPv6 address for device management.

Date and Time

The current date and time on the device, subject to the configuration of
parameter Time Zone.

System Uptime

The total uptime of the radio since the last reset.

System Description

The current configured system description.

Sync Source Status

Displays the current source (GPS, CMM or Internal) of sync timing for
the AP.

Device Coordinates

The current configured Latitude and Longitude coordinates in decimal
format.

DFS Status

Current DFS operational status.

Ethernet Status

Up: The Ethernet (LAN) interface is functioning properly. This also
displays the current port speed and duplex mode to which the Ethernet
port has auto-negotiated to or configured for.

Down: The Ethernet (LAN) interface is either disconnected or it has
encountered an error and is not servicing traffic.

Wireless Status

Up: The radio (WAN) interface is functioning properly

Down: The radio (WAN) interface has encountered an error and is not
servicing traffic.

Registered
Subscriber Modules

The total number of SMs currently registered to the AP.
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Attribute

Meaning

Smart Antenna
(ePMP 2000 only)

Smart Antenna is Connected, Power On: ePMP 2000 is communicating
with the Smart Antenna, and a proper power supply is in use

Smart Antenna is Connected, Power Off:: ePMP 2000 established
communication with the Smart Antenna, but subsequent
communication errors occurred or an improper power supply was
detected

Smart Antenna is Disconnected: Communication between ePMP 2000
and Smart Antenna is down

Power Supply

This field indicates the type of power supply being used to power ePMP
2000. Values are 802.3at and Generic Power Supply.

The Cambium Power Supply provided with ePMP 2000 will be displayed
as "Generic Power Supply". If a different power supply is used and
"Generic Power Supply" is indicated, please make sure that the power
supply wattage is a minimum of 20 watts.
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The SM dashboard is as shown in Figure 31 and the attributes are explained in Table 75.

Figure 31 SM Dashboard
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Table 75 SM Dashboard Attributes

Device Name

Operating Fraquency
Operating Channel Bandwidth
Transmitter Output Power
Antenna Gain

Country

Subscriber Module Mode
Subscriber Module Priority
Network Mode

Downlink RSS!

Downlink SNR

Uplink MCS

Downlink MCS

cnMaestro Remote Management

cnMaestro Connection Status

cnMaestro Account 1D

ePMP1000_SM
5700 MHz
40 MHz
4dBm

15 dBi
Other
TDD

Low
Bridge
-58 dBm
29dB
MCS 15
MCS 15

Enabled - The Registered AP Is
Onboarded

Connected to
cloud.cambiumnetworks.com

wireless MAC Address
Ethernet MAC Address
IP Address

IPv6 Link Local Address
IPv6 Address

Date and Time

System Uptime
System Description
Registered AP SSID
Registered AP MAC Address
Device Coordinates
Link Quality (Uplink)
Link Capacity (Uplink)
Ethernet Status

Wireless Status
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15 minutes, 52 seconds

Cambium-AP

Attribute

Meaning

Device Name

The configured device name of the SM, used for identifying the device in
an NMS such as the Cambium Network Services Server (CNSS).

Operating Frequency

The current operating frequency.

Operating Channel

Bandwidth

The current operating width of the channel used for the radio link.

Transmitter Output

Power

The current power level at which the SM is transmitting (which is

adjusted dynamically by the AP based on radio conditions).

Antenna Gain

The configured gain of the external antenna.

Country The current configured country code, which has an effect on DFS
operation and transmit power restrictions. Registered Subscriber
Modules will inherit this country code when registration is complete
(unless SM is locked to US region).
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Attribute

Meaning

Subscriber Module
Mode

TDD: The SM is operating in the proprietary TDD mode and will only
connect to another ePMP Access Point.

Standard WiFi: The SM is operating in the Standard 802.11n WiFi mode
and will be able to connect to any Access Point operating in standard
WiFi mode.

ePTP Slave: The SM is operating as a Slave in point-to-point mode. The
AP and the system do not support GPS Synchronization in this mode but
are able to provide significantly lower latency than other modes. QoS
(MIR and traffic priority) capability and Link Quality/Capacity indicators
are not available in this mode.

Subscriber Module
Priority

The configured priority of the SM in the sector.

Network Mode

Bridge: The SM acts as a switch, and packets are forwarded or filtered
based on their MAC destination address.

NAT: The SM acts as a router, and packets are forwarded or filtered
based on their IP header (source or destination) which can be grouped
into subnets for finer granularity.

Router: The SM acts as a router and packets are forwarded or filtered
based on their IP header (source or destination) using specific static
routes and IP aliases configured by the operator.

Downlink RSSI The Received Signal Strength Indicator, which is a measurement of the
power level being received by the SM’s antenna.

Downlink SNR The Signal to Noise Ratio, which is an expression of the carrier signal
quality with respect to signal noise and co-channel interference (or
both).

Uplink MCS Modulation and Coding Scheme - indicates the modulation mode used
for the radio uplink, based on radio conditions (MCS 1-7, 9-15).

Downlink MCS Modulation and Coding Scheme - indicates the modulation mode used

for the radio downlink, based on radio conditions (MCS 1-7, 9-15).

cnMaestro Remote
Management

Indicates whether the device is currently configured to be managed by
the Cambium cloud management system — cnMaestro™.

cnMaestro
Connection Status

The current management status of the device with respect to the
Cambium Cloud Server. When Enabled under Configuration->System,
the device will be managed by the Cambium Remote Management
System, which allows all Cambium devices to be managed from the
Cambium Cloud Server.

cnMaestro Account
ID

The ID that the device is currently using to be managed by the Cambium
Cloud Server.
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Attribute Meaning

Wireless MAC The MAC address of the device Wireless interface.

Address

Ethernet MAC The MAC address of the device LAN (Ethernet) interface.

Address

IP Address The current configured device IP address (LAN, Ethernet interface) used

for management access.

IPv6 Link Local

A link-local address is required for the IPv6-enabled interface

Address (applications may rely on the link-local address even when there is no
IPv6 routing). The IPv6 link-local address is comparable to the auto-
configured IPv4 address 169.254.0.0/16.

IPv6 Address The IPv6 address for the device when the device is used in Bridge mode.

This is the IPv6 address for the subnet associated with the Ethernet
interface when the device is used in NAT and Router modes.

Wireless IP Address

The current configured device IP address (Wireless interface), when the
SM is in Router (NAT) mode.

Separate Wireless
Management IP
Address

The current configured device IP address (Separate Wireless
Management interface) used for management access, when the SM is in
Router (NAT) mode.

Date and Time

The current date and time on the device, subject to the configuration of
parameter Time Zone. If an NTP server is not specified, the date and
time will begin from factory default upon radio startup.

System Uptime

The total uptime of the radio since the last reset.

System Description

The current configured system description.

Registered AP SSID

The AP SSID of the AP to which the SM is registered.

Registered AP MAC
Address

The Wireless MAC Address of the AP to which the SM is registered.

Device Coordinates

The current configured Latitude and Longitude coordinates in decimal
format.

DFS Status

Current DFS operational status.

Link Quality (Uplink)

The Uplink quality based on the current MCS and Packet Error Rate
(PER).

Link Capacity
(Uplink)

The uplink capacity based on the current MCS with respect to the
highest supported MCS (MCS15).
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Attribute Meaning

Ethernet Status Up: The Ethernet (LAN) interface is functioning properly. This also
displays the current port speed and duplex mode to which the Ethernet
port has auto-negotiated to or configured for.

Down: The Ethernet (LAN) interface is either disconnected or it has
encountered an error and is not servicing traffic.

Wireless Status Up: The radio (WAN) interface is functioning properly.

Down: The radio (WAN) interface has encountered an error and is not
servicing traffic.

The GUI interface consists of two levels of navigation — the first-level A Home
navigation buttons on the left-hand side (Home, Quick Start, Configuration, 2 ks
Monitor, Tools) as well as the context-based second-level navigations

Q Configuration~

displayed after clicking Configuration, Monitor, or Tools..

008 Quality of Service
E‘f." System
;'-:_ MNetwork
@ Security
-*\- Monitor -
/ Tools ~

026v003 115



cPMP

CAMBIUM NETWORKS

Configuring connectorized radios using the Quick Start menu

The Quick Start tab contains a listing of parameters required to configure a simple radio link and to
configure requisite networking parameters. After configuring an AP, SM and resetting both
devices, the SM is ready to associate (register) to the AP.

Figure 32 AP Quick Start menu
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To configure an AP via the Quick Start menu, follow this procedure:

Procedure:
1  Start the web browser from the management PC.
2 Navigate to the Quick Start menu
3 Configure the parameter Radio Mode:
This parameter controls the function of the device — All ePMP devices may be configured to
operate as an Access Point (AP), Subscriber Module (SM) or as a Spectrum Analyzer. For
initial link bring-up, choose Access Point.
4  Configure the parameter Access Point Mode:
This parameter controls the mode of operation of the Access Point — An AP may be
configured to operate in TDD mode for multipoint access, PTP mode for point-to-point access
using TDD, Standard WiFi or as an ePTP Master. For initial link bring-up, choose TDD. When
the AP is an ePTP Master, the system does not support GPS Synchronization but is able to
provide significantly lower latency than other modes. QoS (MIR and traffic priority) capability
and Link Quality/Capacity indicators are not available in this mode. Configuring the AP in
Standard WiFi mode allows any 802.11 client to register to the AP.
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5 Configure the parameter Country:
Country settings affect the radios in the following ways:
*  Maximum transmit power limiting (based on radio transmitter power plus configured
antenna gain)
» DFS operation is enabled based on the configured country code, if applicable
» Frequency selection limiting (based on valid frequencies for the configured Country

Select the country in which your network will be operating.

6 Configure the parameter Automatic Channel Selection (ACS):

When ACS is enabled, the AP will automatically scan the available spectrum and choose a
channel with the lowest occupancy. For more information on this parameter please see AP
Automatic Channel Selection page on page 184.

7 Configure the parameter Frequency Carrier:

Configure the frequency carrier for RF transmission. This list is dynamically adjusted to the
regional restrictions based on the setting of the Country Code parameter. Ensure that a
thorough spectrum analysis has been completed prior to configuring this parameter.

8 Configure parameter AP SSID (Name):

The AP SSID (Name) is used to identify the AP and is used to configure the SM with the
appropriate AP with which to register. Ensure that this parameter is configured uniquely for
each AP in the network.

9 Configure the parameter Downlink/Uplink Ratio:

Specify the percentage of the aggregate throughput for the downlink (frames transmitted
from the AP to the SM). For example, if the aggregate (uplink and downlink total) throughput
on the AP is 90 Mbps, then 75/25 specified for this parameter allocates 67.5 Mbps for the
downlink and 22.5 Mbps for the uplink. The default for this parameter is 75/25.

AN
&3 Caution

You must set this parameter exactly the same for all APs in a cluster.

10 Configure the parameter Synchronization Source:

This parameter defines the timing source for the device which can be GPS-based or
internally generated. Select GPS if the AP will receive synchronization pulses from a
connected GPS antenna. Select CMM3 or CMM4 if the device will receive GPS
synchronization pulses from a co-located Cambium Cluster Management Module (see PMP
Synchronization Solutions User Guide). Select Internal if no GPS synchronization source is
available (in this mode, transmission between co-located devices will create radio
interference). If Flexible is chosen as the DL/UL Ratio or if the Access Point Mode is chosen
as ePTP Master, then this parameter will be greyed out.

11 Configure the parameter IP Assignment:

If DHCP is selected, the DHCP server automatically assigns the IP configuration (Ethernet
(LAN) IP Address, Ethernet (LAN) IP Subnet Mask, Gateway IP Address (LAN)) and the values
of those individual parameters (below) are not used. To configure a simple test network,
select mode Static.
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12 Configure the parameter IP address:
Internet Protocol (IP) address. This address is used by the family of Internet protocols to
uniquely identify this unit on a network. To configure a simple test network, this field may be
left at default (192.168.0.1).

13 Configure the parameter Subnet Mask:
The Subnet Mask defines the address range of the connected IP network. To configure a
simple test network, this field may be left at default (255.255.255.0).

14 Configure the parameter Gateway:
The IP address of the device on the current network that acts as a gateway. A gateway acts
as an entrance and exit to packets from and to other networks. To configure a simple test
network, this parameter may be left at default (blank).

15 Configure the parameter IPv6 Assighnment
IPv6 Assignment specifies how the IPv6 address is obtained.

Static: Device management IP addressing is configured manually in fields IPv6 Address and
IPv6 Gateway.

DHCPv6: Device management IP addressing (IP address and gateway) is assigned via a
network DHCP server, and parameters IPv6 Address and IPv6é Gateway are unused. If the
DHCPvV6 server is not available previous static IPv6 address will be used as a fallback IPv6
address. If no previous static IPv6 address is available, no IPv6 address will be assigned.
DHCPv6 will occur over the wireless interface by default.

16 Configure the parameter IPv6 Address

Internet protocol version 6 (IPv6) address. This address is used by the family of Internet
protocols to uniquely identify this unit on a network.

IPv6 addresses are represented by eight groups of four hexadecimal digits separated by
colons.

17 Configure the parameter IPv6 Gateway
Configure the IPv6 address of the device on the current network that acts as a gateway. A
gateway acts as an entrance and exit to packets from and to other networks.

18 Configure the parameter WPA2 Pre-shared Key

Configure this key on the AP and then configure each of the network SMs with this key to
complete the authentication configuration. This key must be between 8 to 128 symbols. Click

the visibility icon to toggle the display of the key’s contents.

19 Click the Save icon, then click the Reset icon
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Configuring SM units using the Quick Start menu

The Quick Start tab contains a simple listing of parameters required to configure a simple radio
link and to configure requisite networking parameters.

Figure 33 SM Quick Start menu
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To configure a SM via the Quick Start menu, follow this procedure:

Procedure:
1  Start the web browser from the management PC.
2 Navigate to Quick Start menu

3 Configure the parameter Radio Mode:

This parameter controls the function of the device — all ePMP devices may be configured to
operate as an Access Point (AP), Subscriber Module (SM), or as a Spectrum Analyzer. For
initial link bring-up, choose Subscriber Module.
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4  Configure the parameter Subscriber Module Mode:

This parameter controls the mode of operation of the Subscriber Module — An SM may be
configured to operate in TDD mode for point-to-point and point-to-multipoint access,
Standard WiFi mode providing the capability to connect to any AP operating in standard WiFi
mode or as an ePTP Slave. For initial link bring-up, choose TDD. When the SM is an ePTP
Slave, the system does not support GPS Synchronization but is able to provide significantly
lower latency than other modes. QoS (MIR and traffic priority) capability and Link
Quality/Capacity indicators are not available in this mode.

5 The Country is automatically retrieved from the AP and requires no configuration.
Country settings affect the radios in the following ways:

* Maximum transmit power limiting (based on radio transmitter power plus configured
antenna gain)

» DFS operation is enabled based on the configured country code, if applicable

* Frequency range of operation depending on local limitations

6 Configure the parameter Device Name:
The SM Device Name is used to identify the device on the network. This parameter may be
modified or left at the default value of Cambium-SM.

7 Configure the parameter Network Mode:

Bridge: The SM acts as a switch, and packets are forwarded or filtered based on their MAC
destination address.

NAT: The SM acts as a router, and packets are forwarded or filtered based on their IP header
(source or destination) which can be grouped into subnets for finer granularity.

Router: The SM acts as a router and packets are forwarded or filtered based on their IP
header (source or destination) using specific static routes and IP aliases configured by the
operator.

8 Configure the parameter Wireless IP Assignment:

If DHCP is selected, the DHCP server automatically assigns the IP configuration (Ethernet
(LAN) IP Address, Ethernet (LAN) IP Subnet Mask, Gateway IP Address (LAN)) and the values
of those individual parameters (below) are not used. To configure a simple test network, this
parameter must be configured to Static.

9 Configure the parameter Wireless IP Address:

Internet Protocol (IP) address. This address is used by the family of Internet protocols to
uniquely identify this unit on a network. To configure a simple test network, this field must
be configured to 192.168.0.2.

10 Configure the parameter Wireless Subnet Mask:
The Subnet Mask defines the address range of the connected IP network. To configure a
simple test network, this field may be left at default (255.255.255.0).

11 Configure the parameter Wireless Gateway:

The IP address of the device on the current network that acts as a gateway. A gateway acts
as an entrance and exit to packets from and to other networks. To configure a simple test
network, this parameter may be left at default (blank).
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12

13

14

15

16

17

18

19

Configure the parameter IPv6 Assignment
IPv6 Assignment specifies how the IPv6 address is obtained.

Static: Device management IP addressing is configured manually in fields IPv6 Address and
IPv6 Gateway.

DHCPv6: Device management IP addressing (IP address and gateway) is assigned via a
network DHCP server, and parameters IPv6 Address and IPvé Gateway are unused. If the
DHCPv6 server is not available previous static IPv6 address will be used as a fallback IPv6
address. If no previous static IPv6 address is available, no IPv6 address will be assigned.
DHCPv6 will occur over the wireless interface by default.

Configure the parameter IPv6 Address

Internet protocol version 6 (IPv6) address. This address is used by the family of Internet
protocols to uniquely identify this unit on a network.

IPv6 addresses are represented by eight groups of four hexadecimal digits separated by
colons.
Configure the parameter IPv6 Gateway

Configure the IPv6 address of the device on the current network that acts as a gateway. A
gateway acts as an entrance and exit to packets from and to other networks.

Configure the parameter WPA2 Pre-shared Key:

Configure each of the network SMs with this key (matching the AP’s configured key) to
complete the authentication configuration. This key must be between 8 to 128 symbols. Click

the visibility icon to toggle the display of the key’s contents.

Configure the parameter EAP-TTLS Username:

Configure each of the network SMs with this EAP-TTLS Username (matching the credentials
on the RADIUS server being used for the network). Optionally, the device MAC Address can
be used as the EAP-TTLS Username in either “:” or “-* delimited format.

Configure the parameter EAP-TTLS Password:

Configure each of the network SMs with this EAP-TTLS Password (matching the credentials

on the RADIUS server being used for the network). Click the visibility icon * to toggle
the display of the password’s contents.

Configure the parameter Authentication Identity String:

Configure each of the network SMs with this Identity string (matching the credentials on the
RADIUS server being used for the network). Default value for this parameter is
“anonymous”.

Configure the parameter Authentication Identity Realm:

Configure each of the network SMs with this Identity realm (matching the credentials on the
RADIUS server being used for the network). Default value for this parameter is
“cambiumnetworks.com”.
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20 Configure the Preferred AP’s

The Preferred AP’s is comprised of a list of up to 16 APs to which the SM sequentially
attempts registration. For each AP configured, if authentication is required, enter a Pre-
shared Key associated with the configured AP SSID. If this list is empty or if none of the
configured APs are found, the SM scans and registers to the best AP signal found (with
matching radio and/or authentication settings).

21 Configure the parameter Subscriber Module Scanning:

The Radio Scan List determines the frequencies for which the SM scans for AP signaling. For
a simple radio network setup, click Select All to scan all frequencies.

22 Click the Save icon, then click the Reset icon
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Using the AP menu options

Use the menu navigation bar in the top and left panels to navigate to each web page. The
functional areas that may be accessed from each menu option are listed in Table 76. Some of the
parameters are only displayed for specific system configurations.

Table 76 Functional areas accessed from each AP menu option

Menu option

Menu Details

Quick Start

Configuring connectorized radios using the Quick Start menu
on page 116

Configuration

AP Configure menu on page 124

Radio

AP Radio page on page 125

Quality of Service

AP Quality of Service page on page 137

System AP System page on page 140
Network AP Network page on page 145
Security AP Security page on page 150
Monitor AP Monitor menu on page 153
Performance AP Performance page on page 154
System AP System page on page 158
Wireless AP Wireless page on page 161

Throughput Chart

AP Throughput Chart page on page 164

GPS AP GPS page on page 165

Network AP Network page on page 167

System Log AP System Log page on page 170
Tools AP Tools menu on page 171

Software Upgrade

AP Software Upgrade page on page 172

Backup / Restore

AP Backup/Restore page on page 174

License Management

AP License Management page on page 177

eDetect

AP eDetect page on page 177

Spectrum Analyzer

AP Spectrum Analyzer page on page 181

Automatic Channel Selection

AP Automatic Channel Selection page on page 184

eAlign

AP eAlign page on page 186

Wireless Link Test

AP Wireless Link Test page on page 188

Ping AP Ping page on page 189
Traceroute AP Traceroute page on page 191
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AP CONFIGURE MENU

Use the Configure menu to access all applicable device configuration parameters. The
configuration menu contains the following pages:

e AP Radio page on page 125

e AP Quality of Service page on page 137
e AP System page on page 140

e AP Network page on page 145

e AP Security page on page 150
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AP Radio page

Use the Radio page to configure the device radio interface parameters.

& Caution

Plan Configuration modifications since modifying radio parameters may result in a wireless

outage.

Figure 34 AP Radio page
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SMHz © 10MHz ® 20MHz © 40MHz © Downlink/Uplink Rstio @
. - Freme Size
SMHz © 10MHz ® 20MHz © 20 MHz Downlink Max Rate

© WManagement Traffic Rate

Synchronization
Co-location Mode
Synchronization Source @

© Synchronization Heldoff Time
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19 dBm | min: 0 | max: 30

7 dBi | min: 0 | max: 40

-70 dBm | min: -80 | max: -40
Auto
Forced Secter Antenna
Forced Smart Antenna
75/25 50/50 30/70 Flexible
25ms @ Sms
MCS 15 - 64-QAM 5/6 -
MCS0 ® MCS1
Disabled Enabled
GPS CcMmM2 Cm4 Internal
3000 sec | min: 20 | max: 86400
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Table 77 AP Radio Configuration attributes

Attribute Meaning

General

Radio Mode This parameter controls the function of the device — All ePMP devices may
be configured to operate as an Access Point (AP), Subscriber Module (SM)
or as a Spectrum Analyzer. For initial link bring-up, choose AP.

Driver Mode TDD: The Access Point is operating in point-to-multipoint (PMP) mode using

TDD scheduling. The AP is able to GPS synchronize in this mode (except
when in Flexible mode).

Standard WiFi: The Access Point is operating as a Standard 802.11n Access
Point and will allow any 802.11 client to connect to it. QoS capability and
Link Quality/Capacity indicators are not available in this mode.

ePTP Master: The Access Point is operating as a Master in point-to-point
mode. The AP does not support GPS Synchronization in this mode but is
able to provide significantly lower latency than other modes. QoS (MIR and
traffic priority) capability and Link Quality/Capacity indicators are not
available in this mode.

TDD PTP: The Access Point is operating in point-to-point (PTP) mode using
TDD scheduling. The AP is able to GPS synchronize in this mode (except
when in Flexible mode).

Point-to-Point

First Subscriber Module: The system is configured to accept only the 1*
registered SM. Network entry is denied for all subsequent SM network

Access
entry requests.
MAC Filtering: The system is configured to accept only one SM
registration, and this registration is limited by SM MAC Address (the SM
Wireless MAC Address).

Subscriber Configure the Wireless MAC Address of the sole SM which is granted

Module Wireless
MAC

registration to the AP. All other network entry attempts are rejected by the
AP. The SM’s Preferred AP List may be configured with the destination
point-to-point AP to ensure that the SM connects with the intended AP.

Country From the drop-down list, select the country in which the radio is operating.
Country Code settings affect the radios in the following ways:
¢ Maximum transmit power limiting (based on radio transmitter power
plus configured antenna gain)
e DFS operation is enabled based on the configured country code, if
applicable
e Frequency selection limiting, based on regional limitations
Range Unit Miles: The Max Range setting and resulting frame calculations are
configured in units of miles.
Kilometers: The Kilometers setting and resulting frame calculations are
configured in units of kilometers.
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Attribute

Meaning

Access Point Configuration

SSID

The AP SSID is used to identify the AP and is used to configure the SM with
the appropriate AP with which to register. Ensure that this parameter is
configured uniquely for each AP in the network.

Max Registrations
Allowed

Based on sector/network planning and SM service level implementations,
this parameter allows the user to set the maximum number of SMs that are
allowed to register/network entry. The maximum number of SMs allowed
for each channel bandwidth is as follows:

20/40 MHz : 120 subscribers
10 MHz : 60 subscribers

5 MHz: 30 subscribers
Default value is 60.

For DFS regions, the max number of SMs will be limited based on the
channel bandwidth of the current operating channel, i.e. Frequency Carrier,
Alternate Frequency Carrier 1 or Alternate Frequency Carrier 2.

Max Range

Enter a number of miles or kilometers for the furthest distance from which
an SM is allowed to register to this AP. Do not set the distance to any
greater number of miles. A greater distance:

e does not increase the power of transmission from the AP.
e can reduce aggregate throughput.

Regardless of this distance, the SM must meet the minimum requirements
for an acceptable link. The AP will reject any SM network entry attempts
from outside the configured maximum range. Default value is 3 miles.

WLAN

When the Access Point Mode is set to Standard WiFi, configure this
parameter:

Enabled: The ePMP AP operates as WLAN device and allows any 802.11
client to connect to it within a 100 meter radius.

Disabled: The ePMP AP operates in Standard WiFi mode to allow outdoor
802.11n clients to connect to it at longer distances and is typically used to
migrate non-Cambium SMs to ePMP SMs.

Automatic
Channel Selection

Enabled - This enables the Automatic Channel Selection (ACS) feature. ACS
allows the radio to scan the entire band (governed by the Country setting)
and chooses a channel with the lowest channel occupancy i.e. lowest
interference level. To run the ACS feature (once enabled), the radio will
have to be rebooted or manually triggered using Tools->Automatic Channel
Selection. When ACS is running, the radio measures the occupancy level of
the channel (measured in terms of an internal interference metric) and uses
an algorithm to make a decision to choose the best channel within the
band. The channel chosen is not based just on the occupancy level channel
but also the occupancy level of adjacent channels.
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Attribute

Meaning

Disabled — ACS is disabled and the operator should configure a Frequency
Carrier manually.

Ad Note

The channel bandwidth configured prior to enabling and running ACS will
be used to automatically select a channel. For ex: If the operator manually
configured a channel bandwidth of 20MHz, ACS will scan and choose a
channel of 20MHz wide channel. To switch ACS to 40MHz or other channel
bandwidth, the operator should disable ACS, manually configure 40MHz or
desired channel bandwidth on the radio, then enable and run ACS.

Channel
Bandwidth

Configure the channel size used by the radio for RF transmission. This value
must match between the AP and SMs.

Frequency Carrier

Configure the frequency carrier for RF transmission. This list is dynamically
adjusted to the regional restrictions based on the setting of the Country
Code parameter.

Frequency Reuse

The Frequency Reuse Mode parameter allows operators to define which
APs are co-located (or within radio range) with other APs. This definition
results in an automatic radio network modification such that self-
interference is reduced amongst the co-located sectors.

A network in which two frequencies “F1” and “F2" are reused throughout
the deployment in shown in Figure 35.

Figure 35 Frequency reuse deployment

F2

The set of APs to configure the Frequency Reuse Mode option on is
dependent on the GPS synchronization sources in the whole network,
CMM3, CMM4 or “onboard GPS” (GUI options are: GPS or CMM).
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Attribute Meaning
The GPS sync source is the same on all APs or is a combination of
“onboard GPS" and CMM4
In this configuration the GPS synchronization source in the whole network
is one of the following:

1- “onboard GPS” or

2- CMM4 or

3- CMM3 or

4- Mix of “onboard GPS” and CMM4 (but NOT CMM3)

For instructions on how to configure Frequency Reuse Mode to ensure that
interference is reduced throughout the deployment, see Figure 36.
Figure 36 Frequency reuse configuration example
¥
FR: Back
A\
FR: Back Q&"
F2 A &R
The rules in selecting the APs to enabling the Frequency Reuse Mode in
this deployment are:

1-  Only ONE of the APs on the same tower configured with the same
frequency must be configured with the Frequency Reuse Mode
parameter set to Frequency-Reuse-Back; the other AP must be
configured with Frequency Reuse Mode set to Frequency-Reuse-
Front.

Also, APs on different towers facing each other with overlapped
coverage must be configured with Frequency Reuse Mode set to
Frequency-Reuse-Back.
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Attribute Meaning

The GPS sync source is a mixture of all types (CMM3, CMM4 &
“onboard GPS”)

In this configuration the GPS sync source in the whole network is one of
the following:
1- (CMM3 and “onboard GPS") or

2- (CMM3 and CMM4) or

3- (CMM3 and CMM4 and “onboard GPS”)

For more examples of which APs to enable the Frequency Reuse Mode
feature in this mixture of sync sources, see Figure 37 and Figure 38

Figure 37 Example 1 - Frequency reuse configuration, mixture of GPS
synchronization sources

SYNC Source = GPS/CMM4

SYNC Source = GPS/CMM4

‘ SYNC Source = CMM3 ‘ ‘ SYNC Source = GPS/CMM4 ‘ ‘ SYNC Source = CMM3
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Figure 38 Example 2 - Frequency Reuse Configuration with Mixture of GPS

sources

SYNC Source = GPS/CMM4

SYNC Source = GPS/CMM4

SYNC Source = GPS/CMM4 ‘ ‘ SYNC Source = CMM3 ‘ ‘ SYNC Source = CMM3

The rules in selecting the APs to configure Frequency Reuse Mode to
Frequency Reuse Mode to Frequency-Reuse-Front or Frequency-Reuse-
Back in a mixture of sync sources deployments are:

1-  Only ONE of the APs on the same tower configured with the same
frequency must have Frequency Reuse Mode set to Frequency-
Reuse-Back if the sync source of both APs is the same or the sync is
a combination of “onboard GPS” and CMM4; the other AP will
have the Frequency-Reuse-Front ON.

2- For the APs on different towers facing each other with overlapped
coverage:

a. If both APs have the same sync source then only ONE of
them must have the Frequency-Reuse-Back ON; the other
AP shall have the Frequency-Reuse-Front ON.

b. If one AP has “onboard GPS” as sync source and the other
one has CMM4 then only ONE of them must have
Frequency-Reuse - Back ON; the other AP shall have
Frequency-Reuse-Front ON.

c. Ifone AP has “onboard GPS” or CMM4 as sync source and
the other one has CMM3 then:
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i. If the AP with CMM3 sync source has Frequency-
Reuse-Back ON, then the other AP (with “onboard
GPS” or CMM4 sync source) must have the
Frequency-Reuse-Back ON.
ii. If the AP with CMM3 sync source has Frequency
Reuse Mode set to Off, then the other AP (with
“onboard GPS” or CMM4 sync source) must have
Frequency Reuse Mode set to Off.
Alternate Configure the first channel bandwidth configuration that will be used for
Frequency Carrier  RF transmission if DFS detection causes the radio to switch from using the
1 Channel channel bandwidth configured in Channel Bandwidth.
Bandwidth
Alternate Configure the first frequency that will be used for RF transmission if DFS

Frequency Carrier
1

detection causes the radio to switch from using the frequency configured
in Frequency Carrier. It is important to set this frequency also in the SM
Scan List.

Alternate Configure the second channel bandwidth configuration that will be used
Frequency Carrier  for RF transmission if DFS detection causes the radio to switch from using
2 Channel the channel bandwidth configured in Channel Bandwidth.

Bandwidth

Alternate Configure the second frequency that is used for RF transmission if DFS

Frequency Carrier
2

detection causes the radio to switch from using the frequencies configured
in Frequency Carrier and DFS Alternate Frequency Carrier 1. It is important
to set this frequency also in the SM Scan List.

Power Control

Transmitter
Output Power

This value represents the combined power of the AP’s two transmitters.
This value may be automatically adjusted based on the configuration of the
parameter Country.

Nations and regions may regulate transmitter output power. For example

e 2.4 GHz and 5 GHz modules are available as connectorized radios,
which require the operator to adjust power to ensure regulatory
compliance.

The professional installer of the equipment has the responsibility to

e maintain awareness of applicable regulations.

e calculate the permissible transmitter output power for the module.

¢ confirm that the initial power setting is compliant with national or
regional regulations

e confirm that the power setting is compliant following any reset of the
module to factory defaults.
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Attribute

Meaning

Antenna Gain

This value represents the amount of gain introduced by an external
antenna (minus cable loss). This value is used in calculating the unit’s
Equivalent Isotropic Radiated Power (EIRP) level. For certain Country Code
configurations, the unit’s EIRP may be limited based on regional
regulations.

Subscriber Module
Target Receive
Level

Each SM's transmitter output power is automatically set by the AP. The AP
monitors the received power from each SM and adjusts each SM'’s
transmitter output power so that the received power at the AP from the SM
is not greater than what is configured in SM Target Received Power Level.
These automatic power adjustments ensure that the SM is not transmitting
excessive energy (raising system noise level) and that the SM is able to
achieve an optimal modulation state (and maximum achievable
throughput).

Nominally, target receive levels must be set lesser than -60 dBm in order to
prevent interference from co-located co-channel sectors.

Uplink Antenna
Selection

Uplink Antenna Selection specifies the antenna to be used in the uplink.
This parameter is specific to ePMP 2000 APs with optional Smart Antenna.

Auto: The AP decides which antenna to use (sector or Smart Antenna) for
uplink communications based on internal quality metrics.

Forced Sector Antenna: The AP uses the Sector Antenna for all SM uplink
communications.

Forced Smart Antenna: The AP uses the smart antenna for all SM uplink
communications.

A Note

If the AP is configured with Uplink Antenna Selection set to Auto and an
SM is set to Forced Sector Antenna or Forced Smart Antenna, the SM
setting will be enforced.

If the AP is configured with Uplink Antenna Selection set to Forced
Sector Antenna or Forced Smart Antenna and a SM is set to a conflicting
Forced setting, the AP’s setting will be enforced.

Scheduler

Downlink/Uplink
Ratio

Configure the schedule of downlink traffic to uplink traffic on the radio link.
The first three options, 75/25, 50/50 and 30/70, allow the radio to operate in
a fixed ratio on every frame. In other words, this ratio represents the
amount of the total radio link’s aggregate throughput that will be used for
downlink resources, and the amount of the total radio link’s aggregate
throughput that will be used for uplink resources. The fourth option,
Flexible, allows the radio to dynamically choose the amount of the total
radio’s aggregate throughput that is used for downlink and uplink
resources, every frame.
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Meaning

A Caution

Setting this parameter to Flexible causes the radio to operate in
unsynchronized mode. For all other settings, if the AP is in a cluster or is in
range of another AP, then you must set this parameter on all other APs in
the cluster and in range exactly the same. Otherwise, overlapping RF
transmissions will introduce system interference.

Frame Size

Configure the frame size for use when in TDD or TDD PTP mode. 2.5 ms
frame size allows for co-location (Synchronization) with PMP 100 series of
radios. It provides lower latency than 5 ms frame with approximately 10%
lower throughput. Frame size is irrelevant when the Downlink/Uplink Ratio
is set to Flexible. Please refer to the “ePMP and PMP 100 Co-location and
Migration Recommendations Guide” for guidance on synchronizing ePMP
and PMP 100.

Downlink Max
Rate

Configure the MCS (Modulation and Coding Scheme) rate beyond which
the radio’s scheduler should not exceed when transmitting data traffic on
the downlink. This is useful in situations where there is high variance and
unpredictability in the interference present in the environment causing
packet loss. Reducing the max rate to a lower MCS (than the default MCS
15) may help in these situations. Reducing the Downlink Max Rate will
result in reduced sector capacity. Not available when AP is an ePTP Master
or Standard WiFi.

Management
Traffic Rate

MCSO0: The system is configured to use MCSO rate for all management
messages. This allows for improved link stability and range in high
interference environment.

MCS1: The system is configured to use MCS1 rate for all management
messages. This allows for slightly higher sector throughput. This is the
default setting.

Synchronization

Co-location Mode

Disabled: The ePMP device is able to synchronize only with other ePMP
Access Points.

Enabled: The ePMP device can be configured to synchronize with PMP 100
series of radios in addition to other ePMP Access Points. Please refer to
the “ePMP and PMP 100 Co-location and Migration Recommendations
Guide” for guidance on synchronizing ePMP and PMP 100.

Synchronization
Source

GPS: Synchronization timing is received via the AP’s connected GPS
antenna. Co-located or in-range APs receiving synchronization via GPS or
CMM transmits and receives at the same time, thereby reducing self-
interference.
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Attribute Meaning

CMMS3 and CMM4: Synchronization timing is received via the AP’s
Ethernet port via a connected Cambium Cluster Management Module
(CMM). Co-located or in-range APs receiving synchronization via GPS or
CMM will transmit and receive at the same time, thereby reducing self-
interference. For more information on CMM configuration, refer to the PMP
Synchronization Solutions User Guide.

Internal: Synchronization timing is generated by the AP and the timing is
not based on GPS pulses.

,/.\\ .

~~+Caution

If a CMM is being used, verify that the cables from the CMM to the network
switch are at most 30 ft (shielded) or 10 Ft (unshielded) and that the
network switch is not PoE (802.3af).

APs using Synchronization Source of Internal will not transmit and receive
in sync with other co-located or in-range APs, which introduces self-
interference into the system.

Synchronization Configure the Synchronization source of the co-located PMP 100 Access
Source of Co- Point.
located System GPS: The co-located PMP 100 AP receives synchronization timing via the

Cambium UGPS (Universal Global Positioning System) module. Co-located
or in-range ePMP APs receiving synchronization via GPS or CMM transmits
and receives at the same time, thereby reducing self-interference.

CMMS3 and CMM4: The co-located PMP 100 AP receives synchronization
timing its Ethernet port via a connected Cambium Cluster Management
Module (CMM). Co-located or in-range ePMP APs receiving
synchronization via GPS or CMM will transmit and receive at the same
time, thereby reducing self-interference. For more information on CMM
configuration, refer to the PMP Synchronization Solutions User Guide.
Please refer to the ePMP and PMP 100 Co-location and Migration
Recommendations Guide for guidance on synchronizing ePMP and PMP

100.
Synchronization The Synchronization Holdoff Time is designed to gracefully handle
Holdoff Time fluctuations/losses in the GPS synchronization signaling. After the AP has

received a reliable synchronization pulse for at least 60 seconds, if there is
a loss of synchronization signal, the Synchronization Holdoff timer is
started. During the holdoff interval, all SM registrations are maintained. If
a valid GPS synchronization pulse is regained during the holdoff interval,
then the AP continues to operate normally. If a valid synchronization pulse
is not regained from the GPS source during the holdoff interval, then the
AP ceases radio transmission. Default is 30 seconds.
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Advanced

RTS/CTS (Request to Send / Clear to Send) is the optional mechanism used
by the 802.11 (Standard WiFi) wireless networking protocol to reduce
frame collisions introduced by the problem known as hidden node
problem. Under this mechanism, specific RTS, CTS and ACK
(Acknowledgement) frames are exchanged between the AP and SM to
schedule transmission of packets over the wireless link. The ability to use
this mechanism is available when Access Point Mode is configured as
Standard WiFi.

Downlink CTS

This parameter applies to CTS mechanism for downlink data transmission.
Disabled: The AP does not wait for a CTS frame from the SM/Client before
it sends downlink data.

Enabled: The AP simulates a CTS frame sent to itself notifying the SMs
connected to it that it is going to transmits data on the downlink.

Uplink CTS/RTS

This parameter applies to RTS/CTS mechanism for uplink data
transmission. When Enabled, SM/Client must send an RTS frame and, only
upon receiving a CTS frame from the AP can it transmit uplink data.

RTS Threshold

Configure the RTS packet size threshold for downlink data transmission.
Range is between 0-2347 octets. Typically, sending RTS/CTS frames does
not occur unless the packet size exceeds this threshold. If the packet size
that the node wants to transmit is larger than the threshold, the RTS/CTS
handshake gets triggered. Otherwise, the data frame gets sent
immediately.
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AP Quality of Service page

The ePMP platform supports three QoS priority levels (not available in ePTP Master mode) using
air fairness, priority-based starvation avoidance scheduling algorithm.

Ordering of traffic amongst the priority levels is based on a percentage of total link throughput. In
other words, all priorities receive some throughput so that low priority traffic is not starved from
transmission. In effect, the greatest amount of throughput is guaranteed to the VOIP priority level,
then High, then Low.

Priority Level ePMP Traffic Priority Label

Highest Priority VOIP (only utilized when VOIP Enable is set to Enabled)
Medium Priority High

Lowest Priority Low

By default, all traffic passed over the air interface is low priority. The AP’s Quality of Service page
may be utilized to map traffic to certain priority levels using QoS classification rules. The rules
included in the table are enforced starting with the first row of the table.

A Caution

Each additional traffic classification rule increases device CPU utilization. Careful network
traffic planning is required to efficiently use the device processor.

The ePMP platform also supports radio data rate limiting (Maximum Information Rate, or MIR)
based on the configuration of the MIR table. Operators may add up to 16 MIR profiles on the AP,
each with unique limits for uplink and downlink data rates. The SM field MIR Profile Setting is used
to configure the appropriate MIR profile for limiting the SM's data rate.

Figure 39 AP Quality of Service page

(@ Cambium Networks | oyp2000_d1zabs ‘ Access Point [ B | & Administrator ~
A Home Configuration » Quality of Service
_45 Quick Start ©® Maximum Information Rate (MIR)

MIR Disabled ® Enabled

¢ Configuration-

= MIR Profiles Show Details
gy Radio
W% Quality of Service 0 defauls 100000 I - |
& system
-
s=a Networl
am Metwors Traffic Priority
@ Security O Traffic Priority Disabled ® Enabled
'“ Manitor- © VolP Pricrity Disabled ® Enabled
f Toals~ @ Broadcast Pricrity ® Low High
©® Multicast Pricrity ® Low High
Add Show Details
e - —— | — .
CoS 5 Voice
DsCp 46 Voice
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Table 78 AP Radio Configuration attributes

Attribute

Meaning

Maximum Information Rate (MIR)

MIR

Disabled: When disabled, RF transmission is only limited by the
capacity of the link (and any active QoS classification rules).

Enabled: When enabled, all downlink and uplink traffic is limited
based on the profiles configured in the MIR table.

MIR Profiles

The MIR (Maximum Information Rate) table is comprised of up to
sixteen profiles which, after configured, may be set on the SM to
employ a certain service level or data rate.

Number

Assign a profile number to each row in the AP MIR table. This profile
number is then set on each SM to limit data transfer rates based on
the operator’s configuration of the MIR table and its profiles.

Description

Assign a logical description for each service level. For example, a
tiered service-level provider may deploy service levels “Gold”,
“Silver” and “Bronze” or “20 Mbps”, “10 Mbps” and “5 Mbps” to
offer a clear description.

Downlink MIR (kbps)

Specify the downlink rate at which the AP is allowed to transmit for
this configured profile.

Uplink MIR (kbps)

Specify the uplink rate at which the AP is allowed to transmit for this
configured profile.

Traffic Priority

Traffic Priority

Disabled: No traffic prioritization is performed. All traffic is treated
with equal priority (low priority).

Enabled: Traffic prioritization is enabled and specific types of traffic
can be prioritized using the fields below.

VolIP Priority

Enabled: When enabled, two entries are automatically added to the
first and second rows of the QoS Classification Rules table, one with
Rule Type CoS (5) and one with Rule Type DSCP (46). The addition
of these rules ensures that VolP traffic passed over the radio
downlink is given highest priority. The CoS and DSCP values may be
modified to accommodate non-standard VolP equipment.

Disabled: When disabled, VolP traffic is scheduled normally along
with all other user data.

Broadcast Priority

Low Priority: All Broadcast traffic sent over the downlink is
prioritized as low priority and is delivered to the SM after scheduled
high priority and VolP traffic.

High Priority: All Broadcast traffic sent over the downlink is

prioritized as high priority and is scheduled for delivery to SMs
before low priority traffic but after VolP traffic.
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Multicast Priority

Low Priority: All Multicast traffic sent over the downlink is
prioritized as low priority, and will be delivered to the SM after
scheduled high priority and VolIP traffic.

High Priority: All Multicast traffic sent over the downlink is

prioritized as high priority and is scheduled for delivery to SMs
before low priority traffic but after VolP traffic.

QoS Classification Rules

The QoS Classification Rules table contains all of the rules enforced
by the device when passing traffic over the radio downlink. Traffic
passed through the device is matched against each rule in the table;
when a match is made the traffic is sent over the radio link using the
priority defined in column Traffic Priority.

Type

CoS: Class of Service; traffic prioritization is based on the 3-bit
header present in the 802.1Q VLAN-tagged Ethernet frame header in
the packet entering the AP’s Ethernet port.

VLAN ID: traffic prioritization is based on the VLAN ID of the packet
entering the AP’s Ethernet port.

EtherType: traffic prioritization is based on the two-octet Ethertype
field in the Ethernet frame entering the AP’s Ethernet port. The
Ethertype is used to identify the protocol of the data in the payload
of the Ethernet frame.

IP: traffic prioritization is based on the source and (or) destination IP
address of the packet entering the AP’s Ethernet port. A subnet mask
may be included to define a range of IP addresses to match.

MAC: traffic prioritization is based on the source and (or)
destination MAC address of the packet entering the AP’s Ethernet
port. A mask may be included to define a range of MAC addresses to
match. The mask is made up of a hex representation of a series of 1s
to start the mask and Os that end the mask. A 1 may not follow a 0.
Thus FF:FF:FF:FF:00:00 is allowed, but FF:00:FF:FF:FF:FF is not. The
MAC address is combined with the mask to define the range of
allowed MAC addresses.

Details

Represents the details of the Class of Service (CoS) present in the
packet entering the AP’s Ethernet port.

Priority

Represents the QOS classification rule priority.
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AP System page

The AP’s System page is used to configure system parameters, services, time settings, SNMP and

syslog.
Figure 40 AP System page

Cambium Networks

ePMP 2000

A Home Configuration » System

-f Quick Start

General

Device Name ePMP2000_d184b5

Q Configuration~
@ Radio @ Vebpage Auto Update * 5

Q08 Quality of Service

a=m Network
@ Security
Jf\- Manitor -
f Tools-

Network Time Protocol (NTP)

O IPAssignment @ Siatic O DHCP
@ Preferred NTP Server
© Akernate NTP Server

@ Time Zone (UTC) GMT - Greenwich Mean Time

Simple Network Management Protocol (SNMP)

© Read-Only Community String kreddum-123_234
0 Read-Write Community String kreddum-123_234
System Name kreddum
System Description kreddum
Traps Disabled @ Enabled

@ Trap Community String kreddumtrap

T T

Table is empry

Trap Servers

cnMaestro

O Remote

agement
© cnliaestro URL
© Cambium ID

© Onboarding Key

© Account Management

Administrator Account Disabled © Enabled
Username admin
Password

Home User Account Disabled ® Enabled
Username home
Password

© 2016 Cambium Networks, All Rights Reserved | Version 3.1 |

sec | min: 2 | max: 20

@ Web Access

O HTTP Port

@ SSH Access

© Telnet Access

O MACTelnet Access

© MACTelnet Protocal

© Location Services
On-beard GPS Latitude

On-beard GPS Longitude

On-board GPS Height

v Use GPS Coordinates
Device Latitude

Device Lengitude

Device Height

Device Location

@ System Logging (Syslog)
Server 1
Server 2
Server 2
Serverd

O Syslog Mask

https://qa.cloud.cambiumnetworks.com

min: 1 | max: 65535
Disabled ® Enabled
® Disabled Enabled
Disabled ® Enabled

® MACTelnet MAC-S5H

42.05337 degrees

-088.02551 degrees

241.3 meters
12.90 degrees | min: -90 | max: 90
77.88 degrees | min:-180 | max: 180

meters | mir: -20000 | max: 20000

S

@
Installer Account Disabled ® Enabled
Username nstaller
® Password ®
Read-Only Acceunt Disabled ® Enabled
Username readonly
@ Password EE @

Suppert | Community Forum

026v003



PMP

CAMBIUM NETWORKS

Table 79 AP System attributes

Attribute

Meaning

General

Device Name

Specifies the name of the AP.

Webpage Auto
Update

Configure the interval for which the device retrieves system statistics for
display on the management interface. For example, if this setting is
configured to b5 seconds, the statistics and status parameters displayed
on the management interface will be refreshed every 5 seconds
(default). Webpage Auto Update is a session only configuration change.
It is updated with the <Enter> key and is not savable when using the
save button.

Web Access

HTTP: Access to the device management GUI is conducted via HTTP.
HTTPS: Access to the device management GUI is conducted via HTTPS.

HTTP Port

If Web Service is set to HTTP, configure the port which the device uses
to service incoming HTTP requests for management GUI access.

HTTPS Port

If Web Service is set to HTTPS, configure the port which the device uses
to service incoming HTTPS requests for management GUI access.

SSH Access

Disabled: If the SSH port to the device is ‘Disabled’, access to the device
through SSH is not possible.

Enabled: If the SSH port to the device is ‘Enabled’, Cambium engineers
can access the device through SSH which enables them to login to the
radio and troubleshoot. SSH port is ‘Enabled’ by default.

Telnet Access

Disabled: CLI access via telnet is not allowed for the device.
Enabled: CLI access via telnet is allowed for the device.

MAC-Telnet Access

Disabled: Disables connections to the radio on the link layer via MAC
address from RouterOS or mactelnet-enabled devices.

Enabled: Enables connections to the radio on the link layer via MAC
address from RouterOS or mactelnet-enabled devices.

Ad Note

In order to use MAC-Telnet the first time, the Administrator
account password must be changed on the GUI or the CLI. This
password can then be used for MAC-Telnet.

MAC-Telnet Protocol

MAC-Telnet: Use the MAC-Telnet subservice for access
MAC-SSH: Use the secured MAC-SSH subservice for access

Network Time Protocol

IP Assignment

Static: The device retrieves NTP time data from the servers configured
in fields NTP Server IP Address.

DHCP: The device retrieves NTP time data from the server IP issued via
a network DHCP server.

Preferred NTP Server

Configure the primary NTP server IP addresses from which the device
will retrieve time and date information.
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Attribute

Meaning

Alternate NTP Server

Configure an alternate or secondary NTP server IP addresses from which
the device retrieves time and date information.

Time Zone

The Time Zone option may be used to offset the received NTP time to
match the operator’s local time zone.

Location Services

On-board GPS
Latitude

On a GPS Synchronized ePMP radio, the field is automatically populated
with the Latitude information from the on-board GPS chip.

On-board GPS
Longitude

On a GPS Synchronized ePMP radio, the field is automatically populated
with the Longitude information from the on-board GPS chip.

On-board GPS Height

On a GPS Synchronized ePMP radio, the field is automatically populated
with the Height above sea level information from the on-board GPS
chip.

Use GPS Coordinates

On a GPS Synchronized ePMP radio, the Device coordinates can be
populated using the information retrieved from the on-board GPS chip.

. Update . . .
Click the poat button to automatically populate the Device Latitude

and Device Longitude fields using the coordinates provided by the on-
board GPS chip.

Device Latitude

Configure Latitude information for the device in decimal format.

Device Longitude

Configure Longitude information for the device in decimal format.

Device Height

Configure height above sea level for the device in meters.

Device Location

Hyperlink to display the device location in Google Maps

Simple Network Management Protocol (SNMP)

Read-Only
Community String

Specify a control string that can allow a Network Management Station
(NMS) such as the Cambium Networks Services Server (CNSS) to read
SNMP information. No spaces are allowed in this string. This password
will never authenticate an SNMP user or an NMS to read/write access.

The Read-only Community String value is clear text and is readable by a
packet monitor.

Read-Write
Community String

Specify a control string that can allow a Network Management Station
(NMS) to access SNMP information. No spaces are allowed in this
string.

System Name

Specify a string to associate with the physical module. This parameter
can be polled by the Cambium Networks Services Server (CNSS) or an
NMS. Special characters are supported.

System Description

Specify a description string to associate with the physical module. This
parameter can be polled by the Cambium Networks Services Server
(CNSS) or an NMS. Special characters are supported.
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Attribute

Meaning

Traps

Disabled: SNMP traps for system events are not sent from the device.

Enabled: SNMP traps for system events are sent to the servers
configured in table Trap Servers.

Trap Community
String

Configure a SNMP Trap Community String which is processed by the
servers configured in Trap Servers. This string is used by the trap server
to decide whether or not to process the traps incoming from the device
(i.e. for traps to successfully be received by the trap server, the
community string must match).

Trap Servers

The Trap Servers table is used to configure trap destinations for SNMP
traps generated by the device.

Server IP

Configure the IP address of each SNMP trap server target.

Server Port

Configure the port to which SNMP traps are sent from the ePMP device.

System Logging (Syslog)

Server 1-4

Specify up to four syslog servers to which the device sends syslog
messages.

SysLog Mask

Configure the levels of syslog messages which the devices send to the
servers configured in parameters Server IP 1-4.

M
&3 Caution
Choose only the syslog levels appropriate for your deployment.

Excessive logging can cause the device log file to fill and begin
overwriting previous entries.

cnMaestro

Remote Management

When Enabled, the device will be managed by cnMaestro - the Cambium
Remote Management System, which allows all Cambium devices to be
managed in the cloud.

cnMaestro URL

Configure the URL of cnMaestro. The default value is
https://cloud.cambiumnetworks.com.

Cambium-ID

Configure the Cambium ID that the device will use for on-boarding on to
cnMaestro.

Onboarding key

Configure the password/key associated with the Cambium-ID that the
device will use for on-boarding on to cnMaestro.

Account Management
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Attribute

Meaning

(Administrator)
Username

Read-only listing of available login levels.
e ADMINISTRATOR, full read write permissions.

e INSTALLER, permissions to read and write parameters applicable to
unit installation and monitoring.

e HOME, permissions only to access pertinent information for support
purposes.

e READONLY has permission to only view the Monitor page.

(Administrator)
Password

Configure a custom password for Administrator account. The password

character display may be toggled using the visibility icon

Installer Account

Disabled: The disabled user is not granted access to the device
management interface. The administrator user level cannot be disabled.

Enabled: The user is granted access to the device management
interface.

(Installer) Username

Provide the ‘Installer Username’ in this box.

(Installer) Password

Configure a custom password to secure the device. Only ‘Administrator’
account can override this password. The password character display

may be toggled using the visibility icon

Home User Account

Disabled: The disabled user is not granted access to the device
management interface.

Enabled: The user is granted access to the device management interface

(Home) User
Username

Provide the Home User ‘Username’ in this box.

(Home) User
Password

Configure a custom password to secure the device in order access
pertinent information for support purpose only. The password character

display may be toggled using the visibility icon

Read-Only Account

Disabled: The disabled user is not granted access to the device
management interface, even on a ‘Read-Only’ access.

Enabled: The user is granted ‘Read-Only’ access to the device
management interface.

(Read-Only) Provide the Read-Only ‘Username’ in this box.
Username
(Read-Only) Provide the password that can be used for ‘Read-Only’ access. Password
assword character display may be toggled using the visibility icon
026v003 144



cPMP CAMBIUM NETWORKS

AP Network page

The AP’s Network page is used to configure system networking parameters and VLAN parameters.

Figure 41 AP Network page
@ Cambium Networks | pMP1000 coBed | Access Point n “ & Administrator -

A& Home Configuration » Network

_8’- Quick Start General @ Virtual Local Area Network (VLAN)
. N IP Assignment ® Sratic DHCP © Manzgement VLAN ® Disabled Enabled

Q Configuration -~

= Q 1P Address 192.168.2.200 VLAN ID min: 1 | max: 4094

W) Radio

Subnet Mask 255.255.255.0 VLAN Priarity min: 0 | max:7
Q08 Quality of Service
Gateway 192.168.2.1

B system
Preferred DNS Server 8.8.8.8
m Alternate DNS Server
' IPv6 Assignment Static ® DHCPVG

|PvE Address

o Tools- 1Pv6 Gateway

Ethernet Port
© Ethernet MTU 1500 bytes | min: 576 | max: 1700
© Port Setting Manual ® Auto-Negotiate
Broadcast/Multicast Traffic Shaping Advanced
Broadeast Packet Limit ® Disabled Enabled © Pv6 Support Dissbled ® Enabled
Broadcast Packet Rate 200 pps | min: 100 | max: 16000 [i] Spanning Tree Protocal ® Disabled Enabled
@ Relisble Multicast ® Disabled Enabled © Management Access ® Ethernet Ethernet And Wireless
@ IGMPv2 Fast Leave Suppart Disabled Enabled SM Traffic Isolation ® Disabled Enabled

DHCP Option 82 ® Disabled Enabled
LLDP Dissbled ® Enabled

LLDP Mode ® Receive and Transmit Receive only

® 2017 Cambium Metwarks, All Rights Reserved | Version 3.3-RC14 | Support | Community Forum

Table 80 AP Network attributes

Attribute Meaning

General

IP Assignment Static: Device management IP addressing is configured manually in
fields Device IP Address (LAN), IP Subnet Mask (LAN), Gateway IP
Address (LAN) and DNS Server IP Address (LAN).

DHCP: Device management IP addressing (IP address, subnet mask,
gateway, and DNS server) is assigned via a network DHCP server, and
parameters Device IP Address (LAN), IP Subnet Mask (LAN), Gateway IP
Address (LAN), and DNS Server IP Address (LAN) are unused.
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Attribute

Meaning

IP Address

Internet protocol (IP) address. This address is used by the family of
Internet protocols to uniquely identify this unit on a network.

A Note

If Device IP address Mode is set to DHCP and the device is unable to
retrieve IP address information via DHCP, the device management IP is
set to fallback IP 192.168.0.1 (AP mode), 192.168.0.2 (SM mode),
192.168.0.3 (Spectrum Analyzer mode) or the previously-configured
static Device IP Address. Units may always be accessed via the
Ethernet port with IP 169.254.1.1.

Subnet Mask

Defines the address range of the connected IP network. For example, if
Device IP Address (LAN) is configured to 192.168.2.1 and IP Subnet
Mask (LAN) is configured to 255.255.255.0, the device will belong to
subnet 192.168.2.X.

Gateway

Configure the IP address of the device on the current network that acts
as a gateway. A gateway acts as an entrance and exit to packets from
and to other networks.

Preferred DNS Server

Configure the primary IP address of the server used for DNS resolution.

Alternate DNS Server

Configure the secondary IP address of the server used for DNS
resolution.

IPv6 Assignment

IPv6 Assignment specifies how the IPv6 address is obtained.

Static: Device management IP addressing is configured manually in
fields IPv6 Address and IPv6 Gateway.

DHCPv6: Device management IP addressing (IP address and gateway)
is assigned via a network DHCP server, and parameters IPv6 Address
and IPv6 Gateway are unused. If the DHCPV6 server is not available
previous static IPv6 address will be used as a fallback IPv6 address. If no
previous static IPv6 address is available, no IPv6 address will be
assigned. DHCPv6 will occur over the wireless interface by default.

IPv6 Address

Internet protocol version 6 (IPv6) address. This address is used by the
family of Internet protocols to uniquely identify this unit on a network.

IPv6 addresses are represented by eight groups of four hexadecimal
digits separated by colons.

IPv6 Gateway

Configure the IPv6 address of the device on the current network that
acts as a gateway. A gateway acts as an entrance and exit to packets
from and to other networks.

Virtual Local Area Network (VLAN)
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Attribute

Meaning

Management VLAN

Enabled: The AP management interface can be assigned to a
Management VLAN to separate management traffic (remote module
management via SNMP or HTTP) from user traffic (such as internet
browsing, voice, or video. Once the management interface is enabled
for a VLAN, an AP’'s management interface can be accessed only by
packets tagged with a VLAN ID matching the management VLAN ID.

A VLAN configuration establishes a logical group within the network.
Each computer in the VLAN, regardless of initial or eventual physical
location, has access to the same data based on the VLAN architecture.
For the network operator, this provides flexibility in network
segmentation, simpler management and enhanced security.

Disabled: When disabled, all IP management traffic is allowed to the
device.

VLAN ID

Configure this parameter to include the device’s management traffic on
a separate VLAN network. For example, if MGMT VLAN ID is set to 2,
GUI access will only be allowed from IP packets tagged with VLAN ID 2.

VLAN Priority

ePMP radios can prioritize VLAN traffic based on the eight priorities
described in the IEEE 802.1p specification. MGMT VLAN Priority
represents the VLAN Priority or Class of Service (CoS). Operators may
use this prioritization field to give precedence to device management
traffic.

This parameter only takes effect if the MGMT VLAN parameter is
enabled. Configure this parameter to set the value of the Priority code
point field in the 802.1q tag for traffic on the management VLAN
originating from the SM. The default value is 0.

Ethernet MTU

Maximum Transmission Unit; the size in bytes of the largest data unit
that the device is configured to process. Larger MTU configurations can
enable the network to operate with greater efficiency, but in the case of
retransmissions due to packet errors, efficiency is reduced since large
packets must be resent in the event of an error. Packets received by the
device larger than the configured MTU are dropped.

Port Setting

Manual: The LAN Ethernet port speed and duplex mode can be
manually configured.

Auto-Negotiate: The AP auto negotiates the LAN Ethernet port speed
and duplex mode with the device connected to it.

Port Speed

With “Ethernet Port Configuration” the LAN Ethernet port speed can be
forced to 1000 Mbps, 100 Mbps or 10 Mbps.

Port Duplex Mode

With “Ethernet Port Configuration” the LAN Ethernet port duplex mode
can be forced into Full or Half.

Broadcast/Multicast Traffic Shaping
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Attribute

Meaning

Broadcast Packet
Limit

Enabled: This allows the user to set the Broadcast Packet Rate below.
Configure this parameter to limit the amount of broadcast packets that
will be allowed on the ingress of the radio’s Ethernet port. Set the
packets per second value to limit the impact of events such as broadcast
storms.

Disabled: There is no limit on the amount of broadcast traffic that will
be allowed into the ingress of the radio’s Ethernet port.

Broadcast Packet
Rate

Set the packets per second value to limit the amount of broadcast traffic
that will be allowed on the ingress on the radio’s Ethernet port. The
packets per second limit can be set individually on each ePMP radio.
The range is 100 to 16000 packets per second. The default is 200.

Reliable Multicast

Enabled: This feature allows ePMP to support IGMP capable devices.
Once a multicast group is identified, the AP allows multicast traffic to be
sent only to the SMs within the multicast group. The SMs support up to
5 unique multicast groups. In addition, when this option is enabled, the
multicast traffic is sent to the SMs using the current Downlink MCS rate.

Disabled: ePMP will still support IGMP capable devices but the multicast
traffic will be sent using MCS 1 on the downlink to all SMs, regardless
of the multicast group.

IGMPv2 Fast Leave
Support

Disabled: AP will not drop any IGMPv2 Leave packets

Enabled: AP will drop/ignore IGMPv2 Leave packets from SMs if there
are other SMs downstream still subscribed to the IGMP group.

Advanced

IPv6 Support

Systemwide IPv6 Protocol Support. When enabled, appropriate IPv6
modules and services will be loaded.

Spanning Tree
Protocol

Disabled: When disabled, Spanning Tree Protocol (802.1d) functionality
is disabled at the AP.

Enabled: When enabled, Spanning Tree Protocol (802.1d) functionality
is enabled at the AP, allowing for prevention of Ethernet bridge loops.

Management Access

Ethernet: Only allow access to the AP’s web management interface via
a local Ethernet (LAN) connection. In this configuration, the AP’s web
management interface may not be accessed from over the air (i.e. from
a device situated below the SM).

Ethernet and Wireless: Allow access to the AP’s web management
interface via a local Ethernet (LAN) connection and from over the air (i.e.
from a device situated below the SM).

M

&3 Caution
APs configured with AP Management Access Interface set to LAN and
WLAN are susceptible to unauthorized access.

026v003

148



PMP

CAMBIUM NETWORKS

Attribute

Meaning

SM Traffic Isolation

Disabled: This is the default mode. When SM isolation is disabled, an
SM is able to communicate with another SM, when both the SM’s are
associated to the same Access Point (AP).

Enabled: When SM lIsolation feature is “Enabled”, SM#1 will not be able
to communicate with SM#2 (peer-to-peer traffic) when both the SM’s
are associated with the same Access Point (AP). This feature essentially
enables the AP to drop the packets to avoid peer-to-peer traffic scenario.

DHCP Option 82

Disabled: When ‘Disabled’, ePMP does not insert the "remote-id" (option
ID 0x2) and the "circuit-id" (ID 0x01). DHCP Option 82 is ‘Disabled’ by
default.

Enabled: ePMP inserts “remote-id” (option ID 0x2) to be the SM’s MAC
address and the “circuit-id” (ID 0x01) to be the AP’'s MAC address.
Those two fields are used to identify the remote device and connection
from which the DHCP request was received.

The Link Layer Discovery Protocol (LLDP) is a vendor-neutral link layer

LLDP
protocol (as specified in IEEE 802.1AB)I used by ePMP for advertising its
identity, capabilities, and neighbors on the Ethernet/wired interface.
Disabled: ePMP does not Receive or Transmit LLDP packets from/to its
neighbors.
Enabled: ePMP can Receive LLDP packets from its neighbors and Send
LLDP packets to its neighbors, depending on the LLDP Mode
configuration below.

A

A Note
LLDP packets are Received/Transmitted ONLY to the neighbors on the
Ethernet Interface of the ePMP radio.
Receive and Transmit: ePMP sends and receives LLDP packets to/from

LLDP Mode . . .
its neighbors on the Ethernet/LAN interface.
Receive Only: ePMP receives LLDP packets from its neighbors on the
Ethernet/LAN interface and discovers them.
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AP Security page

The AP’s Security page is used to configure system security features including SM authentication
and Layer2/Layer3 Firewall rules.

& Caution

If a device firewall rule is added with Action set to Deny and Interface set to LAN or WAN
and no other rule attribute are configured, the device will drop all Ethernet or wireless traffic,
respectively. Ensure that all firewall rules are specific to the type of traffic which must be
denied, and that no rules exist in the devices with only Action set to Deny and Interface set
to LAN or WAN. To regain access to the device, perform a factory default.

Figure 42 AP Security page
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Table 81 AP Security attributes

Attribute

Meaning

Security Options

Wireless Security

Open: All SMs requesting network entry are allowed registration.

WPA2: The WPA2 mechanism provides AES radio link encryption and
SM network entry authentication. When enabled, the SM must register
using the Authentication Pre-shared Key configured on the AP and SM.
RADIUS: Enables the connection to a pre-configured RADIUS server.

WPA2

WPA2 Pre-shared Key

Configure this key on the AP. Then configure each of the network SMs
with this key to complete the authentication configuration. This key
must be between 8 to 128 symbols.

RADIUS

Servers

For more Radio servers, click Add. Up to 3 Radius servers can be
configured on the device with the following attributes:

IP Address: IP Address of the Radius server on the network.
Port: The Radius server port. Default is 1812.

Secret: Secret key that is used to communicate with the Radius server.

Server Retries

Number of times the radio will retry authentication with the configured
Radius server before it fails authentication of the SM.

Server Timeout

Timeout between each retry with the configured Radius server before
it fails authentication of the SM.

GUI User
Authentication

This applies to both the AP and its registered SMs.

Device Local Only: The device’s GUI authentication is local to the
device using one of the accounts configured under Configuration-
>System->Account Management.

Remote RADIUS Server Only: The device’'s GUI authentication is
performed using a RADIUS server.

Remote RADIUS Server and Fallback to Local: The device’'s GUI
authentication is performed using a RADIUS server. Upon failure of
authentication through a RADIUS server, the authentication falls back
to one of the local accounts configured under Configuration->System-
>Account Management.

Firewalls

Layer 2 Firewall

Disabled: Modifications to the Layer 2 Firewall Table are not allowed
and rules are not enforced.

Enabled: Modifications to the Layer 2 Firewall Table are allowed and
rules are enforced.
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Attribute

Meaning

Firewall Rules

The Layer 2 firewall table may be used to configure rules matching
layer 2 (MAC layer) traffic which result in forwarding or dropping the
traffic over the radio link or Ethernet interface.

Layer 3 Firewall

Disabled: Modifications to the Layer 3 Firewall Table are not allowed
and rules are not enforced.

Enabled: Modifications to the Layer 3 Firewall Table are allowed and
rules are enforced.

Firewall Rules

The Layer 3 firewall table may be used to configure rules matching
layer 3 (IP layer) traffic which result in forwarding or dropping the
traffic over the radio link or Ethernet interface.

Wireless MAC Address Filtering

Wireless MAC Filter

Disabled: SMs with any MAC Address are allowed to register to the
AP.

Enabled: SMs with specific MAC address can be allowed (Permit) or
denied (Prevent) registration with the AP as configured under the MAC
Filter List.

Wireless MAC Filter
Policy

Prevent: All MAC Addresses configured under the MAC Filter List are
denied registration to the AP.

Permit: Only the MAC Addresses configured under the MAC Filter List
are allowed to register to the AP.

Wireless MAC Filter
List

Configure the SM’s MAC addresses that will be permitted or prevented
from registering to the AP.

MAC Address MAC Address of the SM
Description Friendly description to identify the SM
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AP MONITOR MENU

Use the Monitor menu to access device and network statistics and status information. This section
may be used to analyze and troubleshoot network performance and operation.

The Monitor menu contains the following pages:
e AP Performance page on page 154

e AP System page on page 158

e AP Wireless page on page 161

e AP Throughput Chart page on page 164

e AP GPS page on page 165

e AP Network page on page 167

e AP System Log page on page 170
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AP Performance page

Use the Performance page to monitor system status and statistics to analyze and troubleshoot

network performance and operation.

Figure 43 AP Performance page
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Table 82 AP Performance page attributes

Attribute

Meaning

Time Since Last Reset

Time since the stats were last reset.

Ethernet Statistics - Transmitted

Total Traffic

Total amount of traffic in Kbits transferred from the AP’s Ethernet
interface.

Total Packets

Total number of packets transferred from the AP’s Ethernet interface.

Packet Errors

Total number of packets transmitted out of the AP’s Ethernet interface
with errors due to collisions, CRC errors, or irregular packet size.

Packet Drops

Total number of packets dropped prior to sending out of the AP’s
Ethernet interface due to Ethernet setup or filtering issues.

Multicast/Broadcast
Traffic

Total amount of multicast and broadcast traffic in Kbits sent via the
AP’s Ethernet interface.

Broadcast Packets

Total number of broadcast packets sent via the AP’s Ethernet
interface.

Multicast Packets

Total number of multicast packets sent via the AP’s Ethernet interface.

Ethernet Statistics - Received

Total Traffic

Total amount of traffic in Kbits received by the AP’s Ethernet interface.

Total Packets

Total number of packets received by the AP’s Ethernet interface.

Packet Errors

Total number of packets received by the AP’s Ethernet interface with
errors due to collisions, CRC errors, or irregular packet size.

Packet Drops

Total number of packets dropped prior to sending out of the AP’s
wireless interface due to Ethernet setup or filtering issues.

Multicast/Broadcast
Traffic

Total amount of multicast and broadcast traffic in Kbits received by
the AP’s Ethernet interface.

Broadcast Packets

Total number of broadcast packets received via the AP’s Ethernet
interface.

Multicast Packets

Total number of multicast packets received via the AP’s Ethernet
interface.

Wireless Statistics — Downlink

Total Traffic

Total amount of traffic transmitted out of the AP’s wireless interface in
Kbits.

Total Packets

Total number of packets transmitted out of the AP’s wireless interface.

Error Drop Packets

Total number of packets dropped after transmitting out of the AP’s
Wireless interface due to RF errors (No acknowledgement and other
RF related packet error).
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Attribute

Meaning

Capacity Drop Packets

Total number of packets dropped after transmitting out of the AP’s
Wireless interface due to capacity issues (data buffer/queue overflow
or other performance or internal packet errors).

Retransmission Packets

Total number of packets re-transmitted after transmitting out of the
AP’s Wireless interface due to the packets not being received by the
SMs.

Multicast / Broadcast
Traffic

Total amount of multicast and broadcast traffic transmitted out of the
AP’s wireless interface in Kbits.

Broadcast Packets

Total number of broadcast packets transmitted out of the AP’s
wireless interface.

Multicast Packets

Total number of multicast packets transmitted out of the AP’s wireless
interface.

Wireless Statistics — Uplink

Total Traffic

Total amount of traffic received via the AP’s wireless interface in Kbits.

Total Packets

Total number of packets received via the AP’s wireless interface.

Error Drop Packets

Total number of packets dropped prior to sending out of the AP’s
Ethernet interface due to RF errors (packet integrity error and other RF
related packet error).

Multicast / Broadcast
Traffic

Total amount of multicast and broadcast traffic received on the AP’s
wireless interface in Kbits.

Broadcast packets

Total number of broadcast packets received on the AP’s wireless
interface.

Multicast Packets

Total number of multicast packets received on the AP’s wireless
interface.

System Statistics

Session Drops

Total number of SM sessions dropped on the AP.

Device Reboots

Total number of reboots of the AP.

Network Entry
Attempts

Total number of Network Entry Attempts by all the SMs on the AP.

Successful Network
Attempts

Total number of successful network entry attempts.

Network Entry

Authentication Failures

Total number of failed Network Entry Attempts by all the SMs on the
AP.

Radar (DFS) Detections

Total number of DFS events that were detected by the AP.

Subscriber Module Statistics

MAC Address

MAC Address of the SM connected to the AP.
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Attribute

Meaning

Total Uplink

Total amount of traffic received via the AP’s wireless interface from
this SM in Kbits.

Total Uplink Packets

Total number of packets received via the AP’s wireless interface from
this SM.

Uplink Packet Drops

Total number of packets dropped prior to sending out of the AP’s
Ethernet interface due to RF errors (packet integrity error and other RF
related packet error) from this SM.

Total Downlink

Total amount of traffic transmitted out of the AP’s wireless interface in
Kbits.

Total Downlink Packets

Total number of packets transmitted out of the AP’s wireless interface.

Downlink Packet Drops

Total number of packets dropped after transmitting out of the AP’s
Wireless interface due to RF errors (No acknowledgement and other
RF related packet error).

Downlink Capacity
Packet Drops

Total number of packets dropped after transmitting out of the AP’s
Wireless interface due to capacity issues (data buffer/queue overflow
or other performance or internal packet errors).

Downlink
Retransmitted Packets

Total number of packets re-transmitted after transmitting out of the
AP’s Wireless interface due to the packets not being received by the
SM.

Downlink Power

The transmit power of the AP for the downlink packets to the SM.

Downlink Packets per MCS

MCS 0 through
MCS 15

Number of packets (and percentage of total packets) transmitted out
of the AP’s wireless interface for every modulation mode used by the
AP’s transmitter, based on radio conditions.

Uplink Packets per MCS

MCS 0 through
MCS 15

Number of packets (and percentage of total packets) received on the
AP’s wireless interface for every modulation mode, based on radio
conditions.

Downlink Frame Time

Total Frame Time Used

Percentage of frame time used in the downlink.

Uplink Frame Time

Total Frame Time Used

Percentage of frame time used in the uplink.
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AP System page

Use the System Status page to reference key system information.

Figure 44 AP System Status page
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& 2016 Cambium Netwworks, All Rights Reserved | Version 3.1 | Support | Community Forum

Table 83 AP System Status page attributes

Attribute Meaning

Hardware Version Board hardware version information.

Serial Number Serial Number information.

(MSN)

Firmware Version U-Boot version information.

Software Version The currently operating version of software on the ePMP device.

(Active Bank)

Software Version The backup software version on the ePMP device, used upon failure of

(Inactive Bank) the active bank. Two software upgrades in sequence will update both
the Active Software Bank Version and the Inactive Software Bank
Version.

Device-Agent The operating version of the device agent, which is used for

Version communication with cnMaestro.
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Attribute

Meaning

Date and Time

Current date and time, subject to time zone offsets introduced by the
configuration of the device Time Zone parameter. Until a valid NTP
server is configured, this field will display the time configured from the
factory.

System Uptime

The total system uptime since the last device reset.

Wireless MAC The hardware address of the device wireless interface.
Address

Ethernet MAC The hardware address of the device LAN (Ethernet) interface.
Address

DFS Status N/A: DFS operation is not required for the region configured in

parameter Country Code.

Channel Availability Check: Prior to transmitting, the device must check
the configured Frequency Carrier for radar pulses for 60 seconds). If no
radar pulses are detected, the device transitions to state In-Service
Monitoring.

In-Service Monitoring: Radio is transmitting and receiving normally
while monitoring for radar pulses which require a channel move.

Radar Signal Detected: The receiver has detected a valid radar pulse and
is carrying out detect-and-avoid mechanisms (moving to an alternate
channel).

In-Service Monitoring at Alternative Channel: The radio has detected a
radar pulse and has moved operation to a frequency configured in DFS
Alternative Frequency Carrier 1 or DFS Alternative Frequency Carrier 2.

System Not In Service due to DFS: The radio has detected a radar pulse
and has failed channel availability checks on all alternative frequencies.
The non-occupancy time for the radio frequencies in which radar was
detected is 30 minutes.

Sync Source Status

Displays the current source (GPS, CMM or Internal) of sync timing for
the AP.

Read-Only Users

Displays the number of active Read-Only users logged into the radio.

Read-Write Users

Displays the number of active Read-Write users logged into the radio.

Factory Reset Via
Power Sequence

Enabled: When Enabled under Tools->Backup/Restore->Reset Via Power
Sequence, it is possible to reset the radio’s configuration to factory
defaults using the power cycle sequence explained under Resetting
ePMP to factory defaults by power cycling on page 184.

Disabled: When Disabled, it is not possible to factory default the radio’s
configuration using the power cycle sequence.
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Attribute Meaning
cnMaestro The current management status of the device with respect to the
Connection Status Cambium Cloud Server. When Enabled under Configuration->System,

the device will be managed by the Cambium Remote Management
System, which allows all Cambium devices to be managed from the
Cambium Cloud Server.

cnMaestro Account The ID that the device is currently using to be managed by the Cambium
ID Cloud Server.
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AP Wireless page

Use the Wireless Status page to reference key information about the radio’s wireless interface and

connected SMs.

Figure 45 AP Wireless Status page (ePMP 2000 - List View)
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Figure 46 AP Wireless Status page (ePMP 1000 — Detail View)
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Table 84 AP Wireless Status page attributes

Attribute

Meaning

Operating Frequency

The current frequency at which the AP is operating.

Operating Channel
Bandwidth

The current channel size at which the AP is transmitting and receiving.

Transmitter Output
Power

The current power level at which the AP is transmitting.

Device Initialization
Status

This field indicate the status of the device initialization. Values are
Successful and Error code for fail case. Please pay attention that in fail
case device cannot be used in operating mode due to major hardware
problem.

Registered
Subscriber Modules

The total number of SMs which are currently registered to the AP.

Ethernet Interface

Up: The Ethernet (LAN) interface is functioning properly.

Down: The Ethernet (LAN) interface has encountered an error and is not
servicing traffic.

Wireless Interface

Up: The radio (WAN) interface is functioning properly.

Down: The radio (WAN) interface has encountered an error and is not
servicing traffic.

Country

The current country code at which the AP is operating.

Registered
Subscriber Modules

Use the Registered Subscriber Modules table to monitor registered SMs,
their key RF status and statistics information.

Deregistar Clicking this button deregisters the SM from the AP
MAC Address The MAC address of the SM wireless interface.
IP Address The IPv4 address of the SM wireless interface.
IPv6 Address The IPv6 address of the SM wireless interface.

Device Name

Device Name of the SM

SM Distance (miles)

Distance of the SM from the AP

Session Time

Time duration for which the SM has been registered and in session with
the AP.

RSSI (dBm) Downlink
/ Uplink

Current receive signal strength of the AP at the SM, in the downlink and
the current receive signal strength of the SM at the AP, in the uplink. The
downlink RSSI is an estimation. For accurate downlink RSSI, please refer
to the SM’s Home page.

SNR (dB) Downlink /
Uplink

Current Signal-to-Noise of the SM in the downlink and uplink
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Attribute

Meaning

MCS Downlink /
Uplink

Current MCS at which the SM is operating on the downlink and uplink

Downlink Quality

The downlink quality based on the current MCS and PER (Packet Error
Rate) for this SM

Downlink Capacity

The downlink capacity based on the current DL MCS with respect to the
highest supported MCS (MCS15). Not available in ePTP Master mode.

MIR Profile

Current MIR profile assigned to this SM

“SERVER" indicates that the MIR values are assigned by the RADIUS
server

MIR Rate (kbps)
Downlink / Uplink

Current downlink and uplink MIR assigned to this SM in kbps

Antenna Selected

Indicates the antenna for which uplink communication is conducted,
Sector or Smart Antenna.

When Smart Antenna is displayed, an indicator of the angle (in degrees)
of the antenna pattern is also displayed. The V

value represents vertical polarity and the H value
represents horizontal polarity, both relative to boresight.
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AP Throughput Chart page

Use the Throughput page to reference a line chart visual representation of system throughput over
time. The blue line indicates downlink throughput and the orange line indicates uplink throughput.
The X-axis may be configured to display data over seconds, minutes, or hours, and the Y-axis is
adjusted automatically based on average throughput. Hover over data points to display details.

Figure 47 AP Throughput Chart page
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Table 85 AP Throughput Chart page attributes

Attribute Meaning

Throughput Adjust the X-axis to display throughput intervals in seconds, minutes, or
Measurement Period  hours.
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AP GPS page

Use the GPS Status page to reference key information about the radio’s configured GPS
coordinates.

Figure 48 AP GPS Status page
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Table 86 AP GPS Status page attributes

Attribute

Meaning

On-board GPS
Latitude

On a GPS Synchronized ePMP radio, the field is automatically populated
with the Device Latitude information from the on-board GPS chip.

On-board GPS
Longitude

On a GPS Synchronized ePMP radio, the field is automatically populated
with the Device Longitude information from the on-board GPS chip.

On-board GPS
Height

On a GPS Synchronized ePMP radio, the field is automatically populated
with the Device height above sea level from the on-board GPS chip.

GPS Time
(Greenwich Mean
Time)

On a GPS Synchronized ePMP radio, the field is automatically populated
with the time from the on-board GPS chip.

GPS Firmware
version

On a GPS Synchronized ePMP radio, the field indicates the current
firmware version of the on-board GPS chip.

Satellites Tracked

On a GPS Synchronized ePMP radio, the field indicates the number of
satellites current tracked by the on-board GPS chip.

Satellites Visible

On a GPS Synchronized ePMP radio, the field indicates the number of
satellites visible to the on-board GPS chip.

Satellites The Satellites table provides information about each satellite that is
visible or tracked along with the Satellite ID and Signal to Noise Ratio
(SNR) of the satellite.

ID Represents the Satellite ID.

Signal-to-Noise Ratio

This is an expression of the carrier signal quality with respect to signal
noise.

Status

Status of each Satellite available.
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AP Network page

Use the AP Network Status page to reference key information about the device network status.

Figure 49 AP Network Status page
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Table 87 AP Network Status page attributes

Attribute Meaning

Ethernet Status

IP Assignment Static: Device management IP addressing is configured manually in
fields Device IP Address (LAN), IP Subnet Mask (LAN), Gateway IP
Address (LAN) and DNS Server IP Address (LAN).

DHCP: Device management IP addressing (IP address, subnet mask,
gateway, and DNS server) is assigned via a network DHCP server, and
parameters Device IP Address (LAN), IP Subnet Mask (LAN), Gateway IP
Address (LAN), and DNS Server IP Address (LAN) are unused.

IP Address The current IP Address mode of the device (static or DHCP).

Subnet Mask The currently configured device IP subnet mask.
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Attribute

Meaning

IPv6 Link Local

A link-local address is required for the IPv6-enabled interface

Address (applications may rely on the link-local address even when there is no
IPv6 routing). The IPv6 link-local address is comparable to the auto-
configured IPv4 address 169.254.0.0/16.

IPv6 Address The IPv6 address for device management.

MTU Size The currently configured Maximum Transmission Unit for the AP’s

Ethernet (LAN) interface. Larger MTU configurations can enable the
network to operate with greater efficiency, but in the case of
retransmissions due to packet errors, efficiency is reduced since large
packets must be resent in the event of an error.

Ethernet Status

Up: The device Ethernet interface is functioning and passing data.

Down: The device Ethernet interface has encountered an error
disallowing full operation. Reset the device to reinitiate the Ethernet
interface.

Port Speed

The current Ethernet port speed of the radio.

Port Duplex Mode

The current Ethernet port duplex mode of the radio.

Wireless Status

Wireless Interface

Up: The device wireless interface is functioning and passing data

Down: The device wireless interface has encountered an error
disallowing full operation. Reset the device to reinitiate the wireless
interface.

IP address

Currently unused.

Subnet Mask

Currently unused.

Default Gateway

IP address that is currently assigned.

Network Status

DNS Server IP

Represents the IP address of the DNS Server.

DHCP Option 82

Enabled: ePMP inserts “remote-id” (option ID 0x2) to be SM’s MAC
address and the “circuit-id” (ID 0x01) to be the AP’'s MAC address.
Those two fields are used to identify the remote device and connection
where the DHCP request was received and DHCP server can assign IP
address accordingly.

Disabled: When ‘Disabled’, AP passes the bootP traffic unaffected. DHCP
Option 82 is ‘Disabled’ by default.

Multicast Status
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Attribute

Meaning

Multicast Processing

Displays the rate at which multicast traffic is sent on the downlink.

Multicast Using Fixed MCS: Multicast traffic is sent to the SMs on the
downlink at MCS 1.

Multicast Using Best MCS: Multicast traffic is converted to unicast and
sent to the SMs at the current MCS capability on the downlink.

Total Multicast
Groups

Displays the current number of multicast groups that the AP has
identified from IGMP devices connected to the registered SMs.

ARP Table

MAC Address MAC Address of the devices on the bridge.

IP Address IP Address of the devices on the bridge.

Interface Interface on which the AP identified the devices on.
Bridge Table

MAC address

The hardware address of the AP.

Port

The port to which the device is connected.

Subscriber Module
MAC

MAC Address for one of the connected SMs.

Aging Timer (secs)

Time set for the MAC addresses in the Bridge table.
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AP System Log page

Use the AP System Log page to view the device system log and to download the log file to the
accessing PC/device.

Figure 50 AP System Log page
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Table 88 AP System Log attributes

Attribute Meaning
Syslog Display Enabled: The system log file is displayed on the management GUI.
Disabled: The system log file is hidden on the management GUI.
Download Use this button to download the full system log file to a connected PC or
device.
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AP TOOLS MENU

The AP Tools menu provides several options for upgrading device software, configuration
backup/restore, analyzing RF spectrum, testing device throughput, and running ping and

traceroute tests.

AP Software Upgrade page on page 172

AP Backup/Restore page on page 174

AP License Management page on page 177

AP eDetect page on page 177

AP Spectrum Analyzer page on page 181

AP Automatic Channel Selection page on page 184
AP eAlign page on page 186

AP Wireless Link Test page on page 188

AP Ping page on page 189

AP Traceroute page on page 191
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AP Software Upgrade page

Use the AP Software Upgrade page to update the device radio software to take advantage of new
software features and improvements.

A Caution

Please read the Release Notes associated with each software release for special
notices, feature updates, resolved software issues, and known software issues.
The Release Notes may be accessed at the Cambium Support Center.

Figure 51 AP Software Upgrade page
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Table 89 AP Software Upgrade attributes

Attribute Meaning

Main Software

Software Version ePMP boards that do not have an onboard GPS have one bank of flash
memory which contains a version of software. The version of software
last upgraded onto the Flash memory is present on this bank of flash
memory. This software will be used by the AP when the AP is

rebooted.
Software Version ePMP boards that have an onboard GPShave two banks of flash
(Active Bank) memory which each contain a version of software. The version of

software last upgraded onto the Flash memory is made the Active
Bank. This software will be used by the AP when the AP is rebooted.
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Attribute

Meaning

Software Version
(Inactive Bank)

ePMP boards that have an onboard GPS have two banks of flash
memory which each contain a version of software. The version of
software that was the Active Bank is made the Inactive Bank when
another version of software is upgraded onto the Flash memory. The
Inactive Bank of software will be used by the SM in case the Active
Bank cannot be used due to a failure condition.

Firmware Version

The current U-Boot version.

Upgrade Options

URL: A webserver may be used to retrieve software upgrade packages
(downloaded to the device via the webserver). For example, if a
webserver is running at IP address 192.168.2.1 and the software
upgrade packages are located in the home directory, an operator may
select option From URL and configure the Software Upgrade Source
field to http://192.168.2.1/<software_upgrade_package>.

Local File: Click Browse to select the local file containing the software
upgrade package.

Select File

Click Browse to select a local file (located on the device accessing the
web management interface) for upgrading the device software.

GPS Firmware

Firmware Version

The current firmware of the on-board GPS chip (AXN_1.51_2801). After
upgrading, this version should show as AXN_1.51_2838.

Upgrade Options

URL: A webserver may be used to retrieve GPS firmware upgrade
packages (downloaded to the device via the webserver). For example, if a
webserver is running at IP address 192.168.2.1 and the firmware upgrade
packages are located in the home directory, an operator may select option
From URL and configure the GPS Firmware Upgrade Source field to
http://192.168.2.1/<firmware_upgrade_package>.

Local File: Click Browse to select the local file containing the GPS firmware
upgrade package.

RS Note

If the “GPS Firmware Version” under Monitor=>GPS Status shows “NOT
AVAILABLE"”, it means that the on-board GPS chip has locked up. A power
cycle of the ePMP unit is required to restore the connectivity to the chip
before performing the GPS firmware upgrade.

Select File Click Browse to select a local file (located on the device accessing the web
management interface) for upgrading the on-board GPS chip firmware.
A
Ad Note
Use the same package that is used to upgrade the device’s software. The
new GPS firmware is part of the software upgrade packages.
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To upg
Proced

1

rade the device software from a local file (or network-accessible file), follow this procedure:
ure:

Download the software upgrade packages from
https://support.cambiumnetworks.com/files/epmp

Clear the accessing browser cache

On the device GUI, navigate to Tools => Software Upgrade.

Select the Software Upgrade Source which represents the location of your software
upgrade packages

Based on the configuration of Software Upgrade Source, enter either the Software
Upgrade Source or click the Browse button and locate the software package

Click Upgrade

When the upgrade completes successfully, click the Reset icon

To upgrade the GPS firmware from a local file (or network-accessible file), follow this procedure:

Procedure:

1

Download the software upgrade packages from
https://support.cambiumnetworks.com/files/epmp

Clear the accessing browser cache
On the device GUI, navigate to Tools => Software Upgrade

Select the Upgrade Options under GPS Firmware which represents the location of your
software upgrade packages

Based on the configuration of GPS Firmware Source, enter either the Upgrade Source or
click the Browse button and locate the firmware package

Click Upgrade

When the upgrade completes successfully, click the Reset icon
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AP Backup/Restore page

Use the AP Backup/Restore page to perform the following functions:

e Back up the configuration in either text (.json) format or binary (.bin) format.

o Restore the configuration of using a configuration file that was previously backed up.

e Reset the device to its factory default configuration. For more factory defaulting methods, see:
o Using the device external reset button on page 300

o Resetting ePMP to factory defaults by power cycling on page 301

Figure 52 AP Backup / Restore page

(ﬁ. Cambium Networks

ePMP 2000 ePMP2000_d184b5 Access Point

A Home Tools » Backup / Restore
45 Quick Start Backup Configuration
Q Corfiguration Configuration File Formart ® Texr(Editable) Binary (Secured)

Jf\- Monitor -
f Tools~

.'5 Software Upgrade

oL Backup / Restore

=] License Management

Restore Configuration

Select File

W epetect Factory Default Configuration

wll. spectrum Analyzer © Reser Via Power Sequence Disabled @ Enabled

© Retain Passwords ® Disabled Enabled
(@3 Automatic Channel Selection ain Pessnor mane name

@ Keep Passwords =
("-"J Wireless Link Test

. @ Reset to Factory Defaults m
o ring
m Traceroute
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Table 90 AP Backup / Restore attributes

Attribute Meaning

Backup Configuration

Configuration File Text (Editable): Choosing this option will download the configuration file
Format in the .7 son format and can be viewed and/or edited using a standard
text editor.

Binary (Secured): Choosing this option will download the configuration
file in the .bin format and cannot be viewed and/or edited using an
editor. Use this format for a secure backup.
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Attribute

Meaning

Restore Configuration

Select File

Click Browse to select a local file (located on the device accessing the
web management interface) for restoring the device configuration.

Factory Default Configuration

Reset Via Power
Sequence

Enabled: When Enabled, it is possible to reset the radio’s configuration
to factory defaults using the power cycle sequence explained under
Resetting ePMP to factory defaults by power cycling on page 184.

Disabled: When Disabled, it is not possible to factory default the radio’s
configuration using the power cycle sequence.

Retain Passwords

When set to Enabled, then after a factory default of the radio for any
reason, the passwords used for GUI and CLI access will not be defaulted
and will remain unchanged. The default value of this field is Disabled.

/N

If the passwords cannot be retrieved after the factory default, access to
the radio will be lost/unrecoverable. This feature prevents unauthorized
users from gaining access to the radio for any reason, including theft.

Caution

Keep Licenses

When the Keep Licenses checkbox is selected, enacted functionality
licenses will be retained upon a factory default procedure.

Keep Passwords

When the Keep Passwords checkbox is selected, the passwords used for
GUI and CLI access will not be defaulted and will remain unchanged.
This is one-time option, and it does not apply to factory default
procedures completed by power cycling (Reset Via Power Sequence).

Reset to Factory
Defaults

Use this button to reset the device to its factory default configuration.

'\
[3- Caution
A reset to factory default configuration resets all device parameters.

With the SMs in default configuration it may not be able to register to an
AP configured for your network.
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AP License Management page

The AP License Management page may be used to enter a license key to convert a Lite AP (limited
to 10 connected SMs) to a Full AP (limited to platform capacity of 120).

Figure 53 AP License Management page

@ Cambium Nf;h:“l'fz"')'éﬁ ePMP2000_d184b5 ‘ PPt n & Administrator -

A& Home Tools » License Management

License Management

& quick start
Q Configuration~ 0 License Key

-*- Monitor -
f Tools~

é Software Upgrade

9% Backup / Restore

4} eDetect

ul. Spectrum Analyzer

@@H Automatic Channel Selection
(?) wireless Link Test

:1“; Ping

ﬂ Traceroute
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Table 91 AP License Management attributes

Attribute Meaning

License Key The "License Key" is obtained from support.cambiumnetworks.com and
must be entered into this field to enable additional functionality
(registration capacity, ePMP Elevate support) of the ePMP device.

Ad Note

The AP’s Keep Licenses option may be utilized to retain licensed
functionality upon a factory default procedure.

026v003 177



ePMP CAMBIUM NETWORKS

AP eDetect page

The eDetect tool (not available in ePTP Master mode) is used to measure the 802.11 interference at
the ePMP radio or system when run from the AP, on the current operating channel. When the tool
is run, the ePMP device processes all frames received from devices not connected to the ePMP
system and collects the interfering frame’s information such as MAC Address, RSSI, and MCS. Use
the AP eDetect page to perform the following functions:

e Collect information about interferers system wide on the AP and the SMs connected to it to
display on the APs GUI.

e Collect information about interferers locally at the AP only to display on the AP’s GUI.

Figure 54 AP eDetect page

@ Cambium Networks | oypo000 d1sans | Access Point — B & Administrator -
ePMP 2000
A Tools » eDetect
Home
@ cDetect
& Quick start
@ Detecting Device AP @ AP/SMs
Q Configuration-
Detection Duration 30 sec | min: 10 | max: 120
J'\- Monitor -
Start/Stop
/ Tools~
Expart to C5V
.'5 Software Upgrade
Status Running
oY o / Resto
+2 Backup /Restore SSID Cambium-AP
. R Detection Results
[=] License Management

Interferers' MAC Interferers' SSID Interferers’ RSSI (dBm)
) eDetect

@ MAC 00:04:56:C0:26:D8 RSSI(dBm):-54  RATE: MCS-15 (No interferers)

il spectrum Analyzer @ MAC 00:04:56:D1:84:B6 RSSI(dBm):-63  RATE: MCS-1 (Mo

(@3 Automatic Channel Selection @ MAC: 00:04:56:FB:28:BB  RSSI(dBm): -56  RATE: MCS-15 (No inte
(?J Wireless Link Test

3 eing

E Traceroute

© 2016 Cambium Newworks, All Rights Reserved | Version 3.1 | Support | Community Forum

026v003 178



PMP

CAMBIUM NETWORKS

Table 92 AP eDetect attributes

Attribute

Meaning

Detecting Device

AP: Choosing this option will collect information about interferers local
to the AP.

AP/SMs: Choosing this option collect information about interferers
system wide i.e. interferers local to the AP as well as interferers at the
SMs connected to the AP.

Detection Duration

Configure the duration for which the AP (and SMs) scan for interferers.

N
&3 Caution
During the scanning period, the AP continues servicing the SMs under it,

and there is no outage (unlike running a Spectrum Analyzer). There may
be a negligible degradation in overall sector throughput.

Start/Stop

Use to start or stop the interference detection.

Export to CSV

Choose this option to export the detection results to . csv format.

Status

Current status of the Interference Detection tool.

SSID

The current configured name/SSID of the AP.

Detection Results

Use the Detection Results table to monitor interferers at the AP and at
the registered SMs and their key RF parameters.

Device Instant Health

This is an indicator of the device’s health in terms of channel conditions
in the presence of interferer(s).

Green: Indicates that the channel is relatively clean and has good C/I
levels (>25dB). The interference level is low.

Yellow: Indicates that the channel has moderate or intermittent
interference (C/l between 10dB and 25dB).

Red: Indicates that the channel has high interference and poor C/l levels
(<10dB).

Device MAC

The MAC address of the AP and/or SMs wireless interface.

Device RSSI (dBm)

The Received Signal Strength Indicator, which is a measurement of the
power level being received by the device’s antenna.

Device MCS

Modulation and Coding Scheme - indicates the modulation mode used
for the radio’s receiver side, based on radio conditions (MCS 1-7, 9-15).

Interferers’ MAC

The MAC address of the interferer’'s wireless interface.

Interferers’ RSSI
(dBm)

The Received Signal Strength Indicator, which is a measurement of the
interferer’s power level being received by the device’s antenna.

Interferers’ MCS

Modulation and Coding Scheme - indicates the modulation mode used
by the interferer, based on radio conditions (MCS 1-15).
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A Note

The system is operational when the eDetect tool is initiated. The detection is done during the
transmission period within the TDD frame. And it is possible that the AP detects another AP
on its back sector as an interferer when it is using the same frequency carrier in a GPS
Synchronized system. Also, since the detection happens when the system is operational,
there may be a negligible degradation in overall sector throughput when run from the AP.
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AP Spectrum Analyzer page
Use the AP Spectrum Analyzer page download the spectrum analyzer tool.
To download the spectrum analyzer tool, the AP Device Mode must be set to Spectrum Analyzer.

Java Runtime Environment is required to run the AP spectrum analyzer.

M
£33 Caution

Conducting spectrum analysis causes the AP to enter scan mode and the AP drops all RF
connections.

Vary the days and times when you analyze the spectrum in an area. The RF environment can
change throughout the day or throughout the week.

To conduct a spectrum analysis, follow this procedure:
Required Software:

e Java Run-time Environment (JRE)

Procedure:
1 On the AP GUI, navigate to Configuration => Radio

2 Change the Radio Mode to Spectrum Analyzer

3 Click the Save button

4  Click the Reset button

5 Login to the AP GUI and navigate to Tools => Spectrum Analyzer.
6 Click Download Spectrum Analyzer Tool

7  Locate the folder to which the spectrum analyzer tool was saved and double-click on file
csa.jnlp to launch the tool

8 If a security warning window appears, check the box next to “/ accept the risk and want to
run this application”
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9 Inthe security warning window, click Run

The spectrum analyzer interface is displayed

Coanecind i 1Ha Sl T 300 Soari Soaw

10 Click Range to configure the range of frequencies to scan.

11 Click Start Scan to begin scanning

Coomecied o 129802 200

Display of the
average, peak,
current, and
minimum
power levels for
the configured
range

Statistical
display of the
number of
times each
frequency in the
range was
scanned

Spectrogram
display of the
energy levels
detected
throughout the
configured
range, over
time
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Once the scanning completes, follow these steps to return the device to AP operation:

Procedure:

1 In the spectrum analyzer application, click Stop Scan

2 Close the spectrum analyzer application by clicking File => Exit
3 Onthe AP GUI, navigate to Configure => Radio

4  Configure Device Mode to AP

5 Click the Save button

6  Click the Reset button

026v003 183



ePMP CAMBIUM NETWORKS

AP Automatic Channel Selection page

Use the Automatic Channel Selection page to use the Automatic Channel Selection feature to
allow the AP to choose the best channel possible under the current RF environment. This feature is
not available when the AP is in ePTP Master mode.

Figure 55 AP Automatic Channel Selection
(@@ Cambium Networks | oypy00 d1aabs ‘ Access Point [ s [ o] 8] Sliamneu e

A Home Tools > Automatic Channel Selection

& Quick Start Staws  Enabled

o Configuration= O Automatic Channel Selection Disabled ® Enabled

_*\_ Monitor = Scan Channel Bandwidth ® 20 MHz 40 MHz 10 MHz 5MHz

ACS Relative Interference Metric vs Frequency

f Tools~
+

o Software Upgrade

ic
=1

x
°..E Backup / Restore
[=] License Management

40} eDetect

Relative Interference Metri
-

i Spectrum Analyzer

@ Automatic Channel 3
Selection

E—— 1|||J|||||| | L mm Il
5\; Ping o

5180 5230 5280 5500 5550 5500 5650 5700 s780 5620
Frequency MHz
E Traceroute @ Primary: 5505 MHz @ Secondary: 5610 MHz @ Tertiary: 5555 MHz
Minimum Dwell Time 200 msec | min: 50 | max: 500
Maximum Dwell Time 300 msec | min: 300 | max: 600
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Table 93 Automatic Channel Selection

Attribute

Meaning

Automatic Channel
Selection

Enabled — This enables the Automatic Channel Selection (ACS) feature.
ACS allows the radio to scan the entire band (governed by the Country
setting) and chooses a channel with the lowest channel occupancy i.e.
lowest interference level. To run the ACS feature (once enabled), the
radio will have to be rebooted or manually triggered using Tools-
>Automatic Channel Selection. When ACS is running, the radio
measures the occupancy level of the channel (measured in terms of an
internal interference metric) and uses an algorithm to make a decision
to choose the best channel within the band. The channel chosen is not
based just on the occupancy level channel but also the occupancy level
of adjacent channels.

Disabled — ACS is disabled and the operator should configure a
Frequency Carrier manually.

A Note

The channel bandwidth configured prior to enabling and running ACS
will be used to automatically select a channel. For ex: If the operator
manually configured a channel bandwidth of 20MHz, ACS will scan and
choose a channel of 20MHz wide channel. To switch ACS to 40MHz or
other channel bandwidth, the operator should disable ACS, manually
configure 40MHz or desired channel bandwidth on the radio, then
enable and run ACS.

Scan Channel
Bandwidth

Configure the channel size for which the radio needs to scan the band.

Minimum Dwell Time

Configure the minimum time in milliseconds for which the radio needs
to scan a channel to measure channel occupancy or interference levels.
Default is 200 ms.

Maximum Dwell Time

Configure the maximum time in milliseconds for which the radio needs
to scan a channel to measure channel occupancy or interference levels.
Default is 300 ms.

Results

Click this button to download the most recent ACS results in .csv
format.
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AP eAlign page

Use the eAlign page to aid with link alignment.

A Note

A valid link to an SM is required to provide meaningful RSSI measurements.

Figure 56 AP eAlign

(@ Cambium Networks | oypan0q dtsans | Access Point [ o) ] [ B | & Administrator -
A Home Tools » eAlign
4" Quick Start @y
& corfizurstion- © Operating Frequency 5800 MHz
Registered SM MAC Address 00:04:56:FB:28:BB
Jf\- Meonitor ~

Current RSS -64 dBm (Ch0: -66 dBm, Ch1: -69 dBm)

f Tools~

."y Software Upgrade

Peak R3S -64 dBm

Reset Measurements m

?ﬁ Backup / Restore

[=] License Management _ |

99 eDetect -100 -85 -a0 75 70 -5 50 -55 -50 -5 -40 -35 30
RSSI (dBm
L Spectrum Analyzer ( )
@M Automatic Channel Selection a0+
- E
=35 g
pe
-45
" -50
ﬁ Wireless Link Test i
-50
5‘{- Ping [P VRPN ST NSRSV VY | SRR W ISP, R .UV, SO UG UIRGY | SO Y
-70
B traceroute 75
-20
-35
-80
30 35 40 45 50
Time

B RSSI Level
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Table 94 eAlign
Attribute Meaning
Operating Frequency The current frequency at which the AP is operating.
Registered SM MAC The MAC address of the SM that is registered to the AP.
Address
Current RSSI Current RSSI value measured on the uplink by the AP’s receiver.
Peak RSSI Peak RSSI value measured by the AP’s receiver from the time the
user navigated to the eAlign page.
Reset Measurements Click this button to reset all current measurements.
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2\

AN Caution
ePMP supports Automatic Transmit Power Control (ATPC) where the SMs are instructed by
the AP to adjust their Tx power in order for the SM's signal (UL RSSI) to arrive at the AP at a
predetermined RSSI level (configurable on the AP under Configuration->Radio->Power
Control->Subscriber Module Target Receive Level). This feature is beneficial to keep the
overall noise floor in the sector to an acceptable level and is critical for deploying a GPS
Synchronized system. However, the feature negates the purpose of eAlign measurements on
the AP since, during the alignment, the SM may constantly change its Tx power. It is
recommended to turn off ATPC and set the SM’s Tx power to maximum allowable power
during alignment.

While aligning the link using eAlign, please follow these steps:

Procedure:

1  Onthe SM, set Configuration->Radio->Power Control->Tx Power Manual Limit to Max Tx
Output Power

2 Set Configuration->Radio->Power Control->Transmitter Output Power to 30 dBm (or
maximum value allowed by regulations).

3  Click the Save button
4  Perform link alignment using eAlign

5  Once alignment is complete, set Configuration->Radio->Power Control->Tx Power Manual
Limit back to Auto

6 Click the Save button
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AP Wireless Link Test page

Use the AP Wireless Link Test page to conduct a simple test of AP wireless throughput to any one
of the connected SMs. This allows user to determine the throughput that can be expected on a
particular link without having to use external tools.

Figure 57 AP Wireless Link Test

@ Cambium Networks
ePMP 2000

E3 3 2 Adminisra -

Zurich ePMP2000_d1f2... ‘ Access Point

A& Home Tools » Wireless Link Test

-8"' Quick Start

Q Configuration-

-“- Monitor~

/ Tools~

;‘ Software Upgrade

°..,§ Backup / Restore
E License Management
44} eDetect
ul. Spectrum Analyzer
E@) Automatic Channel Selection
5\} Ping
El Traceroute

Test Setup
SM MAC Address

Packet Size

Duration

@ Uplink Antenna Selection

Dowmlink
Uplink

Aggregate

Registered Subscriber Modules

00:04:56:18:05:01

Small (128 bytes)
Medium (800 bytes)

® Large (1500 bytes)

® 4seconds 10 seconds. 20 seconds

® Auto
Forced Sector Antenna
Forced Smart Antenna

41,766 Mbps
5.754 Mbps

47.52 Mbps

Details

MAC Address
1P Address
IPv6 Address
Device Name
SM Distance (miles)
Session Time (hh:mmss)

0 RSSI (dBm) Downlink / Uplink
SNR (dB) Downlink / Ulink
MCS Downlink / Uplink
Downlink Quality
Downlink Capacity
MIR Profile

MIR Rate fkhnsi Downlink / Lnlink

00:04:56:¢3:f6:6b
10.120.108.33
NA
5GHz_ePMP_Atrium_.35
1.024
6 days 02:22:01
-52/-72
33/18
15/12
83%
%

NFA 1 NIA
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Table 95 AP Wireless Link Test attributes

AP Ping page

Attribute

Meaning

Test Setup

SM MAC Address

Enter the MAC Address of one of the connected SMs or simply click the
Select button of the SM desired in the “Registered Subscriber Modules”
list.

Packet Size

Choose the Packet Size to use for the throughput test.

Duration

Choose the time duration in seconds to use for the throughput test.

Uplink Antenna

Uplink Antenna Selection specifies the antenna to be used in the uplink

Selection for the wireless link test. The antenna cannot be forced if it is already
configured to Forced Sector Antenna or Forced Smart Antenna in
section Configuration > Radio.

Downlink This field indicates the result of the throughput test on the downlink, in
Mbps.

Uplink This field indicates the result of the throughput test on the uplink, in
Mbps.

Aggregate This field indicates the result of the aggregate throughput on the link, in
Mbps. Displayed only when Downlink/Uplink Ratio is set to 75/25, 50/50
or 30/70.

Registered Use the Registered Subscriber Modules table to monitor registered SMs

Subscriber Modules

and their key RF status and statistics information. Click Select on the SM
that is desired to be used in the throughput test.

Use the AP Ping page to conduct a simple test of AP IP connectivity to other devices which are
reachable from the network. If no ping response is received or if “Destination Host Unreachable” is
reported, the target may be down, there may be no route back to the AP, or there may be a failure
in the network hardware (i.e. DNS server failure).
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Figure 58 AP Ping page

('{. Cambium N‘:,t’::\:,o.‘g;g ePMP1000_c6f8ed Access Point — B - & Administrator ~

& rome Tools » Ping
-ﬂb Quick Start LHIT

IP Address Version ® |Pv4 IPvE
ﬂ Configuration=

IPv4 Address, Fully Qualified Domain Name, or 192.168.2.1
JA— Maonitor- Hostname
/ Tools~ Number of Packets (-c) 0 min: 1 | max: 10
* ) d Buffer Size (-s) min: 1 | max: 63507
& Software Upgrade
TTL(-D) min: 1 | max: 128

Q’Q Backup / Restore

Start Ping

40 eDetect PING 192.168.2.1 (192.168.2.1) 32(68) bytes of data.

s from 192.168.2.1: i 1=64 time=0.520 ms
s from 192.168.2.1: i 1-64 time=@.392 ms
s from 192.168.2.1: i 1-64 time=@.401 ms
s from 192.168.2.1: i 1=64 time=0.434 ms

E] License Management
Ping Results

l!. Spectrum Analyzer

&® automatic Channel Selection 40 bytes from 192.168.2.1: 1 1-64 time=0.411 ms
48 bytes from 192.168.2.1: i 1=64 time=2.452 ms
(™) Wireless Link Test 40 bytes from 192.168.2.1: i 1=64 time=0.396 ms

48 bytes from 192.168.2.1: i

- 48 bytes from 192.168.2.1: i
% Plﬂg 48 bytes from 192.168.2.1:

E Traceroute --- 192.168.2.1 ping statistics ---
18 packets transmitted, 1@ received, @% packet loss, time 8995ms
rtt min/avg/max/mdev = ©.391/@.422/0.520/.039 ms

1=64 time=0.399 ms
=8 ttl=64 time=0.391 ms
seq=18 ttl=64 time=8.426 ms
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Table 96 AP Ping attributes

Attribute Meaning

Ping

IP Address Version IPv4: The ping test is conducted via IPv4 protocol.
IPv6: The ping test is conducted via IPv6 protocol.

IP Address Enter the IP address of the ping target.

Number of packets Enter the total number of ping requests to send to the target.
(-c)

Buffer size (-s) Enter the number of data bytes to be sent.

TTL (-t) Set the IP Time-To-Live (TTL) for multicast packets. This flag applies if
the ping target is a multicast address.

Ping results Results of the Ping test are displayed in the box.
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AP Traceroute page

Use the AP Traceroute page to display the route (path) and associated diagnostics for IP
connectivity between the AP and the destination specified.

Figure 59 AP Traceroute page

(@ Cambium Networks | pypang d1sss | Access Poine Fom B & Administrator -
A Home Tools » Traceroute
Jf' Quick Start LI
£ Configuration- 1P Address 10.120.210.136
A vonitor Fragmentation (F)  ® OFF © ON
Trace methad (-) ® ICMP ECHO upp
/ Tools~
Display TTL(} ~ ® OFF © ON
& Software Upgrade
Verbose(+)  ® OFF © ON
Q’E Backup / Restore
(=) License Management Traceroute Results
4} epetect traceroute to 18.12@.21@.}36 (1e.12e.218.136), 3@ hops max, 38 byte packets
ul. Spectrum Analyzer
@ Automatic Channel
Selection
@) Wireless Link Test
ﬁ- Ping
© 2016 Cambium Networks, All Rights Reserved | Version 3.1 | Support | Community Forum
Table 97 AP Traceroute attributes
Attribute Meaning
Traceroute
IP Address Enter the IP address of the target of the traceroute diagnostic.
Fragmentation (-F) ON: Allow source and target to fragment probe packets.

OFF: Do not fragment probe packets (on source or target).

Trace method (-I) ICMP ECHO: Use ICMP ECHO for traceroute probes.
UDP: Use UDP for traceroute probes.

Display TTL (-I) ON: Display TTL values for each hop on the route.
OFF: Suppress display of TTL values for each hop on the route.

Verbose (-v) ON: ICMP packets other than TIME_EXCEEDED and UNREACHABLE are
displayed in the output.

OFF: Suppress display of extraneous ICMP messaging.

Traceroute Results Traceroute test results are displayed in the box.
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Using the SM menu options

Use the menu navigation bar in the top and left panels to navigate to each web page. The
functional area that may be accessed from each menu option is listed under Table 76. Some of the
parameters are only displayed for specific system configurations.

Table 98 Functional areas accessed from each SM menu option

Menu option

Menu Details

Quick Start

Configuring SM units using the Quick Start menu on page 119

Configuration

SM Configuration menu on page 193

Radio

SM Radio page on page 194

Quality of Service

SM Quality of Service page on page 198

System SM System page on page 205
Network SM Network page on page 210
Security SM Security page on page 239
Monitor SM Monitor menu on page 242
Performance SM Performance page on page 243

System Status

SM System page on page 247

Wireless Status

SM Wireless page on page 249

Throughput Chart

SM Throughput Chart page on page 252

Network Status

SM Network page on page 253

System Log

SM System Log page on page 263

Tools

SM Tools menu on page 264

Software Upgrade

SM Software Upgrade page on page 265

Backup / Restore

SM Backup / Restore page on page 268

eDetect

SM eDetect page on page 270

Spectrum Analyzer

SM Spectrum Analyzer page on page 272

eAlign

SM eAlign page on page 274

Wireless Link Test

SM Wireless Link Test page on page 275

Ping SM Ping page on page 276
Traceroute SM Traceroute page on page 277
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SM CONFIGURATION MENU

Use the Configuration menu to access all applicable device configuration parameters. It contains
the following pages:

e SM Radio page on page 194

¢ SM Quality of Service page on page 198
e SM System page on page 205

e SM Network page on page 210

e SM Security page on page 239
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SM Radio page

Use the Radio page to configure the device radio interface parameters.

& Caution

Modifying radio parameters may result in a wireless outage. Plan configuration

modifications accordingly.

Figure 60 SM Radio page (TDD or ePTP Slave mode)
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Table 99 SM Radio Configuration attributes (TDD mode or ePTP Slave mode)

Attribute

Meaning

General

Radio Mode

This parameter controls the function of the device — All ePMP devices
may be configured to operate as an Access Point (AP), Subscriber
Module (SM) or as a Spectrum Analyzer.

Driver Mode

This parameter controls the wireless mode of operation of the SM.

TDD: The SM is operating in the proprietary TDD mode and will only
connect to another ePMP Access Point.

Standard WiFi: The SM is operating in the Standard 802.11n WiFi mode
and will be able to connect to any Access Point operating in standard
802.11n WiFi mode.

ePTP Slave: The SM is operating as a Slave in point-to-point mode. The
AP and the system do not support GPS Synchronization in this mode but
are able to provide significantly lower latency than other modes. QoS
(MIR and traffic priority) capability and Link Quality/Capacity indicators
are not available in this mode.

Country

The SM automatically inherits the Country Code setting of the AP
(except for US-locked devices).

Country settings affect the radios in the following ways:
e Maximum transmit power limiting (based on radio transmitter
power plus configured antenna gain)

e DFS operation is enabled based on the configured country code, if
applicable

e Frequency selection is based on local regulatory limits

Range Unit

The unit of measurement used for reporting Distance from AP.

Preferred AP List

Preferred APs

The Preferred AP List is comprised of a list of up to 16 APs to which the
SM sequentially attempts registration. For each AP configured, if
authentication is required, enter a Pre-shared Key associated with the
configured AP SSID. When the SM is in Standard WiFi mode, the SMs
will actively probe the SSIDs in this list to find APs with hidden SSIDs.
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Attribute

Meaning

Subscriber Module Scanning

Scan Channel
Bandwidth

Click the m button to unselect all channel bandwidths. The SM

will not scan for any frequencies.

Click the button to select all channel bandwidths. The SM will
scan all channel bandwidths, i.e. 5 MHz, 10 MHz, 20 MHz and 40 MHz.
Alternately choose individual channel bandwidth tabs and/or

frequencies within each channel bandwidth tab for a customized scan
list.

Power Control

Max Tx Power

Auto: The Access Point can control, using ATPC (Automatic Transmit
Power Control), the TX power of the SM up to the maximum capability
of the SM’s transmitter (based on regulatory limits).

Manual: The Access Point can control the TX power of the SM up to the
value configured in the Transmitter Output Power field below.

Transmitter Output
Power

When Manual is selected, the SM will not transmit higher than the
configured value in the field. Determines the maximum output power of
the transmitter. The actual output power may be lower due to Automatic
Transmit Power Control (ATPC), where the AP instructs the SM to lower
its power to meet the SM target Receive Level configured on the AP.

Antenna Gain

This value represents the amount of gain introduced by the unit’s
internal antenna. This parameter is read-only for Integrated radios.

Network Entry RSSI
Threshold

Set this parameter to the minimum Received Signal Strength Indicator
(RSSI) at the SM required for the SM to attempt registration to an AP.
For example, if the AP RSSI Threshold is set to -80 dBm, and the SM is
receiving the AP signal at -85 dBm (RSSI = -85 dBm), the SM will not
attempt to register to the AP.

Network Entry SNR

Set this parameter to the minimum Signal-to-Noise Ratio (SNR) at the

Threshold SM required for the SM to attempt registration to an AP. For example, if
the AP SNR Threshold is set to 30 dB and the SM is calculating its DL
SNR as 25 dB, the SM will not attempt to register to the AP.
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Attribute

Meaning

Uplink Antenna
Selection

Uplink Antenna Selection specifies the antenna to be used in the uplink.
This parameter is specific to SMs registered to ePMP 2000 APs
configured with an optional Smart Antenna.

Auto: The AP decides which antenna to use (sector or Smart Antenna)
for uplink communications based on internal quality metrics.

Forced Sector Antenna: The AP uses the Sector Antenna for uplink
communications with SMs configured with this option

Forced Smart Antenna: The AP uses the smart antenna for uplink
communications with SMs configured with this option

RS Note

If the AP is configured with Uplink Antenna Selection set to Auto and
an SM is set to Forced Sector Antenna or Forced Smart Antenna, the
SM setting will be enforced.

If the AP is configured with Uplink Antenna Selection set to Forced
Sector Antenna or Forced Smart Antenna and a SM is setto a
conflicting Forced setting, the AP’s setting will be enforced.

Scheduler

Uplink Max Rate

Configure the MCS (Modulation and Coding Scheme) rate beyond which
the radio’s scheduler should not exceed when transmitting data traffic
on the uplink. This is useful in situations where there is high variance
and unpredictability in the interference present in the environment
causing packet loss. Reducing the max rate to a lower MCS (than the
default MCS 15) may help in these situations. Reducing the Uplink Max
Rate will result in reduced throughput capacity of the SM in the uplink.
Not available when SM is in ePTP Slave or Standard WiFi mode.
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Figure 61 SM Radio page (Standard WiFi mode)
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Table 100 SM Radio Configuration attributes (Standard WiFi mode)

Attribute Meaning

General

Radio Mode This parameter controls the function of the device — All ePMP devices
may be configured to operate as an Access Point (AP), Subscriber
Module (SM) or as a Spectrum Analyzer.

Driver Mode This parameter controls the wireless mode of operation of the SM.

TDD: The SM is operating in the proprietary TDD mode and will only
connect to another ePMP Access Point.

Standard WiFi: The SM is operating in the Standard 802.11n WiFi mode
and will be able to connect to any Access Point operating in standard
802.11n WiFi mode.

ePTP Slave: The SM is operating as a Slave in point-to-point mode. The
AP and the system do not support GPS Synchronization in this mode but
are able to provide significantly lower latency than other modes. QoS
(MIR and traffic priority) capability and Link Quality/Capacity indicators
are not available in this mode.

Fallback Country

The SM automatically inherits the Country Code setting of the AP
(except for US-locked devices).

Fallback Country is used by the SM if the AP does not provide a Country
Code to the SM during registration and affect the radios in the following
ways:

e Maximum transmit power limiting (based on radio transmitter
power plus configured antenna gain)

e DFS operation is enabled based on the configured country code, if
applicable

e Frequency selection is based on local regulatory limits

Range Unit

The unit of measurement used for configuring Distance to AP.

Preferred AP List

Preferred APs

The Preferred AP List is comprised of a list of up to 16 APs to which the
SM sequentially attempts registration. For each AP configured, if
authentication is required, enter a Pre-shared Key associated with the
configured AP SSID.
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Attribute

Meaning

Subscriber Module Scanning

Scan Channel
Bandwidth

Click the m button to unselect all channel bandwidths. The SM

will not scan for any frequencies.

Click the button to select all channel bandwidths. The SM will
scan all channel bandwidths, i.e. 5 MHz, 10 MHz, 20 MHz and 40 MHz.

Alternately choose individual channel bandwidth tabs and/or
frequencies within each channel bandwidth tab for a customized scan
list.

Power Control

Tx Power Manual
Limit

Auto: The Access Point can control, using ATPC (Automatic Transmit
Power Control), the TX power of the SM up to the maximum capability
of the SM’s transmitter (based on regulatory limits).

Max Tx Output Power: The Access Point can control the TX power of the
SM up to the value configured in the Transmitter Output Power field
below.

Transmitter Output
Power

The SM will not transmit higher than the configured value in the field.
Determines the maximum output power of the transmitter. The actual
output power may be lower due to Automatic Transmit Power Control
(ATPC), where the AP instructs the SM to lower its power to meet the
SM target Receive Level configured on the AP.

Antenna Gain

This value represents the amount of gain introduced by the unit’s
internal antenna. This parameter is read-only for Integrated radios.

Network Entry RSSI

Set this parameter to the minimum Received Signal Strength Indicator

Threshold (RSSI) at the SM required for the SM to attempt registration to an AP.
For example, if the AP RSSI Threshold is set to -80 dBm, and the SM is
receiving the AP signal at -85 dBm (RSSI = -85 dBm), the SM will not
attempt to register to the AP.

Scheduler

Distance to AP

In Standard WiFi mode, this parameter represents cell coverage radius.
SMs outside the configured radius will not achieve optimal throughput.
It is recommended to configure Distance to AP to match the actual
physical maximum range of the farthest subscriber. This must be
configured to match the range of the farthest subscriber on all SMs
under the AP regardless of their respective distance from the AP.

Advanced
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Attribute Meaning

RTS Threshold Configure the RTS packet size threshold for uplink data transmission.
Range is between 0-2347 octets. Typically, sending RTS/CTS frames
does not occur unless the packet size exceeds this threshold. If the
packet size that the node wants to transmit is larger than the threshold,
the RTS/CTS handshake gets triggered. Otherwise, the data frame gets
sent immediately.
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SM Quality of Service page

The ePMP platform supports three QoS priority levels (not available in ePTP Master mode) using
air fairness, priority-based starvation avoidance scheduling algorithm.

Ordering of traffic amongst the priority levels is based on a percentage of total link throughput. In
other words, all priorities receive some throughput so that low priority traffic is not starved from
transmission. In effect, the greatest amount of throughput is guaranteed to the VOIP priority level,
then High, then Low.

Priority Level ePMP Traffic Priority Label

Highest Priority VOIP (only utilized when VOIP Enable is set to Enabled)
Medium Priority High

Lowest Priority Low

By default, all traffic passed over the air interface is low priority. The SM’s Quality of Service page
may be utilized to map traffic to certain priority levels using QoS classification rules. The rules
included in the table are enforced starting with the first row of the table.

A Caution

Each additional traffic classification rule increases device CPU utilization. Careful network
traffic planning is required to efficiently use the device processor.

The ePMP platform also supports radio data rate limiting (Maximum Information Rate, or MIR)
based on the configuration of the MIR table. Operators may add up to 16 MIR profiles on the AP,
each with unique limits for uplink and downlink data rates. The SM field MIR Profile Setting is used
to configure the appropriate MIR profile for limiting the SM’s data rate.

Figure 62 SM Quality of Service page
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Table 101 SM Quality of Service attributes

Attribute

Meaning

Maximum Information Rate (MIR)

MIR Profile Number

Configure the desired MIR (Maximum Information Rate) profile for SM
operation. This profile must be configured on the AP else the default
profile (0) is used.

Traffic Priority

Traffic Priority

Enabled: The QoS Classification Rules table is editable and is utilized by
the device to classify traffic.

Disabled: The QoS Classification Rules table is greyed-out and all traffic
is sent at one priority level.

VolP Priority

Enabled: When enabled, two entries are automatically added to the first
and second rows of the QoS Classification Rules table, one with Rule
Type CoS (5) and one with Rule Type DSCP (46). The addition of these
rules ensures that VolP traffic passed over the radio downlink is given
highest priority. The CoS and DSCP values may be modified to
accommodate non-standard VolP equipment.

Broadcast Priority

Low Priority: All Broadcast traffic sent over the uplink is prioritized as
low priority and is delivered to the AP after scheduled high priority and
VolIP traffic.

High Priority: All Broadcast traffic sent over the uplink is prioritized as
high priority and is scheduled for delivery to the AP before low priority
traffic but after VolP traffic.

Multicast Priority

Low Priority: All Multicast traffic sent over the uplink is prioritized as
low priority and is delivered to the AP after scheduled high priority and
VolIP traffic.

High Priority: All Multicast traffic sent over the uplink is prioritized as

high priority and is scheduled for delivery to the AP before low priority
traffic but after VolP traffic.

Subscriber Module
Priority

Normal: SM gives priority to the packets as defined in the rules which
could be "Low", "High", or "VolP". "Normal" priority will allow data to be
added to the appropriate "High", "Low", and "VolP" queues based on the
QoS rules. This is the default setting. If no rule is defined for a packet,
then the packet priority will be “Low”.

High: SM places all data other than VolP in the "High" queue. It will be
given higher priority than SMs configured with “Low” and “Normal”
when there is contention for bandwidth under the AP.

Low: "Low" priority will place all data that is not VolIP in "Low" priority
queue. It will be given lower priority than SMs configured with “High”
when there is contention for bandwidth under the same AP.

"VolP" queue is the highest priority queue followed by "High" queue and
then by "Low" queue. Higher priority queues have preference over lower
priority queues, but will not starve them.
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Attribute

Meaning

QoS Classification
Rules

The QoS Classification Rules table contains all of the rules enforced by
the device when passing traffic over the radio downlink. Traffic passed
through the device is matched against each rule in the table; when a
match is made the traffic is sent over the radio link using the priority
defined in column Traffic Priority.

Type

DSCP: Differentiated Services Code Point; traffic prioritization is based
on the 6-bit Differentiated Services field in the IP header present in the
packet entering the Ethernet port.

CoS: Class of Service; traffic prioritization is based on the 3-bit header
present in the 802.1Q VLAN-tagged Ethernet frame header in the packet
entering the SM’s Ethernet port.

VLAN ID: Traffic prioritization is based on the VLAN ID of the packet
entering the SM’s Ethernet port.

EtherType: Traffic prioritization is based on 2 octet Ethertype field in the
Ethernet frame entering the SM’s Ethernet port. The Ethertype is used to
identify the protocol of the data in the payload of the Ethernet frame.

IP: Traffic prioritization is based on the source and/or destination IP
addresses of the packet entering the SM’s Ethernet port. A subnet mask
may be included to define a range of IP addresses to match.

MAC: Traffic prioritization is based on the source and/or destination
MAC addresses of the packet entering the SM’s Ethernet port. A mask
may be included to define a range of MAC addresses to match. The
mask is made up of a hex representation of a series of 1s to start the
mask and Os that end the mask. A 1 may not follow a 0. Thus,
FF:FF:FF:FF:00:00 is allowed, but FF:00:FF:FF:FF:FF is not. The MAC
address is combined with the mask to define the range of allowed MAC
addresses.

Details

The Rule Details column is used to further configure each classification
rule specified in column Rule Type.

Priority

High: Traffic entering the SM’s Ethernet port is prioritized as “high
priority” for sending over the radio link (traffic will be sent after VOIP-
classified traffic, but before Low-classified traffic).

Low: Traffic entering the SM’s Ethernet port is prioritized as “low
priority” for sending over the radio link (traffic will be sent after VOIP-
classified and High-classified traffic is sent).

026v003

204



cPMP

CAMBIUM NETWORKS

SM System page

The SM’s System page is used to configure system parameters, services, time settings, SNMP and

syslog.
Figure 63 SM System page
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Table 102 SM System attributes

Attribute

Meaning

General

Device Name

The Device Name is used to identify the SM on the network, and may be
retrieved by a NMS such as the Cambium Network Services Server
(CNSS).

Webpage Auto
Update

Configure the interval for which the device retrieves system statistics for
display on the management interface. For example, if this setting is
configured to 5 seconds, the statistics and status parameters displayed
on the management interface will be refreshed every 5 seconds
(default). Webpage Auto Update is a session only configuration change.
It is updated with the <Enter> key and is not savable when using the
save button.

Web Access

HTTP: Access to the device management GUI is conducted via HTTP.
HTTPS: Access to the device management GUI is conducted via HTTPS.

HTTP Port

If Web Service is set to HTTP, configure the port which the device uses
to service incoming HTTP requests for management GUI access.

HTTPS Port

If Web Service is set to HTTPS, configure the port which the device uses
to service incoming HTTPS requests for management GUI access.

SSH Access

Disabled: If the SSH port to the device is ‘Disabled’, access to the device
through SSH is not possible.

Enabled: If the SSH port to the device is ‘Enabled’, Cambium engineers
can access the device through SSH which enables them to login to the
radio and troubleshoot. SSH port is ‘Enabled’ by default.

Telnet Access

Disabled: CLI access via telnet is not allowed for the device.
Enabled: CLI access via telnet is allowed for the device.

MAC-Telnet Access

Disabled: Disables connections to the radio on the link layer via MAC
address from RouterOS or mactelnet-enabled devices.

Enabled: Enables connections to the radio on the link layer via MAC
address from RouterOS or mactelnet-enabled devices.

A Note

In order to use MAC-Telnet the first time, the Administrator account
password must be changed on the GUI or the CLI. This password can
then be used for MAC-Telnet.

MAC-Telnet Protocol

MAC-Telnet: Use the MAC-Telnet subservice for access
MAC-SSH: Use the secured MAC-SSH subservice for access

Network Time Protocol (NTP)

IP Assignment

Static: The device retrieves NTP time data from the servers configured
in fields Preferred NTP Server and Alternate NTP Server.

DHCP: The device retrieves NTP time data from the server IP issued via
a network DHCP server.
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Attribute

Meaning

Preferred NTP Server

Configure primary NTP server IP address from which the device
retrieves time and date information.

Alternate NTP Server

Configure secondary or alternate NTP server IP address from which the
device retrieves time and date information.

Time Zone

The Time Zone option may be used to offset the received NTP time to
match the operator’s local time zone.

Location Services

Device Latitude

Configure Latitude information for the device in decimal format.

Device Longitude

Configure Longitude information for the device in decimal format.

Device Height

Configure the Height above sea level for the device, in meters.

Device Location

Hyperlink to display the device location on Google Maps

Simple Network Management Protocol (SNMP)

Read-Only
Community String

Specify a community string that allows a Network Management Station
(NMS) such as the Cambium Networks Services Server (CNSS) to read
SNMP information. No spaces are allowed in this string. This password
will never authenticate an SNMP user or an NMS to read/write access.

The SNMP Read-only Community String value is clear text and is
readable by a packet monitor.

Read-Write
Community String

Specify a community string that allows a Network Management Station
(NMS) to not only read SNMP information but also write SNMP values

that are defined as writeable in the radio. No spaces are allowed in this
string.

System Name

Specify a string to associate with the physical module. This parameter
can be polled by the Cambium Networks Services Server (CNSS) or an
NMS. Special characters are supported.

System Description

Specify a description string to associate with the physical module. This
parameter can be polled by the Cambium Networks Services Server
(CNSS) or an NMS. Special characters are supported.

Traps

Disabled: With this setting, the radio does not send traps

Enabled: Setting this enables the radio to send SNMP traps to the
configured SNMP Trap Server.

Trap Community
String

Specify a control string to match the Trap Community String on the
SNMP Trap server. No spaces are allowed in this string.

Trap Servers

The SNMP Trap Servers table contains all of the SNMP Trap servers the
radio can send SNMP traps.
Configure the IP Address which the device uses to send SNMP traps.
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Attribute

Meaning

Server IP

Specify up to four SNMP Trap Servers to which the device will send
SNMP traps.

Server Port

Configure port which the device uses to send SNMP traps.

System Logging (Syslog)

Server 1-4

Specify up to four syslog servers to which the device sends syslog
messages.

SysLog Mask

Configure the levels of syslog messages which the devices send to the
servers configured in parameters Syslog Server IP 1-4

cnMaestro

Remote Management

When Enabled, the device will be managed by cnMaestro - the Cambium
Remote Management System, which allows all Cambium devices to be
managed in the cloud.

cnMaestro URL

Configure the URL of cnMaestro. The default value is
https://cloud.cambiumnetworks.com.

Cambium ID

Configure the Cambium ID that the device will use for on-boarding on to
cnMaestro.

Onboarding key

Configure the password/key associated with the Cambium-ID that the
device will use for on-boarding on to cnMaestro.

Account Management

(Administrator)
Username

Read-only listing of available login levels.
¢ ADMINISTRATOR, full read write permissions.

e INSTALLER, permissions to read and write parameters applicable to
unit installation and monitoring.

¢ HOME USER, permissions only to access pertinent information for
support purposes.

¢ READONLY, permissions only to view the Monitor page.

(Administrator)
Password

Configure a custom password configuration for each user to secure the
device. The password character display may be toggled using the

visibility icon

Installer Account

Disabled: The disabled user is not granted access to the device
management interface. The administrator user level cannot be disabled.

Enabled: The user is granted access to the device management
interface.
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Attribute

Meaning

(Installer) Username

Read-only listing of available login levels:

e [INSTALLER, permissions to read and write parameters applicable to
unit installation and monitoring.

¢ HOME USER, permissions only to access pertinent information for
support purposes.

e READONLY, permissions only to view the Monitor page.

(Installer) Password

Configure a custom password configuration for each user to secure the
device. The password character display may be toggled using the

visibility icon

Home User Account

Disabled: The disabled user is not granted access to the device
management interface. The administrator user level cannot be disabled.

Enabled: The user is granted access to the device management
interface.

(Home) User
Username

Read-only listing of available login levels:

e HOME USER, permissions only to access pertinent information for
support purposes.

e READONLY, permissions only to view the Monitor page.

(Home) User
Password

Configure a custom password configuration for each user to secure the
device. The password character display may be toggled using the

visibility icon

Read-Only Account

Disabled: The disabled user is not granted access to the device
management interface. The administrator user level cannot be disabled.

Enabled: The user is granted access to the device management
interface.

(Read-Only) READONLY, permissions only to view the Monitor page.
Username
(Read-Only) Configure a custom password configuration for each user to secure the
Password device.
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SM Network page

The SM’s Network page is used to configure system networking parameters and VLAN
parameters. Parameter availability is based on the configuration of the SM Network Mode

parameter.

Figure 64 SM Network page, NAT mode
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Table 103 SM Network attributes, NAT mode

Attribute

Meaning

General

Network Mode

NAT: The SM acts as a router and packets are forwarded or filtered
based on their IP header (source or destination).

Bridge: The SM acts as a switch and packets are forwarded or
filtered based on their MAC destination address.

Router: The SM acts as a router and packets are forwarded or
filtered based on their IP header (source or destination) using
specific static routes and IP aliases configured by the operator.

Wireless IP Assignment

Static: Wireless IP addressing is configured manually in fields
Wireless IP Address, Wireless IP Subnet Mask, Wireless Gateway IP
Address, Preferred DNS IP Address and Alternate DNS IP Address.

DHCP: Device management IP addressing (IP address, subnet mask,
gateway and DNS server) is assigned via a network DHCP server.

Wireless IP Address

Wireless Internet protocol (IP) address. This address is used by the
family of Internet protocols to uniquely identify this unit on a
network.

Wireless Subnet Mask

Defines the address range of the connected IP network. For example,
if Wireless IP Address is configured to 192.168.2.1 and Wireless IP
Subnet Mask is configured to 255.255.255.0, the device wireless
interface will belong to subnet 192.168.2.X.

Wireless Gateway

Configure the IP address of a computer on the current network that
acts as a gateway. A gateway acts as an entrance and exit to packets
from and to other networks.

Preferred DNS Server

Configure The IP address of the preferred server used for DNS
resolution.

Alternate DNS Server

Configure The IP address of the alternate server used for DNS
resolution.

Wireless IPv6
Assignment

Wireless IPv6 Assignment specifies how the IPv6 address for the
wireless interface is obtained.

Static: Device management IP addressing is configured manually in
fields Wireless IPv6 Address and Wireless IPv6 Gateway.

DHCPv6: Device management IP addressing (IP address and
gateway) is assigned via a network DHCP server, and parameters
Wireless IPv6 Address and Wireless IPv6 Gateway are unused. If the
DHCPv6 server is not available previous static IPv6 address will be
used as a fallback IPv6 address. If no previous static IPv6 address is
available, no IPv6 address will be assigned. DHCPv6 will occur over
the wireless interface by default.
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Attribute

Meaning

Wireless IPv6 Address

Internet protocol version 6 (IPv6) address. This address is used by
the family of Internet protocols to uniquely identify this unit
(wireless interface) on a network.

IPv6 addresses are represented by eight groups of four hexadecimal
digits separated by colons.

Wireless IPv6 Gateway

Configure the IPv6 address of the device on the current network that
acts as a gateway. A gateway acts as an entrance and exit to packets
from and to other networks.

Ethernet Port Security

Disabled: When disabled, any number of devices (MAC Addresses)
can connect via the SM’s Ethernet (LAN) port.

Enabled: When enabled, the number of devices (MAC Addresses)
that can connect via the SM's Ethernet (LAN) port can be restricted
with the fields below.

Secure MAC Limit

Specify the maximum number of unique devices (MAC Addresses)
that can connect via the SM’s Ethernet (LAN) port. Range is 1 - 254
devices.

MAC Aging Time

Specify the aging timer in seconds. The aging timer will determine
the duration for which the SM will maintain the MAC Address in its
bridge table. The timer is restarted any time traffic from a specific
MAC address is received on the LAN port. Once the timer expires,
the MAC Address is removed from the SM’s bridge table.

Ethernet Interface

IP Address

Internet protocol (IP) address. This address is used by the family of
Internet protocols to uniquely identify this unit on a network.

Subnet Mask

Defines the address range of the connected IP network. For example,
if Device IP Address (LAN) is configured to 192.168.2.1 and IP Subnet
Mask (LAN) is configured to 255.255.255.0, the device will belong to
subnet 192.168.2.X.

IPv6 Address

Internet protocol version 6 (IPv6) address. This address is used by
the family of Internet protocols to uniquely identify this unit
(Ethernet interface) on a network.

IPv6 addresses are represented by eight groups of four hexadecimal
digits separated by colons.

Gateway

Configure the IP address of a computer on the current network that
acts as a gateway. A gateway acts as an entrance and exit to packets
from and to other networks.
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Attribute

Meaning

DHCP Server

Disabled: Use this setting when SM is in NAT mode, if there is an
existing DHCP Server below the SM handing out IP Addresses or if
all devices below the SM will be configured with static IP Addresses.
Enabled: Use this setting when SM is in NAT mode, to use the SM's
local/onboard DHCP server to hand out IP addresses to its clients.

DHCP Start IP

Configure the first address which will be issued to a DHCP client.
Upon additional DHCP requests, the DHCP Start IP is incremented
until Local DHCP End IP is reached.

DHCP End IP

Configure the highest IP address in the DHCP pool that can be issued
to a DHCP client.

Preferred DHCP DNS
Server

Configure the primary DNS Server IP address which will be used to
configure DHCP clients (if Local DHCP Server is set to Enabled).

Alternate DHCP DNS
Server

Configure the secondary DNS Server IP address which will be used
to configure DHCP clients (if Local DHCP Server is set to Enabled).

DHCP Lease Time

Configure the time for which a DHCP IP address is leased. When the
lease time expires, the DHCP client must renew IP addressing via
DHCP request.

DHCP Clients The DHCP Client List table identifies hardware situated below the
SM which shall be issued DHCP IP addressing information. The SM
acts as a DHCP server, responding to requests from hardware
connected to the SM.

MAC Configure the physical address of the device which will retrieve
DHCP IP addressing information from the SM.

IP Configure the IP address which will be assigned to the device.

Name Configure a logical name for the device configured (i.e. VolP Phone1,

or Network Camera1).

Separate Wireless Management Interface

Separate Management IP  Disabled: When disabled, the Wireless IP is the management

interface for the SM.

Enabled: When enabled, the IP Address below is the management
interface for the SM.

IP Assignment

Static: Separate Wireless Management Interface is configured
manually in fields IP Address, Subnet Mask and Gateway.

DHCP: Management IP addressing (IP address, subnet mask,
gateway and DNS server) is assigned via a network DHCP server.

IP Address Configure the IP address that will be used to access the SM's
management interface when in NAT mode. The Wireless IP (public
IP) will not allow management access.
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Attribute Meaning

Subnet Mask Defines the address range of the connected IP network. For example,
if IP Address is configured to 192.168.2.1 and Subnet Mask is
configured to 255.255.255.0, the device wireless interface will belong
to subnet 192.168.2.X.

Gateway Configure the IP address of a computer on the current network that
acts as a gateway. A gateway acts as an entrance and exit to packets
from and to other networks.

IPv6 Assignment IPv6 Assignment specifies how the IPv6 address for the separate
wireless interface is obtained.

Static: Device management IP addressing is configured manually in
fields IPv6 Address and IPv6 Gateway.

DHCPv6: Device management IP addressing (IP address and
gateway) is assigned via a network DHCP server, and parameters
IPv6 Address and IPv6 Gateway are unused. If the DHCPv6 server is
not available previous static IPv6 address will be used as a fallback
IPv6 address. If no previous static IPv6 address is available, no IPv6
address will be assigned. DHCPv6 will occur over the wireless
interface by default.

IPv6 Address Internet protocol version 6 (IPv6) address. This address is used by
the family of Internet protocols to uniquely identify this unit
(separate wireless interface) on a network.

IPv6 addresses are represented by eight groups of four hexadecimal
digits separated by colons.

IPv6 Gateway Configure the IPv6 address of the device on the current network that
acts as a gateway. A gateway acts as an entrance and exit to packets
from and to other networks.

Separate Management Enabled: A VLAN configuration establishes a logical group within

VLAN the network. Each computer in the VLAN, regardless of initial or
eventual physical location, has access to the same data based on the
VLAN architecture. For the network operator, this provides flexibility
in network segmentation, simpler management and enhanced
security. When the SM is in NAT mode, the Separate Wireless
Management VLAN configuration is applicable to management data.

Disabled: When disabled, the SM does not have a unique
management VLAN.

VLAN ID Configure this parameter to include the device’s management traffic
on a separate VLAN network.

026v003 214



PMP

CAMBIUM NETWORKS

Attribute

Meaning

VLAN Priority

ePMP radios can prioritize VLAN traffic based on the eight priorities
described in the IEEE 802.1p specification. Data VLAN Priority
represents the VLAN Priority or Class of Service (CoS). Operators
may use this prioritization field to give precedence to device
management data.

This parameter only takes effect if the Separate Wireless
Management VLAN parameter is enabled. Configure this parameter
to set the value of the Priority code point field in the 802.1q tag for
management traffic on the configured VLAN ID originating from the
SM. The default value is 0.

Virtual Local Area Management (VLAN)

VLAN (Management +
Data)

Enabled: A VLAN configuration establishes a logical group within
the network. Each computer in the VLAN, regardless of initial or
eventual physical location, has access to the same data based on the
VLAN architecture. For the network operator, this provides flexibility
in network segmentation, simpler management and enhanced
security. When the SM is in NAT or Router mode, the VLAN
configuration is applicable to both management and user data.

Disabled: When disabled, all IP management and data traffic is
allowed to the device.

VLAN ID

Configure this parameter to include the device’s management and
user traffic on a separate VLAN network.

VLAN Priority

ePMP radios can prioritize VLAN traffic based on the eight priorities
described in the IEEE 802.1p specification. Data VLAN Priority
represents the VLAN Priority or Class of Service (CoS). Operators
may use this prioritization field to give precedence to device user
and management data.

This parameter only takes effect if the VLAN parameter is enabled.
Configure this parameter to set the value of the Priority code point
field in the 802.1q tag for traffic on the configured VLAN ID
originating from the SM. The default value is 0.

Ethernet Port

Ethernet MTU

Maximum Transmission Unit; the size in bytes of the largest data
unit that the device is configured to process. Larger MTU
configurations can enable the network to operate with greater
efficiency, but in the case of retransmissions due to packet errors,
efficiency is reduced since large packets must be resent in the event
of an error.

Ethernet Port

Disabled: The primary Ethernet port is disabled
Enabled: The primary Ethernet port is enabled
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Meaning

Port Setting

Manual: The LAN Ethernet port speed and duplex mode can be
manually configured.

Auto-negotiate: The AP auto negotiates the LAN Ethernet port
speed and duplex mode with the device connected to it.

Port Speed

With “Ethernet Port Configuration” set to Manual, the LAN Ethernet
port speed can be forced to 1000 Mbps (only GPS Synchronized
radio), 100 Mbps or 10 Mbps.

Port Duplex Mode

With “Ethernet Port Configuration” set to Manual, the LAN Ethernet
port duplex mode can be forced to Full or Half.

Auxiliary Port

Disabled: When disabled, the LAN Auxiliary port on the SM is shut
down.

Enabled: When enabled, LAN Auxiliary port on the SM is up and
able to bridge traffic with the primary Ethernet port. Default value is
Enabled.

Auxiliary Port Setting

Manual: The LAN Auxiliary port speed and duplex mode can be
manually configured.

Auto-negotiate: The AP auto negotiates the LAN Auxiliary port
speed and duplex mode with the device connected to it.

Auxiliary Port Speed

With “Auxiliary Port Configuration” set to Manual, the LAN Auxiliary
port speed can be forced to 1000 Mbps (only GPS Synchronized
radio), 100 Mbps or 10 Mbps.

Auxiliary Port Duplex
Mode

With “Auxiliary Port Configuration” set to Manual, the LAN Auxiliary
port duplex mode can be forced to Full or Half.

Auxiliary Port PoE

Disabled: When disabled, the LAN Auxiliary port on the SM will not
provide proprietary PoE out. Default value is Disabled.

Enabled: When enabled, LAN Auxiliary port on the SM will provide
proprietary PoE out to power external PoE devices such as another
ePMP radio or a PoE camera.

Port Forwarding

Port Forwarding

The SM port forwarding functionality may be used to configure the
SM to route external network services to an internal IP address so
that end devices (situated below the SM) are reachable from
external networks.

i\

&3 Caution
Opening ports for forwarding may introduce a network
security risk.
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UPnP IGD

Universal Plug and Play (UPnP) is a set of networking protocols that
permits networked devices, such as personal computers, printers,
Internet gateways, Wi-Fi access points and mobile devices to
seamlessly discover each other's presence on the network and
establish functional network services for data sharing,
communications, and entertainment. UPnP is intended primarily for
residential networks without enterprise-class devices. With UPnP
IGD and PCP protocols ePMP will support explicit dynamic port
mappings.

Enable UPnP IGD (Internet Gateway Device) to allow the ePMP
device to use IGD profile for UPnP support.

NAT PMP (PCP)

The PCP (Port Control Protocol) allows an IPv6 or IPv4 host to
control how incoming IPv6 or IPv4 packets are translated and
forwarded by a Network Address Translator (NAT) or simple firewall,
and also allows a host to optimize its outgoing NAT keepalive
messages. PCP was standardized as a successor to the NAT Port
Mapping Protocol (NAT-PMP), with which it shares similar protocol
concepts and packet formats.

Enable this parameter to allow the ePMP device to use PCP protocol
for UPnP support.

Data Port Forwarding

The Data Port Forwarding Table is used to define which range of
wireless ports that are forwarded to a LAN (SM local network) IP
address below the SM.

Protocol UDP: Packet forwarding decisions are based on UDP packets.
TCP: Packet forwarding decisions are based on TCP packets.

Port Begin Configure the beginning of the range of wireless ports to match for
forwarding to LAN IP.

Port End Configure the end of the range of wireless ports to match for

forwarding to LAN IP.

Forwarding IP

Configure the LAN IP of the device situated below the SM which
receives the packets forwarded based on the Separate Management
IP Port Forwarding Table configuration.

Mapped Port

Configure the port of the device situated below the SM which
receives the packets forwarded based on the Data Port Forwarding
Table configuration.

Separate Management IP
Port Forwarding

The Separate Management IP Port Forwarding Table is used to
define which range of wireless ports from which Management traffic
on the Separate Management IP is forwarded to a LAN (SM local
network) IP address below the SM.
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Protocol UDP: Packet forwarding decisions are based on UDP packets.
TCP: Packet forwarding decisions are based on TCP packets.

Port Begin Configure the beginning of the range of wireless ports to match for
forwarding to LAN IP.

Port End Configure the end of the range of wireless ports to match for

forwarding to LAN IP.

Forwarding IP

Configure the LAN IP of the device situated below the SM which
receives the packets forwarded based on the Separate Management
IP Port Forwarding Table configuration.

Mapped Port

Configure the port of the device situated below the SM which
receives the packets forwarded based on the Separate Management
IP Port Forwarding Table configuration.

Point-to-Point Protocol over Ethernet (PPPoE)

PPPOE

Point-to-Point Protocol over Ethernet: Used for Encapsulating PPP
frames inside Ethernet frames.

Service Name

An optional entry to set a specific service name to connect to for the
PPPoE session. If this is left blank the SM accepts the first service
option that comes back from the Access Concentrator specified
below, if any. This is limited to 32 characters.

Access Concentrator

An optional entry to set a specific Access Concentrator to connect to
for the PPPoE session. If this is blank, the SM accepts the first Access
Concentrator which matches the service name (if specified). This is
limited to 32 characters.

Authentication

ALL: This means that CHAP authentication will be attempted first,
then PAP authentication. The same password is used for both types.

CHAP: This means that CHAP authentication will be attempted.
PAP: This means that PAP authentication will be attempted.

Username

This is the CHAP/PAP username that is used. This is limited to 32
characters.

Password

This is the CHAP/PAP password that is used. This is limited to 32
characters.

MTU Size

Maximum Transmission Unit; the size in bytes of the largest data
unit that the device is configured to process inside the PPPoE tunnel.
This field allows the operator to specify the largest MTU value to use
in the PPPoE session, if PPPoE MSS Clamping is Enabled. The user
will be able to enter an MTU value up to 1492. However, if the MTU
determined in LCP negotiations is less than this user-specified value,
the SM uses the smaller value as its MTU for the PPPoE link.
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Attribute

Meaning

Keep Alive Time

Configure the Keep Alive Time to allow the radio to keep the PPPoE
session up after establishment. As an example, if this field is set to 5,
the PPPoE client will send a keep alive message to the PPPoE server
every b seconds. If there is no acknowledgement, it sends the ‘Keep
alive’ message to the server 4 more times (for a total or 5 times)
before tearing down the PPPoE session. Setting this to 12 will mean
the keep alive message will be sent every 12 seconds and when
there is no acknowledgement, the client will try for a total of 12
times every 12 seconds before tearing down the PPPoE session.

MSS Clamping

Disabled: The SM PPPoE session allows any MTU size determined
by other devices in the PPPoE session during the LCP negotiations.

Enabled: The SM PPPoE session enforces a max MTU size
determined by the PPPoE MTU Size setting for all devices in the
PPPoE session during the LCP negotiations, unless one of the
devices enforces a MTU setting that is smaller in value.

De-Militarized Zone (DMZ)

DMZ

Disabled: Packets arriving on the Wireless Interface destined for the
Ethernet side of the network are dropped if a session does not exist
between the Source IP (Wireless) and Destination IP (Ethernet). By
default NAT requires the sessions to be initiated from the Ethernet
side before a packet is accepted from the Wireless to the Wired
side."

Enabled: Any packets with an unknown destination port (not
associated to an existing session or not defined in the port
forwarding rules) is automatically sent to the device configured with
DMZ IP Address."

IP Address

Configure the IP address of an SM connected device which is
allowed to provide network services to the wide-area network.

Advanced

IPv6 Support

Systemwide IPv6 Protocol Support. When enabled, appropriate IPv6
modules and services will be loaded.
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ARP-NAT

ARP-NAT or Wireless Client Bridging is a special MAC address
translation mechanism. It is similar to NAT for IP networks, except it
works one layer deeper. Instead of translating IP network addresses,
the ePMP device translates between the MAC hardware addresses
on both sides of the interface. If a device on the wired side of the
router makes an ARP request for the MAC address of an IP on the
wireless side, then the ePMP device forwards the request as if it
came from the ePMP device. When the response comes back, it
translates the address again. Instead of passing back the real MAC
(which resides on the wireless network), the ePMP device gives its
own wired MAC address. Then, when it receives frames for IP
addresses on the wireless network, it forwards them through
(conducted on both sides of the bridge).

ARP-NAT is configured on the SM in section Configuration >
Network > Advanced.

Ad Note

PPPoE Client on PCs connected to the SM is not supported and
throughput decreases when ARP-NAT feature is enabled.

Spanning Tree Protocol

Disabled: When disabled, Spanning Tree Protocol (802.1d)
functionality is disabled at the SM.

Enabled: When enabled, Spanning Tree Protocol (802.1d)
functionality is enabled at the SM, allowing for the prevention of
Ethernet bridge loops.

DHCP Server Below SM

Disabled: This blocks DHCP servers connected to the SM’s LAN side
from handing out IP addresses to DHCP clients above the SM
(wireless side).

Enabled: This allows DHCP servers connected to the SM’s LAN side
to assign IP addresses to DHCP clients above the SM (wireless side).
This configuration is typical in PTP links.

NAT Helper For SIP

Disabled: When disabled, the SM does not perform any deep packet
manipulation on the SIP request packet from a SIP Client.

Enabled: When enabled, the SM in NAT mode replaces the Source
IP within the SIP request to the Wireless IP of the SM. Please note
that this translation is often times handled by the SIP server so this
option may not always be needed.
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LLDP

The Link Layer Discovery Protocol (LLDP) is a vendor-neutral link
layer protocol (as specified in IEEE 802.1AB) used by ePMP for
advertising its identity, capabilities, and neighbors on the
Ethernet/wired interface.

Disabled: ePMP does not Receive or Transmit LLDP packets from/to
its neighbors.

Enabled: ePMP can Receive LLDP packets from its neighbors and
Send LLDP packets to its neighbors, depending on the LLDP Mode
configuration below.

LLDP Mode

Receive and Transmit: ePMP sends and receives LLDP packets
to/from its neighbors on the Ethernet/LAN interface.

Receive Only: ePMP receives LLDP packets from its neighbors on the
Ethernet/LAN interface and discovers them.
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Figure 65 SM Network page, Bridge mode
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Table 104 SM Network attributes, Bridge mode

Attribute Meaning

General

Network Mode NAT: The SM acts as a router and packets are forwarded or filtered
based on their IP header (source or destination).
Bridge: The SM acts as a switch and packets are forwarded or filtered
based on their MAC destination address.
Router: The SM acts as a router and packets are forwarded or filtered
based on their IP header (source or destination) using specific static
routes and IP aliases configured by the operator.
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IP Assignment

Static: Device management IP addressing is configured manually in
fields IP Address, Subnet Mask, Gateway, Preferred DNS Server and
Alternate DNS Server.

DHCP: Device management IP addressing (IP address, subnet mask,
gateway, and DNS server) is assigned via a network DHCP server, and
parameters IP Address, Subnet Mask, Gateway, Preferred DNS Server
and Alternate DNS Server are unused.

IP Address

Internet protocol (IP) address. This address is used by the family of
Internet protocols to uniquely identify this unit on a network.

A Note

If Device IP address Mode is set to DHCP and the device is unable to
retrieve IP address information via DHCP, the device management IP is
set to fall back to IP 192.168.0.1 (AP mode), 192.168.0.2 (SM mode),
192.168.0.3 (Spectrum Analyzer mode) or the previously-configured
static Device IP Address. Units may always be accessed via the
Ethernet port with IP 169.254.1.1. 169.254.1.1 is a local IP and is
independent of the NAT local subnet or the wireless IP.

Subnet Mask

Defines the address range of the connected IP network. For example, if
IP Address, Subnet Mask, Gateway, Preferred DNS Server and
Alternate DNS Server are configured to 255.255.255.0, the device will
belong to subnet 192.168.2.X.

Gateway

Configure the IP address of a computer on the current network that acts
as a gateway. A gateway acts as an entrance and exit to packets from
and to other networks.

Preferred DNS Server

Configure the IP address of the preferred server used for DNS
resolution.

Alternate DNS Server

Configure the IP address of the alternate server used for DNS
resolution.

IPv6 Assignment

IPv6 Assignment specifies how the IPv6 address is obtained.

Static: Device management IP addressing is configured manually in
fields IPv6 Address and IPv6 Gateway.

DHCPv6: Device management IP addressing (IP address and gateway)
is assigned via a network DHCP server, and parameters IPv6 Address
and IPv6 Gateway are unused. If the DHCPv6 server is not available
previous static IPv6 address will be used as a fallback IPv6 address. If
no previous static IPv6 address is available, no IPv6 address will be
assigned. DHCPv6 will occur over the wireless interface by default.
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IPv6 Address

Internet protocol version 6 (IPv6) address. This address is used by the
family of Internet protocols to uniquely identify this unit on a network.

IPv6 addresses are represented by eight groups of four hexadecimal
digits separated by colons.

IPv6 Gateway

Configure the IPv6 address of the device on the current network that
acts as a gateway. A gateway acts as an entrance and exit to packets
from and to other networks.

Ethernet Port Security

Disabled: When disabled, any number of devices (MAC Addresses) can
connect via the SM’s Ethernet (LAN) port.
Enabled: When enabled, the number of devices (MAC Addresses) that

can connect via the SM’s Ethernet (LAN) port can be restricted with the
fields below.

Secure MAC Limit

Specify the maximum number of unique devices (MAC Addresses) that
can connect via the SM’s Ethernet (LAN) port. Range is 1 — 254 devices.

MAC Aging Time

Specify the aging timer in seconds. The aging timer will determine the
duration for which the SM will maintain the MAC Address in its bridge
table. The timer is restarted any time traffic from a specific MAC
address is received on the LAN port. Once the timer expires, the MAC
Address is removed from the SM’s bridge table.

Virtual Local Area Network (VLAN)

Management VLAN

Enabled: The SM management interface can be assigned to a
Management VLAN to separate management traffic (remote module
management via SNMP or HTTP) from user traffic (such as internet
browsing, voice, or video). Once the management interface is enabled
for a VLAN, an SM’s management interface can be accessed only by
packets tagged with a VLAN ID matching the management VLAN ID.

A VLAN configuration establishes a logical group within the network.
For the network operator, this provides flexibility in network
segmentation, simpler management and enhanced security.

Disabled: When disabled, all untagged IP management traffic is
allowed to the device.

Management VLAN ID

Configure this parameter to include the device’s management traffic on
a separate VLAN network. For example, if MGMT VLAN ID is set to 2,
GUI access will only be allowed from frames tagged with VLAN ID 2.
This parameter only takes effect if the MGMT VLAN parameter is
enabled.

026v003

224



PMP

CAMBIUM NETWORKS

Attribute

Meaning

Management VLAN
Priority

ePMP radios can prioritize VLAN traffic based on the eight priorities
described in the IEEE 802.1p specification. MGMT VLAN Priority
represents the VLAN Priority or Class of Service (CoS). Operators may
use this prioritization field to give precedence to device management
traffic.

This parameter only takes effect if the MGMT VLAN parameter is
enabled. Configure this parameter to set the value of the Priority code
point field in the 802.1q tag for traffic on the management VLAN
originating from the SM. The default value is 0.

Data VLAN

Enabled: A VLAN tag will be added to all untagged traffic entering the
SM'’s LAN port before sending it to the AP and remove tags in the
opposite direction from traffic (tagged with Data VLAN ID) entering on
the SM’s WAN port before sending to the SM’s LAN port.

Disabled: When disabled, no changes are made to untagged traffic
passing through the SM.

Data VLAN ID

Configure this parameter to include this VLAN tag to all untagged traffic
entering on the SM’s LAN port before sending it to the AP and remove
tags in the opposite direction from traffic (tagged with Data VLAN ID)
entering on the SM’s WAN port before sending to the SM’s LAN port.

Data VLAN Priority

ePMP radios can prioritize VLAN traffic based on the eight priorities
described in the IEEE 802.1p specification. Data VLAN Priority
represents the VLAN Priority or Class of Service (CoS). Operators may
use this prioritization field to give precedence to device user data.

This parameter only takes effect if the Data VLAN parameter is enabled.
Configure this parameter to set the value of the Priority code point field
in the 802.1q tag for traffic on the Data VLAN originating from the SM.
The default value is 0.

Membership VLANs

Configure the Membership VLAN Table to include the SM in one or
more VLANs. When the SM receives a packet tagged from either the
Ethernet (LAN) or Wireless (WAN) side with a VLAN ID which is
contained in the Membership VLAN Table, the packet is forwarded and
sent out the other interface. When the SM receives a packet tagged with
a VLAN ID which is not present in the Membership VLAN Table, the
frame is dropped (assuming there is at least one VLAN ID present in the
Membership VLAN table or configured as a Data VLAN).

VLAN ID Begin Configure the first VLAN ID for the VLAN range.
VLAN ID End Configure the last VLAN ID for the VLAN range.
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VLAN Mapping

Configure the VLAN Mapping Table to map the C-VLAN of traffic
ingressing the Ethernet (LAN) port of the SM to a S-VLAN before being
forwarded to the air interface on the UL. In the DL direction, the SM will
automatically un-map the S-VLAN to the C-VLAN before forwarding the
tagged packets to the Ethernet (LAN) interface of the SM.

C-VLAN

Configure the C-VLAN ID of the tagged traffic for which the mapping
needs to occur

Ad Note

The C-VLAN ID must be entered in the SM VLAN Membership
VLAN table.

S-VLAN

Configure the S-VLAN ID to which the tagged traffic needs to be
mapped to.

Aid Note

The S-VLAN ID must be entered in the SM VLAN Membership
VLAN table.

Ethernet Port

Ethernet MTU

Maximum Transmission Unit; the size in bytes of the largest data unit
that the device is configured to process. Larger MTU configurations
can enable the network to operate with greater efficiency, but in the
case of retransmissions due to packet errors, efficiency is reduced since
large packets must be resent in the event of an error.

Ethernet Port

Disabled: The primary Ethernet port is disabled
Enabled: The primary Ethernet port is enabled

Port Setting

Manual: The LAN Ethernet port speed and duplex mode can be
manually configured.

Auto-negotiate: The AP auto negotiates the LAN Ethernet port speed
and duplex mode with the device connected to it.

Port Speed

With “Ethernet Port Configuration”, the LAN Ethernet port speed can be
forced to 1000 Mbps (only GPS Sync'd radio), 100 Mbps or 10 Mbps.

Port Duplex Mode

With “Ethernet Port Configuration”, the LAN Ethernet port duplex mode
can be forced to Full or Half.

Auxiliary Port

Disabled: When disabled, the LAN Auxiliary port on the SM is shut
down.

Enabled: When enabled, LAN Auxiliary port on the SM is up and able
to bridge traffic with the primary Ethernet port. Default value is
Enabled.
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Auxiliary Port Setting

Manual: The LAN Auxiliary port speed and duplex mode can be
manually configured.

Auto-negotiate: The AP auto negotiates the LAN Auxiliary port speed
and duplex mode with the device connected to it.

Auxiliary Port Speed

With “Auxiliary Port Configuration” set to Manual, the LAN Auxiliary
port speed can be forced to 1000 Mbps (only GPS Synchronized radio),
100 Mbps or 10 Mbps.

Auxiliary Port Duplex
Mode

With “Auxiliary Port Configuration” set to Manual, the LAN Auxiliary
port duplex mode can be forced to Full or Half.

Auxiliary Port PoE

Disabled: When disabled, the LAN Auxiliary port on the SM will not
provide proprietary PoE out. Default value is Disabled.

Enabled: When enabled, LAN Auxiliary port on the SM will provide
proprietary PoE out to power external PoE devices such as another

ePMP radio or a PoE camera.

Broadcast/Multicast Traffic Shaping

Broadcast Packet
Limit

Enabled: This allows the user to set the Broadcast Packet Rate below.
Configure this parameter to limit the amount of broadcast packets that
will be allowed on the ingress of the radio’s Ethernet port. Set the
packets per second value to limit the impact of events such as
broadcast storms.

Disabled: There is no limit on the amount of broadcast traffic that will
be allowed into the ingress of the radio’s Ethernet port.

Broadcast Packet Rate

Set the packets per second value to limit the amount of broadcast traffic
that will be allowed on the ingress on the radio’s Ethernet port. The
packets per second limit can be set individually on each ePMP radio.
The range is 100 to 16000 packets per second. The default is 1000.

Multicast Group Limit

Configure the maximum number of simultaneous multicast groups that
the SM will allow from devices below it. The default (and maximum) is
5.

Multicast VLAN

Enabled: A VLAN tag will be added to all untagged multicast traffic
entering the SM’s LAN port before sending it to the AP and remove
tags in the opposite direction from traffic (tagged with Multicast VLAN
ID) entering on the SM’s WAN port before sending to the SM’s LAN
port.

Disabled: When disabled, no changes are made to untagged multicast
traffic passing through the SM.
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Multicast VLAN ID

Configure this parameter to include this VLAN tag to all untagged
multicast traffic entering on the SM’s LAN port before sending it to the
AP and remove tags in the opposite direction from multicast traffic
(tagged with Multicast VLAN ID) entering on the SM’s WAN port before
sending to the SM’s LAN port.

Multicast VLAN
Priority

ePMP radios can prioritize VLAN traffic based on the eight priorities
described in the IEEE 802.1p specification. Multicast VLAN Priority
represents the VLAN Priority or Class of Service (CoS). Operators may
use this prioritization field to give precedence to device multicast data.

This parameter only takes effect if the Multicast VLAN parameter is
enabled. Configure this parameter to set the value of the Priority code
point field in the 802.1q tag for traffic on the Multicast VLAN originating
from the SM. The default value is 0.

Advanced

Spanning Tree
Protocol

Disabled: When disabled, Spanning Tree Protocol (802.1d) functionality
is disabled at the SM.

Enabled: When enabled, Spanning Tree Protocol (802.1d) functionality
is enabled at the SM, allowing for the prevention of Ethernet bridge
loops.

DHCP Servers Below
SM

Disabled: This blocks DHCP servers connected to the SM’s LAN side
from handing out IP addresses to DHCP clients above the SM (wireless
side).

Enabled: This allows DHCP servers connected to the SM’s LAN side to
assign IP addresses to DHCP clients above the SM (wireless side). This
configuration is typical in PTP links.

NAT Helper For SIP

Disabled: When disabled, the SM does not perform any deep packet
manipulation on the SIP request packet from a SIP Client.

Enabled: When enabled, the SM in NAT mode replaces the Source IP
within the SIP request to the Wireless IP of the SM. Please note that this
translation is often times handled by the SIP server so this option may
not always be needed.
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LLDP The Link Layer Discovery Protocol (LLDP) is a vendor-neutral link layer
protocol (as specified in IEEE 802.1AB) used by ePMP for advertising its
identity, capabilities, and neighbors on the Ethernet/wired interface.
Disabled: ePMP does not Receive or Transmit LLDP packets from/to its
neighbors.
Enabled: ePMP can Receive LLDP packets from its neighbors and Send
LLDP packets to its neighbors, depending on the LLDP Mode
configuration below.

A

A Note
LLDP packets are Received/Transmitted ONLY to the neighbors on the
Ethernet Interface of the ePMP radio.
Receive and Transmit: ePMP sends and receives LLDP packets to/from

LLDP Mode . . .
its neighbors on the Ethernet/LAN interface.
Receive Only: ePMP receives LLDP packets from its neighbors on the
Ethernet/LAN interface and discovers them.
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Figure 66 SM Network page, Router mode
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Table 105 SM Network attributes, Router mode

Attribute

Meaning

General

Network Mode

NAT: The SM acts as a router and packets are forwarded or filtered
based on their IP header (source or destination).

Bridge: The SM acts as a switch and packets are forwarded or
filtered based on their MAC destination address.

Router: The SM acts as a router and packets are forwarded or
filtered based on their IP header (source or destination) using
specific static routes and IP aliases configured by the operator.

Wireless IP Assignment

Static: Wireless IP addressing is configured manually in fields
Wireless IP Address, Wireless IP Subnet Mask, Wireless Gateway IP
Address, Preferred DNS IP Address and Alternate DNS IP Address.

DHCP: Device management IP addressing (IP address, subnet mask,
gateway and DNS server) is assigned via a network DHCP server.

Wireless IP Address

Wireless Internet protocol (IP) address. This address is used by the
family of Internet protocols to uniquely identify this unit on a
network.

Wireless Subnet Mask

Defines the address range of the connected IP network. For example,
if Wireless IP Address is configured to 192.168.2.1 and Wireless IP
Subnet Mask is configured to 255.255.255.0, the device wireless
interface will belong to subnet 192.168.2.X.

Wireless Gateway

Configure the IP address of a computer on the current network that
acts as a gateway. A gateway acts as an entrance and exit to packets
from and to other networks.

Preferred DNS Server

Configure The IP address of the preferred server used for DNS
resolution.

Alternate DNS Server

Configure The IP address of the alternate server used for DNS
resolution.

Ethernet Port Security

Disabled: When disabled, any number of devices (MAC Addresses)
can connect via the SM’s Ethernet (LAN) port.

Enabled: When enabled, the number of devices (MAC Addresses)
that can connect via the SM’s Ethernet (LAN) port can be restricted
with the fields below.

Secure MAC Limit

Specify the maximum number of unique devices (MAC Addresses)
that can connect via the SM’s Ethernet (LAN) port. Range is 1 - 254
devices.
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MAC Aging Time

Specify the aging timer in seconds. The aging timer will determine
the duration for which the SM will maintain the MAC Address in its
bridge table. The timer is restarted any time traffic from a specific
MAC address is received on the LAN port. Once the timer expires,
the MAC Address is removed from the SM’s bridge table.

Ethernet Interface

IP Address

Internet protocol (IP) address. This address is used by the family of
Internet protocols to uniquely identify this unit on a network.

Subnet Mask

Defines the address range of the connected IP network. For example,
if Device IP Address (LAN) is configured to 192.168.2.1 and IP Subnet
Mask (LAN) is configured to 255.255.255.0, the device will belong to
subnet 192.168.2.X.

DHCP Server

Disabled: Use this setting when SM is in NAT mode, if there is an
existing DHCP Server below the SM handing out IP Addresses or if
all devices below the SM will be configured with static IP Addresses.
Enabled: Use this setting when SM is in NAT mode, to use the SM's
local/onboard DHCP server to hand out IP addresses to its clients.

DHCP Start IP

Configure the first address which will be issued to a DHCP client.
Upon additional DHCP requests, the DHCP Start IP is incremented
until Local DHCP End IP is reached.

DHCP End IP

Configure the highest IP address in the DHCP pool that can be issued
to a DHCP client.

Preferred DHCP DNS
Server

Configure the primary DNS Server IP address which will be used to
configure DHCP clients (if Local DHCP Server is set to Enabled).

Alternate DHCP DNS
Server

Configure the secondary DNS Server IP address which will be used
to configure DHCP clients (if Local DHCP Server is set to Enabled).

DHCP Lease Time

Configure the time for which a DHCP IP address is leased. When the
lease time expires, the DHCP client must renew IP addressing via
DHCP request.

DHCP Clients The DHCP Client List table identifies hardware situated below the
SM which shall be issued DHCP IP addressing information. The SM
acts as a DHCP server, responding to requests from hardware
connected to the SM.

MAC Configure the physical address of the device which will retrieve
DHCP IP addressing information from the SM.

IP Configure the IP address which will be assigned to the device.

Name Configure a logical name for the device configured (i.e. VoIP Phone1,
or Network Camera1).
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Static Routes

Route

When Enabled, it allows the operator to create static routes that will
apply to both the Wireless and Ethernet interface of the SM.

This allows operators to configure a custom table of explicit paths
between networks. Static routing is often used as a method to
reduce the overhead of processing dynamic routes through a
network when the specific path is known (or, it is simpler to define a
specific path). Static routing is also used as a backup when dynamic
routing protocols fail to complete a route from one network to
another.

In router mode, the Static Routes table is referenced by the SM to
forward/filter packets to a particular destination configured by the
user based on the IP addressing information contained in the table.

Since static routes do not change with network changes, it is
recommended to only use static routes for simple network paths
which are not prone to frequent changes (requiring updates to the
routes configured on the ePMP SM).

It is important to consider each hop in a static route’s path to ensure
that the routing equipment has been configured to statically or
dynamically route packets to the proper destination. Otherwise, the
network communication will fail.

A Note

Network Address Translation (NAT) is not performed when the SM
is in Router mode.

Target Network IP

Configure the target subnet/network’s IP address to which the SM
should route the packets.

Subnet Mask

Configure the subnet mask for the Target Network IP address.

Gateway Configure the gateway to which packets that match the Target
Network IP Address and Subnet Mask are sent.
Description Provide a description to easily identify the static route and its

purpose.

Separate Wireless Management Interface

Separate Management IP

Disabled: When disabled, the Wireless IP is the management
interface for the SM.

Enabled: When enabled, the IP Address below is the management
interface for the SM.
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IP Assignment

Static: Separate Wireless Management Interface is configured
manually in fields IP Address, Subnet Mask and Gateway.

DHCP: Management IP addressing (IP address, subnet mask,
gateway and DNS server) is assigned via a network DHCP server.

IP Address

Configure the IP address that will be used to access the SM’s
management interface when in NAT mode. The Wireless IP (public
IP) will not allow management access.

Subnet Mask

Defines the address range of the connected IP network. For example,
if IP Address is configured to 192.168.2.1 and Subnet Mask is
configured to 255.255.255.0, the device wireless interface will belong
to subnet 192.168.2.X.

Gateway

Configure the IP address of a computer on the current network that
acts as a gateway. A gateway acts as an entrance and exit to packets
from and to other networks.

Separate Management
VLAN

Enabled: A VLAN configuration establishes a logical group within
the network. Each computer in the VLAN, regardless of initial or
eventual physical location, has access to the same data based on the
VLAN architecture. For the network operator, this provides flexibility
in network segmentation, simpler management and enhanced
security. When the SM is in NAT mode, the Separate Wireless
Management VLAN configuration is applicable to management data.

Disabled: When disabled, the SM does not have a unique
management VLAN.

VLAN ID

Configure this parameter to include the device’'s management traffic
on a separate VLAN network.

VLAN Priority

ePMP radios can prioritize VLAN traffic based on the eight priorities
described in the IEEE 802.1p specification. Data VLAN Priority
represents the VLAN Priority or Class of Service (CoS). Operators
may use this prioritization field to give precedence to device
management data.

This parameter only takes effect if the Separate Wireless
Management VLAN parameter is enabled. Configure this parameter
to set the value of the Priority code point field in the 802.1q tag for
management traffic on the configured VLAN ID originating from the
SM. The default value is 0.

Virtual Local Area Management (VLAN)

026v003

234



PMP

CAMBIUM NETWORKS

Attribute

Meaning

VLAN (Management +
Data)

Enabled: A VLAN configuration establishes a logical group within
the network. Each computer in the VLAN, regardless of initial or
eventual physical location, has access to the same data based on the
VLAN architecture. For the network operator, this provides flexibility
in network segmentation, simpler management and enhanced
security. When the SM is in NAT or Router mode, the VLAN
configuration is applicable to both management and user data.

Disabled: When disabled, all IP management and data traffic is
allowed to the device.

VLAN ID

Configure this parameter to include the device’s management and
user traffic on a separate VLAN network.

VLAN Priority

ePMP radios can prioritize VLAN traffic based on the eight priorities
described in the IEEE 802.1p specification. Data VLAN Priority
represents the VLAN Priority or Class of Service (CoS). Operators
may use this prioritization field to give precedence to device user
and management data.

This parameter only takes effect if the VLAN parameter is enabled.
Configure this parameter to set the value of the Priority code point
field in the 802.1q tag for traffic on the configured VLAN ID
originating from the SM. The default value is 0.

IP Aliases

IP aliases When Enabled, IP aliases allow the operator to associate more than
one IP address to the Ethernet interface of the SM.
This configuration of multiple IP addresses for the SM’s Ethernet
interface allows connections to multiple networks, often used as a
mechanism for management access to the device from a convenient
networking path.

IP Address Configure the IP address for the alias.

Subnet Mask

Configure the subnet mask for the alias.

Description

Provide a description to easily identify the IP alias and its
purpose/connected network.

Ethernet Port

Ethernet MTU

Maximum Transmission Unit; the size in bytes of the largest data
unit that the device is configured to process. Larger MTU
configurations can enable the network to operate with greater
efficiency, but in the case of retransmissions due to packet errors,
efficiency is reduced since large packets must be resent in the event
of an error.
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Attribute

Meaning

Ethernet Port

Disabled: The primary Ethernet port is disabled
Enabled: The primary Ethernet port is enabled

Port Setting

Manual: The LAN Ethernet port speed and duplex mode can be
manually configured.

Auto-negotiate: The AP auto negotiates the LAN Ethernet port
speed and duplex mode with the device connected to it.

Port Speed

With “Ethernet Port Configuration” set to Manual, the LAN Ethernet
port speed can be forced to 1000 Mbps (only GPS Synchronized
radio), 100 Mbps or 10 Mbps.

Port Duplex Mode

With “Ethernet Port Configuration” set to Manual, the LAN Ethernet
port duplex mode can be forced to Full or Half.

Auxiliary Port

Disabled: When disabled, the LAN Auxiliary port on the SM is shut
down.

Enabled: When enabled, LAN Auxiliary port on the SM is up and
able to bridge traffic with the primary Ethernet port. Default value is
Enabled.

Auxiliary Port
Configuration

Manual: The LAN Auxiliary port speed and duplex mode can be
manually configured.

Auto-negotiate: The AP auto negotiates the LAN Auxiliary port
speed and duplex mode with the device connected to it.

Auxiliary Port Speed

With “Auxiliary Port Configuration” set to Manual, the LAN Auxiliary
port speed can be forced to 1000 Mbps (only GPS Synchronized
radio), 100 Mbps or 10 Mbps.

Auxiliary Port Duplex
Mode

With “Auxiliary Port Configuration” set to Manual, the LAN Auxiliary
port duplex mode can be forced to Full or Half.

Auxiliary Port PoE

Disabled: When disabled, the LAN Auxiliary port on the SM will not
provide proprietary PoE out. Default value is Disabled.

Enabled: When enabled, LAN Auxiliary port on the SM will provide
proprietary PoE out to power external PoE devices such as another

ePMP radio or a PoE camera.

Advanced

Spanning Tree Protocol

Disabled: When disabled, Spanning Tree Protocol (802.1d)
functionality is disabled at the SM.

Enabled: When enabled, Spanning Tree Protocol (802.1d)
functionality is enabled at the SM, allowing for the prevention of
Ethernet bridge loops.
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Attribute

Meaning

DHCP Servers Below SM

Disabled: This blocks DHCP servers connected to the SM’s LAN side
from handing out IP addresses to DHCP clients above the SM
(wireless side).

Enabled: This allows DHCP servers connected to the SM’s LAN side
to assign IP addresses to DHCP clients above the SM (wireless side).
This configuration is typical in PTP links.

NAT Helper For SIP

Disabled: When disabled, the SM does not perform any deep packet
manipulation on the SIP request packet from a SIP Client.

Enabled: When enabled, the SM in NAT mode replaces the Source
IP within the SIP request to the Wireless IP of the SM. Please note
that this translation is often times handled by the SIP server so this
option may not always be needed.

The Link Layer Discovery Protocol (LLDP) is a vendor-neutral link

LLDP
layer protocol (as specified in IEEE 802.1AB) used by ePMP for
advertising its identity, capabilities, and neighbors on the
Ethernet/wired interface.
Disabled: ePMP does not Receive or Transmit LLDP packets from/to
its neighbors.
Enabled: ePMP can Receive LLDP packets from its neighbors and
Send LLDP packets to its neighbors, depending on the LLDP Mode
configuration below.

A

Ad Note
LLDP packets are Received/Transmitted ONLY to the neighbors on
the Ethernet Interface of the ePMP radio.

LLDP Mode Receive and Transmit: ePMP sends and receives LLDP packets

to/from its neighbors on the Ethernet/LAN interface.
Receive Only: ePMP receives LLDP packets from its neighbors on the
Ethernet/LAN interface and discovers them.

Point-to-Point Protocol over Ethernet (PPPoE)

PPPOE

Point-to-Point Protocol over Ethernet: Used for Encapsulating PPP
frames inside Ethernet frames.

Service Name

An optional entry to set a specific service name to connect to for the
PPPoE session. If this is left blank the SM accepts the first service
option that comes back from the Access Concentrator specified
below, if any. This is limited to 32 characters.

Access Concentrator

An optional entry to set a specific Access Concentrator to connect to
for the PPPoE session. If this is blank, the SM accepts the first Access
Concentrator which matches the service name (if specified). This is
limited to 32 characters.
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Attribute

Meaning

Authentication

ALL: This means that CHAP authentication will be attempted first,
then PAP authentication. The same password is used for both types.

CHAP: This means that CHAP authentication will be attempted.
PAP: This means that PAP authentication will be attempted.

Username This is the CHAP/PAP username that is used. This is limited to 32
characters.

Password This is the CHAP/PAP password that is used. This is limited to 32
characters.

MTU Size Maximum Transmission Unit; the size in bytes of the largest data

unit that the device is configured to process inside the PPPoE tunnel.
This field allows the operator to specify the largest MTU value to use
in the PPPoE session, if PPPoE MSS Clamping is Enabled. The user
will be able to enter an MTU value up to 1492. However, if the MTU
determined in LCP negotiations is less than this user-specified value,
the SM uses the smaller value as its MTU for the PPPoE link.

Keep Alive Time

Configure the Keep Alive Time to allow the radio to keep the PPPoE
session up after establishment. As an example, if this field is set to 5,
the PPPoE client will send a keep alive message to the PPPoE server
every 5 seconds. If there is no acknowledgement, it sends the ‘Keep
alive’ message to the server 4 more times (for a total or 5 times)
before tearing down the PPPoE session. Setting this to 12 will mean
the keep alive message will be sent every 12 seconds and when
there is no acknowledgement, the client will try for a total of 12
times every 12 seconds before tearing down the PPPoE session.

MSS Clamping

Disabled: The SM PPPoE session allows any MTU size determined
by other devices in the PPPoE session during the LCP negotiations.

Enabled: The SM PPPoE session enforces a max MTU size
determined by the PPPoE MTU Size setting for all devices in the
PPPoE session during the LCP negotiations, unless one of the
devices enforces a MTU setting that is smaller in value.
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SM Security page

The SM’s Security page is used to configure system security features including SM authentication
and Layer2/Layer3 Firewall rules.

Al Caution

If a device firewall rule is added with Action set to Deny and Interface set to LAN or WAN and no

other rule attribute are configured, the device will drop all Ethernet or wireless traffic,

respectively. Ensure that all firewall rules are specific to the type of traffic which must be denied,

and that no rules exist in the devices with only Action set to Deny and Interface set to LAN or

WAN. To regain access to the device, perform a factory default.

Figure 67 SM Security page

(f. Cambium Networks
ePMP 1000

ePMP1000_c026d7 ‘ Subscriber Module

ﬁ Home
#’ Quick Start
Q Configuration~
@ Radio
008 Quality of Service
E‘Zf System
;r-. Network
A monitor~
/’ Tools~

Configuration s Security

Security Options WPA2

@ Wireless Security + RADIUS o WPAZ @ WPA2 Preshared Key  sresesesssann

RADIUS
© EAP-TTLS Username cambium-station @ Default Root Certificate default.cre
Use Ethernet MAC Address as & Off @ Canopy Root Certificate pmpds0.crt
EAP-TTLS Username Using ' as Format
. @ User Provisioned Root Cert 1 no certificate added
Using ' as Format
@ EAP-TTLS Password e @ User Provisioned Root Cert 2 no certificate added
@ Authentication Identity String anonymous
@ Authentication Identity cambiumnetworks.com
Realm
Firewalls

@ Layer 2 Firewall ® Disabled Enabled

Table is empty

@ Layer 3 Firewall ® Disabled Enabled

Table is empty
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Table 106 SM Security attributes

Attribute

Meaning

Security Options

Wireless Security

Select the type of authentication preferred, whether RADIUS, WPA2,
Open or a combination of the three.

WPA2

WPA2 Pre-shared Key

Configure this key on the AP and then configure each of the network
SMs with this key to complete the authentication configuration. This
key must be between 8 to 128 symbols.

RADIUS

EAP-TTLS Username

Configure the EAP-TTLS Username to match the credentials on the
RADIUS server being used for the network.

Use Ethernet MAC
Address at EAP-TTLS
Username

The device MAC Address can be used as the EAP-TTLS Username in

",

either “:" or “-“ delimited format.

EAP-TTLS Password

Configure the EAP-TTLS Password to match the credentials on the
RADIUS server being used for the network.

Authentication Identity
String

Configure this Identity string to match the credentials on the RADIUS
server being used for the network. Default value for this parameter is
“anonymous”.

Authentication ldentity
Realm

Configure this Identity string to match the credentials on the RADIUS
server being used for the network. Default value for this parameter is
“cambiumnetworks.com”.

Default Root Certificate

Default EAP-TTLS root certificate that must match the certificate on
the RADIUS server.

Canopy Root Certificate

PMP 450 default EAP-TTLS root certificate to match the certificate on
the RADIUS server used with current PMP 450 deployments.

User Provisioned Root
Cert 1

Import a user certificate if a certificate different from the default
certificates is needed.

User Provisioned Root
Cert 2

Import a second user certificate if a certificate different from the
default or 1°" user provisioned certificate is needed.

Firewalls

Layer 2 Firewall

Enabled: Modifications to the Layer 2 Firewall Table are allowed and
rules are enforced.

Disabled: Modifications to the Layer 2 Firewall Table are not allowed
and rules are not enforced.
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Attribute Meaning

Firewall Rules The Layer 2 firewall table may be used to configure rules matching
layer 2 (MAC layer) traffic which result in forwarding or dropping the
traffic over the radio link or Ethernet interface.

A Note

When the SM is in NAT mode, only the Src MAC filtering
functionality is supported

Layer 3 Firewall Disabled: Modifications to the Layer 3 Firewall Table are not allowed
and rules are not enforced.

Enabled: Modifications to the Layer 3 Firewall Table are allowed and
rules are enforced.

Firewall Rules The Layer 3 firewall table may be used to configure rules matching
layer 3 (IP layer) traffic which result in forwarding or dropping the
traffic over the radio link or Ethernet interface.
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SM MONITOR MENU

Use the Monitor menu to access device and network statistics and status information. This section
may be used to analyze and troubleshoot network performance and operation.

The Monitor menu contains the following pages:
e SM Performance page on page 243

e SM System page on page 247

e SM Wireless page on page 249

e SM Throughput Chart page on page 252

e SM Network page on page 253

e SM System Log page on page 263
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SM Performance page

Use the Performance page to monitor system status and statistics to analyze and troubleshoot
network performance and operation.

Figure 68 SM Performance page

Cambium Networks

ePMP1000_c026d7 ‘ Subscriber Module

ePMP 1000
A Home Monitor » Performance
& Quick start Reset Stafistics

Time Since Last Reset 0002:01:33:59
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Ethernet Statistics -Transmitted Fihernet Statistes - Recelved

¢ Configuration~

B8 system Total Traffic O Kbits Total Traffic 0 Kbits
> wireless Total Packets O Total Packets 0
Throughput Chart PacketErrors O PacketErrors 0
@, Network PacketDrops O Packet Drops [
= oystemLog Multicast / Broadeast 0 Kbits Multicast / Broadcast 0 Kbits
Traffic Traffic
#F Tools+ BroadcastPackets 0 Broadcast Packets 0
Multicast Packets 0 Multicast Packets o
Wireless Statistics - Downlink Wireless Statistics - Uplink
Total Traffic 1128485 Kbits Total Traffic 490100 Kbits
Total Packets 667492 Total Packets 90854
Error Drop Packets 0 Error Drop Packets 0
Multicast / Broadcast 440483 Kbit Capacity Drop Packets 0

Traffic

Retransmission Packets 0
Broadcast Packets 531165

‘ . e Multicast / Broadcast 24340 Kbits
@ Multicast Packets 72983 Traffic
Broadcast Packets 23785

@ Multicast Packets 0

@ Link Quality 100 %

(Uplink)
@ Link Capacity ~ 100%
(Uplink)
System Statistics
@ sessionDrops 6
@ Device Reboots 18
@ Radar (DFS) Detections 1]
@ Downlink Packets Per MCS @ Uplink Packets Per MCS
MCS 15- 64-QAM 5/6 59012 (8.8%) MCS15-64-QAM 5/6 97987 (98.1%)
MCS 14- 64-QAM 344 3278 (0.5%) MCS 14-64-QAM 3/4 100 (0.1%)
MCS13-64-QAM 23 197 (0%) MCS 12 -64-QAM 2/3 124 (0.1%4)
MCS12-16-QAM 34 71 (0%) MCS 12-16-QAM 3[4 77 (0.1%6)
MCS11-16-QAM 12 168 (0%) MCS 11-16-QAM 1/2 477 (0.5%)
MCS10-QPSK3/4 155 (0%) MCS10-QPSK3/4 268 (0.3%)
MCS9-QPSK1/2 207 (0%) MCS9-QPSK1/2 235 (0.2%)
MCS7-64-QAM 5/6 41 (0%) MCS 7-64-QAM 5/6 85 (0.1%)
MCS 6- 64-QAM 2/4 79 (0%) MCS 6-64-QAM 3/4 198 (0.2%)
MCS5-64-QAM 2/3 6 (0%) MCS5-64-QAM2/3 4 (0%)
MCS4-16-QAM 344 5 (0%) MCS4-16-QAM 3/4 7 (0%)
MCS3-16-QAM 172 11 (0%) MCS3-16-QAM 1/2 4 (0%)
MCS2-QPSK3/4 71 (0%) MCS2-QPSK3/4 164 (0.2%)
MCS1-QPSK1/2 604289 (90.5%) MCS1-QPSK1/2 204 (0.2%)
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Table 107 SM Performance attributes

Attribute Meaning

Time Since Last Reset Time since the stats were last reset.

Reset Stats Resets all statistics for both Ethernet and Wireless.

Ethernet Statistics - Transmitted

Total Traffic Total amount of traffic in Kbits transferred from the SM’s Ethernet
interface.

Total Packets Total number of packets transferred from the SM’s Ethernet interface.

Packet Errors Total number of packets transmitted out of the SM’s Ethernet interface

with errors due to collisions, CRC errors, or irregular packet size.

Packet Drops Total number of packets dropped prior to sending out of the SM's
Ethernet interface due to Ethernet setup or filtering issues.

Total amount of multicast and broadcast traffic in Kbits sent via the

Multicast / Broadcast .
SM'’s Ethernet interface.

Traffic
Broadcast Packets Total number of broadcast packets sent via the SM’s Ethernet

interface.
Total number of multicast packets sent via the SM’s Ethernet interface.

Multicast Packets

Ethernet Statistics - Received

Total Traffic Total amount of traffic in Kbits received by the SM’s Ethernet
interface.

Total Packets Total number of packets received by the SM’s Ethernet interface.

Packet Errors Total number of packets received by the SM’s Ethernet interface with

errors due to collisions, CRC errors, or irregular packet size.

Packet Drops Total number of packets dropped prior to sending out of the SM’s
wireless interface due to Ethernet setup or filtering issues.

Multicast / Broadcast Total amount of multicast and broadcast traffic in Kbits received by

Traffic the SM’s Ethernet interface.

Broadcast Packets Total number of broadcast packets received via the SM’s Ethernet
interface.

Multicast Packets Total number of multicast packets received via the SM’s Ethernet
interface.

Wireless Statistics - Downlink

Total Traffic Total amount of traffic received via the SM’s wireless interface in
Kbits.
Total Packets Total number of packets received via the SM’s wireless interface.

026v003 244



PMP

CAMBIUM NETWORKS

Attribute

Meaning

Error Drop Packets

Total number of packets dropped prior to sending out of the SM’s
Ethernet interface due to RF errors (packet integrity error and other RF
related packet error).

Multicast / Broadcast
Traffic

Total amount of multicast and broadcast traffic transmitted out of the
SM'’s wireless interface in Kbits.

Broadcast Packets

Total number of broadcast packets transmitted out of the SM's
wireless interface.

Multicast Packets

Total number of multicast packets transmitted out of the SM’s wireless
interface.

Wireless Statistics - Uplink

Total Traffic

Total amount of traffic transmitted out of the SM’s wireless interface
in Kbits.

Total Packets

Total number of packets transmitted out of the SM’s wireless
interface.

Error Drop Packets

Total number of packets dropped after transmitting out of the SM’s
Wireless interface due to RF errors (No acknowledgement and other
RF related packet error).

Capacity Drop Packets

Total number of packets dropped after transmitting out of the SM’s
Wireless interface due to capacity issues (data buffer/queue overflow
or other performance or internal packet errors).

Retransmission
Packets

Total number of packets re-transmitted after transmitting out of the
SM’s Wireless interface due to the packets not being received by the
AP.

Multicast / Broadcast
Traffic

Total amount of multicast and broadcast traffic received on the SM’s
wireless interface in Kbits.

Broadcast Packets

Total number of broadcast packets transmitted on the SM’s wireless
interface.

Multicast Packets

Total number of multicast packets transmitted on the SM’s wireless
interface.

Link Quality (Uplink)

The Uplink quality based on the current MCS and PER.

Link Capacity (Uplink)

The uplink capacity based on the current MCS with respect to the
highest supported MCS (MCS15).

System Statistics

Session Drops

Total number of sessions dropped by the SM.

Device Reboots

Total number of reboots of the SM.

Radar (DFS) Detections

Total number of DFS events that were detected by the SM.
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Attribute Meaning

Downlink Packets Per Number of packets (and percentage of total packets) received on the

MCS SM'’s wireless interface for every modulation mode, based on radio
conditions.

Uplink Packets Per Number of packets (and percentage of total packets) transmitted out of

MCS the SM’s wireless interface for every modulation mode used by the

SM’s transmitter, based on radio conditions.

026v003 246



cPMP

CAMBIUM NETWORKS

SM System page

Use the System page to reference key system information.

Figure 69 SM System page

@Cambium Networks | oyp1000_coz6d7 ‘ Subscriber Module

ePMP 1000
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-8!’ Quick Start
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Device-Agent Version
Date and Time
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Ethernet MAC Address
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N/A
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00:04:56:C0:26:D8
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System Log

f' Tools~

DFS5 Status Not Available
Contains FCC ID(s): Z8H8GFTO005
Read-Only Users 0

Read-Write Users

SM Current GUI User Authentication Device Local Only
Factory Reset Via Power Sequence Enabled
cnMaestro Connection Status Connected to qa.cloud.cambiumnetworks.com

cnMaestro Account 1D KREDDUM_CNSNGQA
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Table 108 SM System page attributes

Attribute

Meaning

Hardware Version

Board hardware version information.

Serial Number
(MSN)

Unit serial number (MSN).

Firmware Version

U-Boot version information.

Software Version

Current operating version of software on the device. This listing is also
present on the GUI footer bar (which contains a hyperlink to download
new system software).

Device-Agent
Version

The operating version of the device agent, which is used for
communication with cnMaestro.

Date and Time

Current date and time, subject to time zone offsets introduced by the
configuration of the device Time Zone parameter. This shows a factory-
configured time until a valid NTP server is configured.

System Uptime

The total system uptime since the last device reset.

Wireless MAC
Address

The hardware address of the device wireless interface.

Ethernet MAC
Address

The hardware address of the device Ethernet interface.
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Attribute

Meaning

DFS Status

N/A: DFS operation is not required for the region configured in
parameter Country Code

Channel Availability Check: Prior to transmitting, the device must check
the configured Frequency Carrier for radar pulses for 60 seconds). If no
radar pulses are detected, the device transitions to state In-Service
Monitoring.

In-Service Monitoring: Radio is transmitting and receiving normally
while monitoring for radar pulses which require a channel move.

Radar Signal Detected: The receiver has detected a valid radar pulse and
is carrying out detect-and-avoid mechanisms (moving to an alternate
channel).

In-Service Monitoring at Alternative Channel: The radio has detected a
radar pulse and has moved operation to a frequency configured in DFS
Alternative Frequency Carrier 1 or DFS Alternative Frequency Carrier 2.

System Not In Service due to DFS: The radio has detected a radar pulse
and has failed channel availability checks on all alternative frequencies.
The non-occupancy time for the radio frequencies in which radar was
detected is 30 minutes.

Contains FCC ID(s)

Displays listing of FCC IDs applicable to the device.

Read-Only Users

Displays the number of active Read-Only users logged into the radio.

Read-Write Users

Displays the number of active Read-Write users logged into the radio.

SM Current GUI
User Authentication

Displays the mechanism used for authentication of web management
interface users.

Factory Reset Via
Power Sequence

Enabled: When Enabled under Tools->Backup/Restore->Reset Via Power
Sequence, it is possible to reset the radio’s configuration to factory
defaults using the power cycle sequence explained under Resetting
ePMP to factory defaults by power cycling on page 184.

Disabled: When Disabled, it is not possible to factory default the radio’s
configuration using the power cycle sequence.

cnMaestro
Connection Status

The current management status of the device with respect to the
Cambium Cloud Server. When Enabled under Configuration->System,
the device will be managed by the Cambium Remote Management
System, which allows all Cambium devices to be managed from the
Cambium Cloud Server.

cnMaestro Account
ID

The ID that the device is currently using to be managed by the Cambium
Cloud Server.
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SM Wireless page

Use the Wireless page to reference key information about the radio’s wireless interface.

Figure 70 SM Wireless page
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Table 109 SM Wireless page attributes

Attribute

Meaning

Registered AP SSID

SSID of the AP to which the SM is registered.

Registered AP MAC address

Wireless MAC address of the AP to which the SM is registered.

Distance from AP

The distance from the AP, determined by radio signal
propagation delay.

Operating Frequency

The current frequency at which the SM is transmitting and
receiving.

Operating Channel Bandwidth

The current channel size at which the SM is transmitting and
receiving.

Downlink RSSI

The Received Signal Strength Indicator, which is a
measurement of the power level being received by the SM's
antenna.

Downlink SNR

The Signal to Noise Ratio, which is an expression of the carrier
signal quality with respect to signal noise.

Transmitter Output Power

The current power level at which the SM is transmitting.
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Attribute Meaning

Uplink MCS Modulation and Coding Scheme - indicates the modulation
mode used for the radio uplink, based on radio conditions
(MCS 1-7, 9-15).

Downlink MCS Modulation and Coding Scheme - indicates the modulation

mode used for the radio downlink, based on radio conditions
(MCS 1-7, 9-15).

Power Control Mode from AP

Open Loop: In this mode, the SM will not receive any power
change information in the Group Poll Frame. SM calculates the
UL transmit power based on path loss calculations only.

Closed Loop: In closed loop UL power control, Subscriber
Module will get the AP actual transmit power of beacon frame
and SM Target Received Power Level in the beacon. Based on
these two values, SM calculates the path loss. Based on path
loss and TRL values it calculates it's transmit power such that
the signal from SM arrives at AP at the configured target level.
Path loss calculation will be updated by SM every time there is
a change in values of AP actual TX power or TRL in the
Beacon.

Forced Sector Antenna

When an ePMP 2000 AP is deployed with a Sector Antenna and
a Smart Antenna, this parameter forces the AP to use only
Sector Antenna for all Subscriber Modules.

Ethernet Interface

Up: The radio (LAN) interface is functioning properly.

Down: The radio (LAN) interface has encountered an error and
is not servicing traffic.

Wireless Interface

Up: The radio (WAN) interface is functioning properly.

Down: The radio (WAN) interface has encountered an error
and is not servicing traffic.

Country

The current code the SM is operating under.

Time since last scan

Amount of time elapsed since the last scan was completed by
the SM for available APs.

Registration Status

The current registration status of the SM.

Available APs

The Available AP list may be referenced to view which APs are
available for SM network entry, and also to view the status of
the current AP to SM radio link.

Add as Preferred

Click the m button to add the AP to the Preferred AP List
under Configuration->Radio.

SSID

The SSID of the visible AP.

MAC Address

The MAC address of the visible AP.
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Attribute

Meaning

Frequency Carrier (MHz)

The current operating frequency of the visible AP.

Channel Bandwidth

The current operating channel bandwidth of the visible AP.

RSSI (dBm) The current measured Received Signal Strength Indicator at
the AP.
SNR (dB) The current measured Signal-to-Noise Ratio of the SM to AP

link.

Registration State

The indication of the result of the SM’s network entry attempt:
Successful: SM registration is successful

Failed: Out of Range: The SM is out of the AP’s configured
maximum range (Max Range parameter)

Failed: Capacity limit reached at AP: The AP is no longer
allowing SM network entry due to capacity reached

Failed: No Allocation on AP: The SM to AP handshaking failed
due to a misconfigured pre-shared key between the SM and AP

Failed: SW Version Incompatibility: The version of software
resident on the AP is older than the software version on the
SM

Failed: PTP Mode: ACL Policy: The AP is configured with PTP
Access set to MAC Limited and the SM’s MAC address is not
configured in the AP’s PTP MAC Address field

Failed: Other: The AP does not have the required available
memory to allow network entry

Session Time (hh:mm:ss)

This timer indicates the time elapsed since the SM registered
to the AP.

Wireless Security

This field indicates the security state of the AP to SM link.

Meets Reg Criteria

Yes: The scanned AP meets the Network Entry criteria defined
by the internal Network Algorithm.

No: The scanned AP does not meet the Network Entry criteria
defined by the internal Network Algorithm.
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SM Throughput Chart page

Use the Throughput page to reference a line chart visual representation of system throughput over
time. The blue line indicates downlink throughput and the orange line indicates uplink throughput.
The X-axis may be configured to display data over seconds, minutes, or hours, and the Y-axis is
adjusted automatically based on average throughput. Hover over data points to display details.

Figure 71 SM Throughput Chart page
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Table 110 SM Throughput Chart page attributes

Attribute Meaning

Throughput Adjust the X-axis to display throughput intervals in seconds, minutes, or
Measurement Period  hours.
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SM Network page

Use the SM Network page to reference key information about the device network status.

Figure 72 SM Network page, Bridge Mode
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Table 111 SM Network page attributes, Bridge Mode
Attribute Meaning
Ethernet Interface
IP Address The IP address for the device when the device is used in Bridge mode.
Subnet Mask The currently configured device IP subnet mask.
IPv6 Link Local A link-local address is required for the IPv6-enabled interface
Address (applications may rely on the link-local address even when there is no

IPv6 routing). The IPv6 link-local address is comparable to the auto-
configured IPv4 address 169.254.0.0/16.

IPv6 Address The IPv6 address for device management.
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Attribute

Meaning

MTU Size

The currently configured Maximum Transmission Unit for the AP’s
Ethernet (LAN) interface. Larger MTU configurations can enable the
network to operate with greater efficiency, but in the case of
retransmissions due to packet errors, efficiency is reduced since large
packets must be resent in the event of an error.

Ethernet Status

Up: The device Ethernet interface is functioning and passing data

Down: The device Ethernet interface has encountered an error
disallowing full operation. Reset the device to reinitiate the Ethernet
interface.

Port Speed

The current speed of the SM’s LAN port.

Port Duplex Mode

The current duplex mode of the SM’s LAN port.

Auxiliary Ethernet
Status

The current status of the SM’s Auxiliary Ethernet Port.

Auxiliary Port Speed

The current operating speed of the SM’s Auxiliary Ethernet Port.

Auxiliary Port Duplex
Mode

The current operating duplex mode of the SM’s Auxiliary Ethernet Port.

Wireless Status

Wireless Interface

Up: The device wireless interface is functioning and passing data

Down: The device wireless interface has encountered an error
disallowing full operation. Reset the device to reinitiate the wireless
interface.

IP address

The IP address for the wireless interface is displayed only when the SM
is in NAT Mode.

Subnet Mask

The subnet for the wireless interface is displayed only when the SM is in
NAT Mode.

Default Gateway

The current configured gateway for the bridge network of the SM.

Network Status

Network Mode

Bridge: The SM acts as a switch, and packets are forwarded or filtered
based on their MAC destination address.

NAT: The SM acts as a router, and packets are forwarded or filtered
based on their IP header (source or destination) which can be grouped
into subnets for finer granularity.

Router: The SM acts as a router and packets are forwarded or filtered
based on their IP header (source or destination) using specific static
routes and IP aliases configured by the operator.

DNS Server IP

Represents the IP address of the DNS Server.

Multicast Status
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Attribute

Meaning

Multicast Group
Limit

The maximum number of simultaneous multicast groups that will be
allowed through the SM.

Total Multicast
Groups

The current number of Multicast groups that have subscribed under this
SM.

ARP Table

MAC Address

MAC Address of the devices on the bridge.

IP Address

IP Address of the devices on the bridge.

Interface

Interface on which the SM identified the devices on.

Bridge Table

MAC Address

MAC Address of the SM connected to the AP.

Port

The port to which the device is connected.

Aging Timer (secs)

Time set for the MAC addresses in the Bridge table.

Figure 73 SM Network page, NAT Mode
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Table 112 SM Network page attributes, NAT mode

Attribute

Meaning

Ethernet Interface

IP Address

The IP address for the subnet associated with the Ethernet interface
when the device is used in NAT and Router modes.

Subnet Mask

The currently configured device IP subnet mask.

MTU Size

The currently configured Maximum Transmission Unit for the AP’s
Ethernet (LAN) interface. Larger MTU configurations can enable the
network to operate with greater efficiency, but in the case of
retransmissions due to packet errors, efficiency is reduced since large
packets must be resent in the event of an error.

Ethernet Status

Up: The device Ethernet interface is functioning and passing data

Down: The device Ethernet interface has encountered an error
disallowing full operation. Reset the device to reinitiate the Ethernet
interface.

Port Speed

The current speed of the SM’s LAN port.

Port Duplex Mode

The current duplex mode of the SM’s LAN port.

Auxiliary Ethernet
Status

The current status of the SM’s Auxiliary Ethernet Port.

Auxiliary Port Speed

The current operating speed of the SM’s Auxiliary Ethernet Port.

Auxiliary Port Duplex
Mode

The current operating duplex mode of the SM’s Auxiliary Ethernet Port.

Separate Wireless Management IP

Separate
Management IP

Disabled: A separate wireless management interface is not available.

Enabled: A Separate Wireless Management IP has been configured and
a management interface is available.

IP Assignment

Static: Device management IP addressing is configured manually in
fields IP Address, Subnet Mask, Gateway, Preferred DNS Server and
Alternate DNS Server.

DHCP: Device management IP addressing (IP address, subnet mask,
gateway, and DNS server) is assigned via a network DHCP server, and
parameters IP Address, Subnet Mask, Gateway, Preferred DNS Server
and Alternate DNS Server are unused.

IP Address

The IP address for the separate wireless management interface is
displayed only when the Separate Wireless Management IP is enabled.

Subnet Mask

The subnet for the separate wireless management interface.

Gateway

The default gateway for the separate wireless management interface.
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Attribute

Meaning

Wireless Status

Wireless IP
Assignment

Static: Device management IP addressing is configured manually in
fields IP Address, Subnet Mask, Gateway, Preferred DNS Server and
Alternate DNS Server.

DHCP: Device management IP addressing (IP address, subnet mask,
gateway, and DNS server) is assigned via a network DHCP server, and
parameters IP Address, Subnet Mask, Gateway, Preferred DNS Server
and Alternate DNS Server are unused.

Wireless Status

Up: The device wireless interface is functioning and passing data

Down: The device wireless interface has encountered an error
disallowing full operation. Reset the device to reinitiate the wireless
interface.

IP Address

The IP address for the wireless interface of the SM.

Subnet Mask

The subnet for the wireless interface of the SM.

Default Gateway

The default gateway for the wireless interface of the SM.

Network Status

Network Mode

Bridge: The SM acts as a switch, and packets are forwarded or filtered
based on their MAC destination address.

NAT: The SM acts as a router, and packets are forwarded or filtered
based on their IP header (source or destination) which can be grouped
into subnets for finer granularity.

Router: The SM acts as a router and packets are forwarded or filtered
based on their IP header (source or destination) using specific static
routes and IP aliases configured by the operator.

DNS Server IP

Represents the IP address of the DNS Server.

PPPoE Mode

Disabled: If this is left blank the STA will accept the first service option
that comes back from the Access Concentrator specified below, if any.
PPPoE is ‘Disabled’ by default.

Enabled: An optional entry is ‘Enabled’ to set a specific service name to
connect to the PPPoE session. This is limited to 32 characters.

DHCP Lease Time

Current configured time for which a DHCP IP address is leased. When
the lease time expires, the DHCP client must renew IP addressing via
DHCP request.

ARP Table
MAC Address MAC Address of the devices in the SM’s routing table.
IP Address IP Address of the devices in the SMs routing table.
Interface Interface on which the SM identified the devices on.
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Attribute

Meaning

Local DHCP Server

DHCP Server Status

Indicates if the local DHCP server on the SM in NAT mode is
Enabled/Disabled.

DHCP Server IP Start
Address

The first IP address in the DHCP pool which will be issued to a DHCP
client. Upon additional DHCP requests, the DHCP Start IP is incremented
until Local DHCP End IP is reached.

DHCP Server IP End
Address

The last/highest address IP address in the DHCP pool of addresses which
is issued to a DHCP client.

DHCP Gateway IP
Address

The gateway of the local DHCP server

DHCP DNS IP
Address

DNS Server IP address which will be used to configure DHCP clients (if
Local DHCP Server is set to Enabled under Configuration=>Network).

DHCP Static MAC to IP Configuration Table

MAC Address MAC address of clients that were statically assigned an IP address in the
DHCP Static MAC to IP Configuration Table under Configuration >
Network

IP Address IP address of clients that were statically assigned an IP address in the

DHCP Static MAC to IP Configuration Table under Configuration >
Network

DHCP Assigned IP Address Table

MAC Address MAC address of clients that were assigned a IP address through DHCP
from the Local DHCP Server
IP Address IP address of clients that were assigned a IP address through DHCP from

the Local DHCP Server

Device Name

Device Name of clients that were assigned a IP address through DHCP
from the Local DHCP Server
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Figure 74 SM Network page, Router Mode
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Table 113 SM Network page attributes, Router mode

Attribute Meaning

Ethernet Interface

IP Address The IP address for the subnet associated with the Ethernet interface
when the device is used in NAT and Router modes.

Subnet Mask The currently configured device IP subnet mask.

MTU Size The currently configured Maximum Transmission Unit for the AP’s
Ethernet (LAN) interface. Larger MTU configurations can enable the
network to operate with greater efficiency, but in the case of
retransmissions due to packet errors, efficiency is reduced since large
packets must be resent in the event of an error.
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Attribute

Meaning

Ethernet Status

Up: The device Ethernet interface is functioning and passing data

Down: The device Ethernet interface has encountered an error
disallowing full operation. Reset the device to reinitiate the Ethernet
interface.

Port Speed

The current speed of the SM’s LAN port.

Port Duplex Mode

The current duplex mode of the SM’s LAN port.

Auxiliary Ethernet
Status

The current status of the SM’s Auxiliary Ethernet Port.

Auxiliary Port Speed

The current operating speed of the SM’s Auxiliary Ethernet Port.

Auxiliary Port Duplex
Mode

The current operating duplex mode of the SM’s Auxiliary Ethernet Port.

Wireless Interface

Wireless IP
Assignment

Static: Device management IP addressing is configured manually in
fields IP Address, Subnet Mask, Gateway, Preferred DNS Server and
Alternate DNS Server.

DHCP: Device management IP addressing (IP address, subnet mask,
gateway, and DNS server) is assigned via a network DHCP server, and
parameters IP Address, Subnet Mask, Gateway, Preferred DNS Server
and Alternate DNS Server are unused.

Wireless IP
Assignment

Static: Device management IP addressing is configured manually in
fields IP Address, Subnet Mask, Gateway, Preferred DNS Server and
Alternate DNS Server.

DHCP: Device management IP addressing (IP address, subnet mask,
gateway, and DNS server) is assigned via a network DHCP server, and
parameters IP Address, Subnet Mask, Gateway, Preferred DNS Server
and Alternate DNS Server are unused.

IP Address

The IP address for the separate wireless management interface is
displayed only when the Separate Wireless Management IP is enabled.

Subnet Mask

The subnet for the separate wireless management interface of the SM.

Default Gateway

The default gateway for the separate wireless management interface of
the SM.

Network Status
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Attribute

Meaning

Network Mode

Bridge: The SM acts as a switch, and packets are forwarded or filtered
based on their MAC destination address.

NAT: The SM acts as a router, and packets are forwarded or filtered
based on their IP header (source or destination) which can be grouped
into subnets for finer granularity.

Router: The SM acts as a router and packets are forwarded or filtered
based on their IP header (source or destination) using specific static
routes and IP aliases configured by the operator.

DNS Server IP

Represents the IP address of the DNS Server.

PPPoE Mode

Disabled: If this is left blank the STA will accept the first service option
that comes back from the Access Concentrator specified below, if any.
PPPoE is ‘Disabled’ by default.

Enabled: An optional entry is ‘Enabled’ to set a specific service name to
connect to the PPPoE session. This is limited to 32 characters.

DHCP Lease Time

Current configured time for which a DHCP IP address is leased. When
the lease time expires, the DHCP client must renew IP addressing via
DHCP request.

ARP Table

MAC Address MAC Address of the devices in the SM’s routing table.
IP Address IP Address of the devices in the SMs routing table.
Interface Interface on which the SM identified the devices on.

Local DHCP Server

DHCP Server Status

Indicates if the local DHCP server on the SM in NAT mode is
Enabled/Disabled.

DHCP Server IP Start
Address

The first IP address in the DHCP pool which will be issued to a DHCP
client. Upon additional DHCP requests, the DHCP Start IP is incremented
until Local DHCP End IP is reached.

DHCP Server IP End
Address

The last/highest address IP address in the DHCP pool of addresses which
is issued to a DHCP client.

DHCP Gateway IP
Address

The gateway of the local DHCP server

DHCP DNS IP
Address

DNS Server IP address which will be used to configure DHCP clients (if
Local DHCP Server is set to Enabled under Configuration=>Network).

Static Routes

Target Network IP

Target subnet/network’s IP address to which the SM should route the
packets.

Subnet Mask

Subnet mask for the Target Network IP address.
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Attribute Meaning

Gateway Gateway to which packets that match the Target Network IP Address and
Subnet Mask are sent.

Interface Interface to which the static route is active.

IP Aliases

IP Address IP address for the configured IP alias.

Subnet Mask

Subnet mask for the configured IP alias.
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SM System Log page

Use the SM System Log page to view the device system log and to download the log file to the
accessing PC or device.

Figure 75 SM System Log page
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Table 114 SM System Log attributes

Attribute Meaning

Syslog Display Enabled: The system log file is displayed on the management GUI.
Disabled: The system log file is hidden on the management GUI.

Syslog file Use this button to download the full system log file to a connected PC or
device.
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SM TOOLS MENU

The SM Tools menu provides several options for upgrading device software, configuration
backup/restore, analyzing RF spectrum, testing device throughput, running ping and traceroute
tests.

e SM Software Upgrade page on page 265

e SM Backup / Restore page on page 268

e SM eDetect page on page 270

e SM Spectrum Analyzer page on page 272
e SM eAlign page on page 274

e SM Wireless Link Test page on page 275

e SM Ping page on page 276

e SM Traceroute page on page 277
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SM Software Upgrade page

Use the SM Software Upgrade page to update the device radio software to take advantage of new
software features and improvements.

A Caution

Please read the Release Notes associated with each software release for special
notices, feature updates, resolved software issues, and known software issues.
The Release Notes may be accessed at the Cambium Support Center.

Figure 76 SM Software Upgrade page
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Table 115 SM Software Upgrade attributes

Attribute Meaning

Software Version The current operating software version. ePMP boards that do not have
an onboard GPS have one bank of flash memory which contains a
version of software. The version of software last upgraded onto the
Flash memory is present on this bank of flash memory. This software
will be used by the SM when the SM is rebooted.

Firmware Version Specifies the code used to boot the board.
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Attribute Meaning

Upgrade Options From URL: A webserver may be used to retrieve software upgrade
packages (downloaded to the device via the webserver). For example, if
a webserver is running at IP address 192.168.2.1 and the software
upgrade packages are located in the home directory, an operator may
select option From URL and configure the Software Upgrade Source Info
field to http://192.168.2.1/<software_upgrade_package>

From Local File: Click Browse to select the local file containing the
software upgrade package

Select File Click Browse to select a local file (located on the device accessing the
web management interface) for upgrading the device software.
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To upgrade the device software, follow this procedure:

Procedure:

1 Download the software upgrade packages from
https://support.cambiumnetworks.com/files/epmp

2 Clear the cache of the accessing browser
3  Onthe device GUI, navigate to Tools => Software Upgrade

4  Select the SW Upgrade Option which represents the location of your software upgrade
packages

5 Based on the configuration of SW Upgrade Option, enter either the Software Upgrade
Source Info or click the Browse button and locate the software package

6 Click Upgrade

7 When the upgrade is completed successfully, click the Reset icon
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SM Backup / Restore page

Use the SM Backup / Restore page to perform the following functions:

e Back up the configuration in either text (.json) format or binary (.bin) format.

¢ Restore the configuration of using a configuration file that was previously backed up.

o Reset the device to its factory default configuration. For more factory defaulting methods, see:
o Using the device external reset button on page 300
o Resetting ePMP to factory defaults by power cycling on page 301

Figure 77 SM Backup / Restore page
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Table 116 SM Backup / Restore attributes

Attribute

Meaning

Backup Configuration

Configuration File
Format

Text (Editable): Choosing this option will download the configuration file
in the . json format, and can be viewed and/or edited using a standard
text editor.

Binary (Secured): Choosing this option will download the configuration
file in the .bin format, and cannot be viewed and/or edited using an
editor. Use this format for a secure backup.

Restore Configuration

Select File

Click Browse to select a local file (located on the device accessing the
web management interface) for restoring the device configuration.

Factory Default Configuration

Reset Via Power
Sequence

Enabled: When Enabled, it is possible to reset the radio’s configuration
to factory defaults using the power cycle sequence explained under
Resetting ePMP to factory defaults by power cycling on page 184.

Disabled: When Disabled, it is not possible to factory default the radio’s
configuration using the power cycle sequence.

Retain Passwords

When set to Enabled, then after a factory default of the radio for any
reason, the passwords used for GUI and CLI access will not be defaulted
and will remain unchanged. The default value of this field is Disabled.

A\
AN Caution
If the passwords cannot be retrieved after the factory default, access to
the radio will be lost/unrecoverable. This feature prevents unauthorized
users from gaining access to the radio for any reason, including theft.

Keep Passwords

When the Keep Passwords checkbox is selected, the passwords used for
GUI and CLI access will not be defaulted and will remain unchanged.
This is one-time option, and it does not apply to factory default
procedures completed by power cycling (Reset Via Power Sequence).

Reset to Factory

Use this button to reset the device to its factory default configuration.

Defaults N
=+ Caution
A reset to factory default configuration resets all device parameters.
With the SMs in default configuration it may not be able to register to an
AP configured for your network.
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SM eDetect page

The eDetect tool (not available in ePTP Slave mode) is used to measure the 802.11 interference at
the ePMP radio or system when run from the AP, on the current operating channel. When the tool
is run, the ePMP device processes all frames received from devices not connected to the ePMP
system and collects the interfering frame’s information such as MAC Address, RSSI, and MCS. Use
the SM eDetect page to collect information about interferers locally at the SM to display on the
SM’s GUI.

Figure 78 SM eDetect page
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Table 117 SM eDetect attributes

Attribute

Meaning

eDetect

Detection Duration

Configure the duration for which the SM scans for interferers.

'\
&3 Caution
During the scanning period, the SM must be connected to the AP
and passing user traffic, and there cannot be any outage (unlike
running a Spectrum Analyzer). There may be a negligible
degradation in the SM's throughput.

Start/Stop

Use to start or stop the interference detection.

Export to CSV

Choose this option to export the detection results to .csv format.

Status

Current status of the Interference Detection tool.

Detection Results

Use the Detection Results table to monitor interferers at the SM and
their key RF parameters.

Device Instant Health

This is an indicator of the device’s health in terms of channel conditions
in the presence of interferer(s).

Green: Indicates that the channel is relatively clean and has good C/I
levels (>25dB). The interference level is low.

Yellow: Indicates that the channel has moderate or intermittent
interference (C/lI between 10dB and 25dB).

Red: Indicates that the channel has high interference and poor C/I levels
(<10dB).

Device MAC

The MAC address of the SM’s wireless interface.

Device RSSI (dBm)

The Received Signal Strength Indicator, which is a measurement of the
power level being received by the device’s antenna.

Device MCS

Modulation and Coding Scheme - indicates the modulation mode used
for a radio’s receiver side, based on radio conditions (MCS 1-7, 9-15).

Interferers’ MAC

The MAC address of the interferer’'s wireless interface.

Interferers’ RSSI
(dBm)

The Received Signal Strength Indicator, which is a measurement of the
interferer’s power level being received by the device’s antenna.

Interferers’ MCS

Modulation and Coding Scheme - indicates the modulation mode used
by the interferer, based on radio conditions (ex: MCS 1--15).
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SM Spectrum Analyzer page

Use the SM Spectrum Analyzer page to configure SM spectrum analyzer parameters and to
download the spectrum analyzer tool.

To download the spectrum analyzer tool, the AP Device Mode must be set to Spectrum Analyzer.

Java Runtime Environment is required to run the AP spectrum analyzer.

AN

&3 Caution
Conducting spectrum analysis causes the SM to enter scan mode and the SM drops all RF
connections.

Vary the days and times when you analyze the spectrum in an area. The RF environment can
change throughout the day or throughout the week.

To conduct a spectrum analysis, follow these steps:
Required Software:

e Java Run-time Environment (JRE)

Procedure:

1 Onthe SM GUI, navigate to Configure => System

2 Configure Device mode to Spectrum Analyzer

3 Click the Save button

4  Click the Reset button

5 Login to the SM and navigate to Tools => Spectrum Analyzer.

6 Click Download Spectrum Analyzer Tool

7 Locate the folder to which the spe